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Remarques sur l’utilisation de ce manuel 
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i-Tree Eco software provides a broad picture of the urban forest or trees in your study area. It 

is designed to use field data from complete inventories of trees or randomly located plots 

throughout a community along with local hourly air pollution and meteorological data to 

quantify urban forest structure, environmental effects, and value to communities. Managers 

or researchers can use the baseline data to make effective resource management decisions, 

develop policy, and set priorities. 

 

From project start to finish, Eco is a complete package that provides users with the following 

components: 

• Detailed, statistically based sampling and data collection protocols. These protocols 

allow for estimation of totals and variation related to urban forest structure and 

population effects. 

• A mobile data collector for web-enabled smartphones, tablets, or similar devices that 

can be used for field data collection. 

• A central computing engine that makes scientifically based estimates of the effects of 

urban forests using peer-reviewed scientific equations to predict environmental and 

economic benefits. 

• Summary reports including charts, tables, and a written report. 

 

 

 

 

 

 

 

 

 

Though i-Tree Eco was originally developed for the United States, growing interest among 

international urban foresters has spurred improved model functionality in other countries as 

time and limited resources have permitted. 

 

Supported Countries 

Eco v6.0 has been adapted for use throughout Canada, Mexico, Australia, the United 

Kingdom and Europe with the necessary species information, location information, and 

pollution and weather data preprocessed and available in the application.  

About i-Tree Eco 

 International Projects 

 

 

To install the i-Tree Eco software, please see the Eco Guide to Installing 

Software for system requirements and installation instructions. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
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Completing an i-Tree Eco analysis can seem like a daunting task, so here are the most 
important things you need to know about using this software: 
 

• Eco projects are highly customizable and thus require a significant amount of 
planning. 
 

• The Eco model uses field data to estimate forest structure, function, and benefits so 
you will be required to collect data for the individual trees in your study area. 

 
This manual will walk you through the stepwise process of completing an i-Tree Eco project 
by describing the following project phases in more detail: 
 

Phase I: Planning For Your Project 
There are many decisions to be made in order to customize your Eco project. To help 
you work through this planning phase, we have provided a simple decision tree that 
will guide you through the questions that must be answered. 
 
Phase II: Setting Up Your Project 
Once you have planned what type of project you will be doing, you can begin setting 
up your project. Depending on your answers in Phase I, you may need to gather 
additional data or create your sample. Here we will guide you through those next 
steps. 
 
Phase III A & B: Collecting Your Field Data 
After Phase II is complete, you are ready to move to the data collection phase! In this 
section of the manual, we will help you decide what data you will collect in the field 
and exactly how to take the necessary measurements and collect that data. 
 
Phase IV: Working with Eco 
After you have collected your field data, you will be ready to work directly with the i-
Tree Eco software. In this section, we will describe each of the components of the 
user interface in detail and walk you through the process of entering or editing your 
field data.  
 
Phase V: Viewing Your Reports 
Eco provides a large variety of output data in the form of charts, tables, and reports. 
This section of the manual describes what results are available and how to view 
them. 

 

The Eco V6.0 Rundown 

 

 

Supplement the basic knowledge that can be gained from this manual with 

the topic-specific information in the Eco Guides. That way, you can choose to 

read about the topics that are relevant to your custom project. 

Tip 

http://www.itreetools.org/resources/manuals.php
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Before you get started with Eco there are several decisions that must be made. Use this 

simple decision tree as a guide for Phase I. As you can see, not every question will be 

relevant to your Eco project. In the remainder of this section of the manual, we’ll provide you 

with more information to help answer these questions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Phase I: Planning For Your Project 

 Decision Tree 

 

 

i-Tree Eco users have developed a number of documents to help others with 

many aspects of project planning and management. These are an excellent 

resource and can be found at www.itreetools.org under Resources > 

Archives > i-Tree Eco Project Planning & Management Resources. 

Tip 

What are the boundaries of your study 

area? 

Will you stratify your 

sample? 

What type of inventory will you do? 

How big will your plots 

be? 

How many plots will you 

inventory? 

Complete Inventory Plot-Based Sample 

Inventory 
Do you have an existing 

inventory? 

Project Basics 

http://www.itreetools.org/
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Designing a new i-Tree Eco project requires some early decision-making and planning. You 

must define the boundaries of your study area, determine what type of project is most 

suitable for your objectives, and decide what data you will be collecting in the field. 

What are the boundaries of your study area? 

An Eco analysis can be done for an entire city, a neighborhood, a park, or even a backyard. 

What type of Eco inventory will you do? 

A typical Eco project can involve a complete ground-based inventory simplified by dividing 

the entire Urban Forest resource into sections and inventorying every tree in each section. A 

plot-based sample inventory involves inventorying a series of sample plots distributed across 

a city, a large university campus, or some other broad, diverse landscape.  

 

If you decide to do a plot-based sample inventory, skip to the Plot-Based Sample Inventory 

section. Otherwise, read the Complete Inventory section below and then go to Phase II: 

Setting Up Your Project.  

 

 
If you have decided to conduct a complete inventory, you will be collecting data for all of the 

trees located in your study area. In this type of project, you can choose to stratify or 

subdivide your trees by smaller units, such as land uses or zones, which can help clarify 

differences across the study area. Your Eco results will be estimated for all the trees in your 

study area as well as by strata. The decision to stratify should ultimately be based on your 

current and future project objectives and available resources. 

Do you have an existing inventory? 

Users interested in analyzing an existing inventory now have the option to import their 

existing complete inventory data into Eco.  

 

First, you will need to format your existing inventory. i-Tree Eco’s inventory import tool works 

best with a properly formatted dataset. This means that existing data should be saved as a 

specific file type and include all of the required variables. Each individual data variable also 

has its own formatting requirements that must be adhered to. 

 

 

 

 Project Basics 

 Complete Inventory 
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What file type is best? 

Save your inventory data as one of the following file types: 

• Excel spreadsheet (.xls or .xlsx) 

• Access database (.mdb or .accdb) 

• Comma separated values (.csv) 

 

What data are required? 

i-Tree Eco v6.0 has been modified so that users are now required to collect only two 

measurements of trees to complete an Eco project. The reduction in required data has been 

made to accommodate users with existing street tree inventory data, which oftentimes does 

not include all of the previously required tree measurements. 

 

The following two data variables must be included in your existing inventory: 

• Species: The species and genus names of each tree assessed. 

• Diameter at breast height (DBH): The tree stem diameter at breast height (1.37 

meters above planted grade) for each tree. 

 

For users collecting dead trees, an additional data variable is required for your existing 

inventory. Users must collect: 

• Crown health: Tree crown health estimated as condition or dieback (i.e., dead 

branches) of the crown. 

 

The crown health variable is used to indicate which sampled trees are dead and which are 

not. Dead trees should be given either a 100% dieback or 0% condition designation 

depending on which variable you decide to provide. Refer to Phase IIIB for additional 

information on collecting crown health and designating dead trees in the field. 

 

Be aware that some additional analyses require certain data to be collected beyond species 

and DBH. Please refer to Phase IIIB for more information on the data requirements for 

supplemental analyses. 

 

 

i-Tree Eco requires users to collect two tree measurements. While this 

approach allows users with limited existing inventories to run the model, it 

also has substantial limitations. The accuracy of ecosystem service estimates 

can be improved significantly by providing additional optional tree 

measurements. 

Caution 

 
! 
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How do I format each data variable? 

In addition to the two required data variables (species and DBH), users are allowed to import 

any or all of the inventory data shown in Table 1. Each individual data variable has its own 

formatting requirements. 

 

Here are several guidelines to keep in mind: 

• Field names – Users are not required to edit the field names of their existing data to 

match those used by the Eco application; instead, users will be asked to indicate the 

corresponding Eco field name. (Note: Those Eco field names will continue to be used 

and displayed in the application.) 

 

• Data limits – Eco has rules that serve as data integrity checks which require all 

values to fall within the accepted limits. For data variables where this applies, the 

limits are included in Table 1. The import function will not work properly if the data do 

not adhere to the validation rules. 

 

• Field type – Eco data variables can often be displayed in several ways. For example, 

species data can be entered as common name, scientific name, or species code. For 

data variables where this applies, users will be asked to indicate which field type 

corresponds to their existing data. 

 

• Value mapping – Users are not required to format their field values to match those 

used by the Eco application. For example, if you have recorded your species data as 

species codes, these codes do not have to be the same ones that are built into the 

Eco application. However, they must be mapped to Eco’s values. The option to map 

values is available for all data variables in Table 1. For variables where field values 

are to be mapped, the data formatting in Table 1 need not be followed. Instead, users 

will be asked to map the values used in their existing data to those available in Eco. 

(Note: Those Eco values will continue to be used and displayed in the application.) 

 

Table 1—Data Variables for Complete Inventory Projects 

The Data Variables column lists the required and optional data variables that can be imported 

from an existing inventory. For best results, the data formatting and limits described for each 

variable should be adhered to unless you choose to map values. 

 

 

Data Variables Data Formatting Data Limits 

Required fields   

Species 
Enter as specified in Eco Field 
Manual 

n/a 
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DBH  Enter as number 0.5 to 500 (in or cm) 

Optional fields   

Tree ID Enter as number > 0 without duplication 

Strata 
Enter as specified in Project 
Configuration 

n/a 

Crew Enter as text n/a 

Survey Date Enter as date/time n/a 

Status 
Enter as specified in Eco Field 
Manual 

n/a 

Land use 
Enter as specified in Project 
Configuration 

n/a 

Photo ID Enter as text n/a 

Latitude Enter as GPS coordinate n/a 

Longitude Enter as GPS coordinate n/a 

DBH measurement height  Enter as number 0.1 to 6 (ft or m) 

DBH measured Enter as Yes (Y) or No (N) n/a 

Street tree/non-street tree 
Enter as Yes (Y) for street tree or No 
(N) for non-street tree 

n/a 

Public/private 
Enter as Yes (Y) for public tree or 
No (N) for private tree 

n/a 

Total tree height Enter as number 0 to 450 (ft or m) 

Crown 
size 

Height to live top Enter as number Crown size 

Height to crown base Enter as number 0 to 450 

Crown width Enter as number 0 to 300 

Percent crown missing Enter as number 0 to 100 

Crown health 
Enter as specified in Project 
Configuration 

n/a 

Crown light exposure Enter as number -1, 0, 1, 2, 3, 4, or 5 

Energy 

Direction Enter as number Energy 

Distance (ft or m) Enter as number 
0.1 to 60 (must be -1 
when no building is 
present) 

Maintenance recommended 
Enter as specified in Project 
Configuration 

n/a 

Maintenance task 
Enter as specified in Project 
Configuration 

n/a 

Sidewalk conflict 
Enter as specified in Project 
Configuration 

n/a 

Utility conflict 
Enter as specified in Project 
Configuration 

n/a 
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Follow the Complete Inventory Import procedure outlined in Phase IV > Adding Data. 

 

 

 

If you have decided to conduct a plot-based sample inventory of a large-scale study area, 

one of the most important steps in planning your project will be deciding how to create the 

random sample of plots. This section will help you understand elements of designing a 

sample such as stratification options and the number of plots needed. Your sample design 

decisions should be based on your desired project goals (i.e., the questions you are trying to 

answer), the available resources to manage and complete the project, and the desired 

precision of the model estimates. 

 

Will you stratify your sample? 

For some studies, stratifying (subdividing) the study area into smaller units can help clarify 

differences across the area. For example, a stratified sample design with many plots may 

allow for comparison between land use types or neighborhoods and for greater precision of 

the model estimates. However, there will be associated project considerations such as the 

additional resources that will be needed to create maps, obtain permission to access 

properties, travel to plots, and collect field data. Conversely, a simple random sample with no 

stratification will not allow for comparison of sub-units but may still provide sufficient 

information to achieve the project objectives. Ultimately, the decision to stratify should be 

based on your current and future project objectives and your available resources. 

 

 Plot-Based Sample Inventory 

 

 

Required fields, species and DBH, must be entered according to the 

formatting requirements in Table 1 or mapped to Eco’s values. Invalid or 

unmatched values will result in records being skipped. 

Caution 

 
! 

 

 

A technical article is available at www.itreetools.org under Resources > 

Archives that provides more detail on the effects of sample design options 

on project precision and estimates. See “Effect of Plot and Sample Size on 

Timing and Precision of Urban Forest Assessments” under the Eco 

resources section of that page. 

Tip 

http://www.itreetools.org/
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Review the following options before you decide whether or not to stratify your sample: 

 

• No stratification (simple random sample): In a study with no stratification, plots are laid 

out randomly across the study area. This is a simpler method and offers the advantage of 

true randomness. True randomness, however, might not provide you with a true picture of 

your urban forest. Consider, for example, an extreme case of a city that is divided into 

two land uses: single-family residential (10% of total area) and industrial (90% of total 

area), with all of the trees in the residential district. A true random sample would place 

10% of plots in residential areas and 90% of plots in the industrial area and would result 

in an incorrect picture of the urban forest. Since in most cities the trees themselves are 

not distributed randomly across land uses or neighborhoods, stratified sampling can offer 

a more accurate picture of the urban forest. 

 

• Stratification (stratified random sample): In a study with stratification, the study area is 

subdivided into smaller units such as neighborhoods or land use classes. This can be 

done prior to determining your plots (pre-stratification) or after data is collected (post-

stratification). 

 

o Pre-stratification: In this method, the study area is divided into smaller 

classes (or strata) prior to determining the plots. The number of plots in each 

stratum is based on which areas are believed to have the greatest variability 

or are of greatest interest. Often the majority of the plots are distributed within 

residential and forest / vacant land uses, as these areas tend to have the 

greatest density of trees. One disadvantage of stratification is that it might 

 

 

Whether you pre-stratify or post-stratify, be sure not to choose too many 

categories or strata. The number of strata used in an Eco project is typically 

between 5 and 10 (for an analysis with 200 total plots) and cannot exceed 14. 

Too many categories can lead to analysis problems, as too few plots may not 

show in some strata. Each stratum should have at least 20 plots. 

Caution 

 
! 

 

 

Stratification is handled differently for complete inventory projects. If you 

are doing a complete inventory project and are interested in collecting 

strata, please read about it in the Phase IIIA > Choosing Your Data 

section.  

Tip 
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make revisiting the same plots in the future difficult if land uses change over 

time. On the other hand, if treed lands are slated for development, plot data 

outputs can be used to show the quantified loss of benefits. 

 

o Post-stratification: In this method, plots are first randomly distributed 

throughout the study area, and then strata boundaries are determined after 

data collection or in the future. Post-stratification allows you to analyze your 

data into multiple schemes. For example, you can use the same plots and 

field data to compare your results by land use types and then change the 

stratification to allow for analysis by political boundaries, neighborhoods, or 

management units as desired. Post-stratification allows you to manage the 

stratification boundary definitions to analyze change over time if your project 

will be reassessed in the future. For example, a land use category that is 

agricultural in an initial study may be developed in the future and reclassified 

as residential or commercial. Although post-stratification allows for greater 

flexibility, one disadvantage is that estimates may not be as accurate as a pre-

stratified project where plot quantity is predetermined based on existing land 

types and desired objectives. 

 

How big will your plots be? 

The standard plot size for an Eco analysis is a 0.04-hectare circular plot with radius of 

11.34 meters. If necessary, smaller or larger plots can be used – for instance, if you are 

analyzing a small area in which 0.04-hectare plots would overlap. 

 

How many plots will you inventory? 

As a general rule, 200 plots (.04 hectare each) in a stratified random sample (with at least 20 

plots per stratum) will yield a standard error of about 10% for an estimate of the entire city. 

As the number of plots increases, the standard error decreases and you can be more 

confident in the estimate for the population. The graph below provides a rough estimate of 

how the standard error of the total number of trees in a city changes based on the number of 

plots sampled. Note how for the first 100 plots, the standard error drops more rapidly than for 

the second 100 plots, although the standard error continues to drop with increased sample 

size. 

 

Keep in mind, however, that as the number of plots increases, so does the time and cost of 

field data collection. A crew of two people can typically measure 200 plots in one summer for 

a city with about 20% tree cover. The actual number of plots to be measured differs based on 

many factors, including the size of the city and tree cover. 
 

 

 

We recommend adding an extra 5-10% to your final number of plots.  

These extra plots can serve as replacements where another plot is 

inaccessible. 

 

Tip 
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So you’ve answered all of the questions in Phase I and are ready to set up your Eco 

project… 

 

Use Table 1 to help you through Phase II. Read the questions in the table, choose the 

answer that applies to your project, and then follow the directions. This will help guide you to 

the steps that are relevant to your project. 

 
Table 1—Guide to Next Steps 

Questions Answers Directions 

1. What are the boundaries 
of your study area? 

1a. My study area is located in the U.S., 
Australia, Canada, or the UK. 

Continue to Question #2. 

1b. My study area is not located in the 
U.S., Australia, Canada, or the UK. 

Read about The Data Gathering 
Step below, then go to Question #2 of 
this table. 

2. What type of inventory 
will you do? 

2a. Complete inventory – I will sample 
all of the trees in my study area. 

Continue to Question #3. 

2b. Plot-based sample inventory – I will 
sample the trees on plots distributed 
throughout my study area. 

Skip to Question #4. 

3. Do you have an existing 
inventory? 

3a. Yes – I will be importing an existing 
inventory. 

Go to Phase IV of this manual. 

3b. No – I need to collect field data. Go to Phase III of this manual. 

4. Will you stratify your 
sample? 

4a. No – I am going to do a simple 
random sample. 

Read about The Sample Creation 
Step below, then go to Phase III of 
this manual. 

4b. Yes – I am going to do a stratified 
random sample and pre-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase III of this 
manual. 

4c. Yes – I am going to do a stratified 
random sample and post-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase III of this 
manual. 

5. How big will your plots 
be? 

(as specified) 
Use this information in the Preparing 
for the Field section of Phase III. 

6. How many plots will you 
inventory? 

(as specified) 
Use this information in The Sample 
Creation Step below. 

   

Phase II: Setting Up Your Project 

 Guide to Next Steps 
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Datasets that are used in conjunction with the collected field data include: 

 

• Species information 

• Location information 

• Precipitation data 

• Additional weather data 

• Pollution data 

 

These data are already incorporated in Eco for study areas in all countries listed on Page 1. 

 

 

i-Tree Database provides two functions. Users may choose to do one or both of the following 

while working with the tool: 

 

1  View the Species or Location databases, or 

2  Add Species, Location, Precipitation, or Pollution data to the databases. 

 

The option to view the Species or Location databases allows users to search the data used 

by the i-Tree applications. Users can see what species and locations are currently available 

for modeling. For new projects, users should check if their location and species of interest 

are already in the data. Identifying missing data will help inform decisions to add data to the 

databases. 

To get started, go to i-Tree Database at: http://www.itreetools.org/database. View the 

Species and Location databases in turn. Note if your project location and desired tree and 

shrub species are already in the database. 

 

 

 

  

 The Data Gathering Step 

 

 

Weather data is also used in i-Tree Eco and is available globally from the 

National Climatic Data Center (NCDC). All datasets from the NCDC with 

sufficient weather data have been incorporated in i-Tree Eco v6.0. Within 

Eco weather data quality is categorized as either Good, Fair, or Poor 

based on the number of missing hourly weather data. Currently, users 

will select from the available weather stations directly in the application 

and are not able to submit their own weather data.  

Tip 

http://www.itreetools.org/database
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To view available species: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Species from the drop-down list. 

3 Choose one of the following from the Search by drop-down: 

a Scientific Name 

b Common Name 

4 Enter the name of the species that you are trying to find based on your selection in 

the Search by drop-down (i.e., scientific or common name). 

5 Click Go. 

6 The species that match your search will be listed below the search box. 

7 Click Clear to discard the name that you entered and start over. 

 

If you are having difficulty finding a species, try searching by both scientific and common 

name or entering only part of the name, e.g. the Genus, in the search box. 

 

To view available locations: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Location from the drop-down list. 

3 Define a search area by: 

a Selecting a nation from the Search by drop-down. 

b Selecting a more precise area from the list, if additional drop-down menus 

appear. 

4 Click Go. 

5 All of the available locations in your designated search area will be listed below the 

search box. 

6 Click Clear to discard the search area that you defined in the search box and start 

over. 

 

 

 

 

 

Refer to i-Tree Database’s “How to Use” text by going to Menu > Help at 

the top of the webpage. 

Tip 

 

 

If you see incomplete or erroneous data in either the species or location 

information, let the i-Tree Team know! Go to the Feedback menu at the top 

of the i-Tree Database webpage and click on Comments. 

Tip 
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Species Information 

The Species database includes species information for more than 7,500 tree and shrub 

species. Though adding new species for i-Tree Eco is optional, it is necessary for your 

analysis if any species in your local area are not already included. 

 

By viewing the database, as described above, you can identify any missing tree or shrub 

species. To make those species available in Eco, collect the necessary information for those 

species and submit it using i-Tree Database.  

 

To add a new tree species to the Species database:  

 

1 Click on Add to Database at the top of the page. 

 

2 Select Species. 

 

3 Fill in all of the required fields for your new tree species. 

a If the genus name of your new species is not available in the Genus Name 

drop-down list, add it to the database by doing the following: 

b Click the Add New Genus button. 

c Enter the name of the new genus in the space provided. 

d Click Save to add the entry to the database. 

e Click Cancel to discontinue the action of adding a new genus. 

 

4 Fill in any of the optional fields that you are able to – the more information you 

provide, the better! 

 

5 As you fill in the fields, if you are not satisfied with the data you’ve entered click Reset 

to clear the form. 

 

 

 

If you determine that you will need to submit additional data using i-Tree 

Database, consider doing that before you collect your field data. New tree 

species are entered and submitted individually, but you may choose to 

submit as many new tree species as you like! Data submitted in i-Tree 

Database will need to be vetted by the U.S. Forest Service before it can be 

made available in Eco. This will take some time. 

Tip 
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6 Click Submit when you are satisfied with the information you’ve provided. The data 

entered in the Species form will be sent to the i-Tree Team to be validated and 

incorporated into the i-Tree databases.  

Location Information 

The Location database includes location information for countries listed on Page 1 and is 

always expanding internationally. When you designed your Eco project, you should have 

decided on the location and boundaries of your study area. By viewing the database, as 

described above, you can identify if your location is already available in Eco. If it is, you do 

not need to submit any location information. Your Eco project can be run directly in Eco.  

 

Precipitation Data 
 

Internationally, precipitation data is often insufficient or absent from the weather data 

available in Eco. To supplement Eco’s existing weather data with hourly precipitation data for 

your location, collect the necessary information for the precipitation data and submit it using i-

Tree Database. 

 

Precipitation data must be hourly data in meters submitted in Excel format for a complete 

calendar year. A template is provided in i-Tree Database to ensure proper data formatting. 

 

To provide properly formatted precipitation data: 

1 Go to i-Tree Database at: http://www.itreetools.org/database. 

2 Click on Add to Database at the top of the page. 

3 Select Precipitation. 

4 Click on the Template link to download the precipitation template (see Table 3 

below). 

5 From the compressed file, choose the spreadsheet for the year that corresponds to 

the year your precipitation data was collected. 

6 Populate the sheet with your hourly data. Be sure your data is in meters per hour. 

7 Save a copy of your formatted precipitation data. 

 

 

 

Precipitation data is required for avoided runoff modeling and strongly 

recommended for pollution removal. Without precipitation data, the i-Tree Eco 

model cannot estimate avoided runoff. Pollution removal estimates for PM2.5 

also use precipitation data and without the data the model will likely 

overestimate PM2.5 removal. 

Tip 

http://www.itreetools.org/database
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Your spreadsheet should be uploaded in i-Tree Database for submission as described in 

Submit Additional Data using i-Tree Database. Please also provide the following fields for 

each dataset you add: 

 

 

 

Table 3—Precipitation fields for i-Tree Database 

Field Required Description 

Continent x Continent name of location for which precipitation data is being added 

Nation x Nation name of location for which precipitation data is being added 

State x 
Primary partition (e.g., state, province, or territory) name of location for 

which precipitation data is being added 

Year x Calendar year in which new precipitation data was collected 

Weather Station x Weather station that precipitation data will be added to 

Precipitation Data x File containing new precipitation data to be uploaded 

Pollution Data 

 

Hourly air quality data can be submitted for particulate matter less than 2.5 microns (PM2.5), 

carbon monoxide (CO), ozone (O3), nitrogen dioxide (NO2), and sulfur dioxide (SO2). Data 

must be hourly, submitted in Excel format, for a complete calendar year. To provide local 

pollution data for your location, collect the necessary information for the pollution data and 

submit it using i-Tree Database. A template is provided in i-Tree Database to ensure proper 

data formatting (Table 4).  

 

 

 

 

 

 

Air quality data is required to run the pollution model. Without this data, 

pollution removal estimates will not be included in your results. 

Tip 

 

 

The pollutant particulate matter less than 10 microns (PM10) is no longer 

included because i-Tree Eco v6.0 analyzes particulate matter less than 2.5 

microns (PM2.5) which is a subset of PM10. PM2.5 is generally more relevant in 

discussions concerning air pollution effects on human health. 

Caution 

 
! 
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To provide properly formatted air quality data: 

1 Go to i-Tree Database at: http://www.itreetools.org/database. 

2 Click on Add to Database at the top of the page. 

3 Select Pollution. 

4 Click on the Template link to download the pollution template (see Table 4 and 5 

below). 

5 From the compressed file, choose the spreadsheet (leap year or non-leap year) that 

is appropriate for the year your pollution data was collected. 

6 Follow the formatting requirements listed below to add your hourly data.  

7 Save a copy of your formatted pollution data. 

 

 

 

 

 

Table 4—Formatting requirements for pollution template 

Column Column name Format Description Requirements 

A YEAR Number 
Year the data were 

recorded 

Must be 2005-2013 and match year of 

weather data to be used 

B MONTH Number 
Month of the year the data 

were recorded 
CANNOT BE EDITED. Must be 1-12 

C SPNAME Text Name of the pollutant 

CANNOT BE EDITED. 

Must be: 

• CO for carbon monoxide, 

• NO2 for nitrogen dioxide, 

• O3 for ozone, 

• PM2.5 for particulate matter less 

than 2.5 microns, 

• SO2 for sulfur dioxide, or 

• PM10 for particulate matter less 

than 10 microns 

D CITYNAME Text 

Name of the city where 

the pollution monitor is 

located 

Do not leave blank; if city name is 

unknown, fill in with a letter (e.g., X) 

E ADDR Text 
Address of the pollution 

monitor  

Do not leave blank; if address is 

unknown, fill in with a letter (e.g., X) 

F UNITS Number Units of the pollutant 

Must be: 

• 1 for micrograms per cubic meter 

(µg/m3) or  

• 7 for parts per million (ppm) 

G QUANTITY Number 
Value of the measurement 

in units given in Column F 

Missing values must be entered as  

-999 

H DAY Number 
Day of the month the data 

were recorded 
CANNOT BE EDITED. Must be 1-31 

I HOUR Number 
Hour of the day the data 

were recorded 
CANNOT BE EDITED. Must be 0-23 

http://www.itreetools.org/database
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Your spreadsheet should be uploaded in i-Tree Database for submission as described in 

Submit Additional Data using i-Tree Database. Please also provide the following fields for 

each dataset you add: 

 

Table 5—Pollution fields for i-Tree Database 

Field Required Description 

Continent x Continent name of location for which pollution data is being added 

Nation x Nation name of location for which pollution data is being added 

State x 
Primary partition (e.g., state, province, or territory) name of location for 

which pollution data is being added 

Year x Calendar year in which new pollution data was collected 

Pollution Data x File containing new pollution data to be uploaded 

 

 

Avoiding Common Air Quality Data Problems  

Providing properly formatted pollution data consistently causes the most problems for 

international users. Submitting incorrect or incomplete pollution datasets may require 

corrections or resubmission and influences the amount of time before it can be made 

available in Eco. Here are a couple items to keep in mind to avoid common issues while you 

gather your pollution data and ensure timely incorporation into Eco: 

 

• Complete calendar year – Eco requires hourly pollution data for a complete calendar 

year (Jan 1 – Dec 31). The year does not have to be recent, but it needs to be 

complete and within the same calendar year for all pollutants. For example, although 

data available for June 1, 2014 to May 31, 2015 spans 365 days, the Eco model 

cannot process this data because it is taken from two separate calendar years. It is 

not possible for the i-Tree team to piece together parts of pollution data from different 

years if data is incomplete from one station. 

 

• Pollution data gaps - The pollution model can handle some time gaps without 

pollutant values for several hours (e.g., 2-3 hour gaps in data) as this is typical with 

most external pollution data sets. In these cases, the model will interpolate to fill data 

gaps over short time frames. 

 

• Missing pollutants - If you are missing data for a pollutant, such as PM2.5, the model 

will exclude that pollutant from the analysis. 

 

Valuation Data 

International users are also encouraged to provide local valuation data. Providing your own 

benefit prices allows users to localize their results. i-Tree Eco uses values from the scientific 
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literature to estimate the economic value associated with tree benefits. Default values 

currently estimated are: 

 

• Carbon – based on the U.S. Social Cost of Carbon (SCC) 

 

• Avoided runoff – U.S. national average costs of stormwater control 

 

• Pollution removal – based on U.S. median externality values for carbon monoxide, 

nitrogen dioxide, sulfur dioxide, particulate matter less than 2.5 microns, and ozone 

removal 

 

• Energy – U.S. national average cost of electricity and fuels (e.g., heating oil, 

propane, natural gas) 

 

You can provide your own valuation data if you would like to localize your benefit estimates. 

If you do not provide your own valuation data, the default values will be used and converted 

to the local currency with a user-defined exchange rate. Unlike species, location, 

precipitation, and pollution data that are submitted in i-Tree Database, valuation data are 

entered directly in the i-Tree Eco application. By entering the data directly in Eco, it will be 

used for your project, but it will not be added to the databases. Read about adding valuation 

data in Eco under Phase IV: Working with Eco > Navigating the User Interface. 

 

 

If you have decided to do a plot-based sample project, then you will need to create your 

sample. This step will walk you through that process.  

Randomization 

 The Sample Creation Step 
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There are many ways that you can randomly distribute plots throughout your study area, 

whether you are working with a stratified or un-stratified sample. Again, your decision should 

be based on the objectives of your study and the resources available to create the layout. 

Some Eco users collaborate with local universities or government agencies for assistance to 

create random plot layouts for their projects. Three randomization methods are as follows: 

 

Random:  

For an un-stratified or post-stratified sample, plots are laid randomly within the boundaries of 

the entire study area. For a pre-stratified sample, plots are laid randomly within the 

boundaries of each individual predetermined stratum. 

 

Fixed Grid: 

First, random plots are created by laying out a fixed grid of points, equidistant over the entire 

project area. Once the grid points have been laid out, they are numbered. 

 

For an un-stratified or post-stratified sample, plots are selected for the entire study area by 

choosing points from the grid using a random number generator, which can be found online 

or within software tools such as Excel. For a pre-stratified sample, plots are selected the 

same way, but for each predetermined stratum. 

 

A potential disadvantage of this method, however, may occur if the grid unintentionally 

coincides with an existing city street grid. In that case, many plots may fall on similar land 

uses, which may not be desirable. 

 

Randomized grid:  

In this method, an evenly spaced grid is laid over the study area. Then, plot points are 

selected randomly within each cell, which allows for a more even distribution of points 

throughout your study area with a greater degree of randomness than using a fixed grid. 

 

One advantage of the randomized grid is that it allows for multiple post-stratification schemes 

because plots are more evenly distributed. 

 

Random Fixed Grid Randomized Grid 
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Sample Creation Methods 

Once you have designed your sample and made the necessary decisions about stratification, 

plot size, and number of plots, there are multiple methods available to help you create your 

plot sample. You can use any method you like, including paper maps and pencil, as long as it 

follows random sampling conventions.  

 

Eco offers a random plot generator that allows you to create your sample right in the 

application itself. The plot generator works with Google Maps and utilizes study area 

boundaries that can be drawn by the user or supplied from an ESRI ArcGIS shapefile. This 

method can be used whether you have decided to stratify your sample or not. However, in 

the Google Maps Plot Generator, plots are distributed randomly and cannot be distributed on 

a fixed grid or randomized grid. 

 

Eco plots can also be created in other programs and loaded into the application. In this case, 

you could use ESRI’s ArcGIS software to generate your plots. The end result will be three 

files to load into Eco during project set up to create a plot list for your project configuration. 

 

How you choose to create your sample ultimately depends on your randomization method, 

decisions about stratification, and available resources. For example, nearly all sample 

designs can be created using GIS, but the software can be expensive. The random type of 

random plot distribution is typically done by using Eco’s Google Maps Plot Generator or with 

the aid of a GIS system. The fixed grid type of random plot distribution can be done 

manually on a map or by using GIS. The randomized grid type of random plot distribution 

would most likely require GIS. 

 

 

 

  

 

 

Look at the Eco Guide to Post-stratified Samples for directions on how to 

create a post-stratified random sample of i-Tree Eco plots using Eco’s manual 

plot creation function. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PostStratifiedSamples.pdf
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Variables requises 

Décider quelles données vous collecterez pour vos arbres est une étape importante dans la 

planification de votre projet Eco. Pour tout inventaire, les deux variables suivantes doivent 

être collectées pour chaque arbre :  

• Espèce : identifiez et saisissez le genre et l’espèce de chaque arbre relevé 

 

• Diamètre à hauteur de poitrine (DHP) : mesurez et saisissez le diamètre du tronc à 

la hauteur de la poitrine (1,37 mètres du sol) pour chaque arbre. 

  

En outre, les deux variables suivantes doivent être collectées pour chaque placette 

(uniquement pour les inventaires par échantillonnage basés sur des placettes : 

• Pourcentage mesuré : identification directe ou par estimation du pourcentage de la 

superficie de chaque placette accessible et mesurable par l’équipe de terrain. 

 

• Pourcentage de couvert arboré : identification du pourcentage de la superficie 

couverte par la canopée au niveau de chaque placette. 

Phase IIIA: Préparation pour la collecte de vos 

données de terrain 

 Choisir vos données 

 

i-Tree Eco exige aux utilisateurs de collecter deux mesures d’arbre.  

Cette approche permet aux utilisateurs ayant des inventaires existants 

limités de tourner le modèle. Néanmoins, elle présente d’importantes limites. 

La précision des estimations des services écosystémiques peut être 

considérablement améliorée en mesurant, en option, d’autres variables. 

Veuillez en savoir plus sur ces limitations dans Eco Guide to Data 

Limitations. 

Avertissement 

 
! 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
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Analyses supplémentaires 

i-Tree Eco fournit des données relatives à la structure, fonctions et bénéfices rendus par 

votre forêt urbaine notamment : 

• Nombre d’arbres 

• Composition en espèces 

• Surface foliaire et biomasse 

• Réduction de la pollution atmosphérique et sa valeur (CHF) 

• Stockage et séquestration de carbone et leur valeur (CHF) 

• Effet sur l’hydrologie/rétention des eaux pluviales et sa valeur (CHF) 

• Emissions des composés organiques volatils 

• Production de l’oxygène 

• Effets sur le rayonnement ultraviolet (UV) 

 

 

Il existe plusieurs analyses supplémentaires que vous pouvez inclure dans votre projet Eco 

personnalisé. Consultez les descriptions suivantes pour vous aider à décider quelles 

analyses sont pertinentes par rapport aux objectifs de votre projet. 

Energie (Energy) (disponible pour les inventaires complets et les inventaires par 

échantillonnage basés sur des placettes) : 

Les arbres situés à proximité des bâtiments peuvent affecter la quantité d'énergie utilisée 

pour les chauffer ou les refroidir en réduisant la température de l'air, en bloquant le vent et en 

produisant de l'ombre. Si vous souhaitez évaluer les effets de votre forêt urbaine sur la 

consommation énergétique, vous devrez collecter des informations relatives aux bâtiments 

voisins (c-à-d la distance et la direction par rapports aux arbres). (Remarque : les effets 

énergétiques ne sont calculés que pour les bâtiments résidentiels). 

Faune (Wildlife) (disponible pour les inventaires par échantillonnage basés sur des 

placettes) : 

Eco estime l'aptitude d'une zone à assurer la subsistance des populations de neuf espèces 

d’oiseaux différentes en fonction des caractéristiques de l’habitat liées et/ou influençant 

l’abondance de chaque espèce. Ces estimations sont basées sur 1) l'aire de répartition de 

l'espèce, 2) la structure de la forêt locale, 3) les arbres, les arbustes et le couvert au sol de la 

zone d'étude. Pour évaluer cette aptitude, les pourcentages du couvert arbustif et du couvert 

 

Pour avoir ces analyses supplémentaires, d’autres données sur les arbres 

que celles décrites ci-dessus (espèce et DHP) doivent être collectées. 

Consultez les tableaux 3 et 4 dans la section suivante pour en savoir plus. 

Avertissement 

 
! 
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au sol doivent être collectés. Des caractéristiques supplémentaires des arbres sont fortement 

recommandées pour de meilleures estimations (voir le tableau 3). 

Prévision (Forecast) (disponible pour les inventaires complets et les inventaires par 

échantillonnage basés sur des placettes) : 

Le modèle de prévision utilise des estimations structurelles générées par Eco ainsi que des 

taux de croissance et de mortalité pour estimer à quoi ressemblera votre forêt urbaine dans 

les années futures. Si vous souhaitez étudier votre future forêt urbaine, des informations 

complémentaires sont recommandées (voir tableaux 3 et 4). 

Arbustes (Shrubs) (disponible pour les inventaires par échantillonnage basés sur des 

placettes) : 

Eco analyse principalement les arbres de votre zone d'étude, mais les arbustes sont une 

autre ressource importante et offrent de nombreux bénéfices. Si vous souhaitez analyser les 

arbustes dans votre zone d'étude, vous devrez collecter des informations sur les espèces, la 

hauteur et le couvert arbustif dans les placettes. 

Espace plantable (plantable space) (disponible pour les inventaires par échantillonnage 

basés sur des placettes) : 

Si vous souhaitez estimer l'espace de plantation disponible pour votre terrain d’étude, vous 

devrez estimer la fraction qui peut être plantée dans chaque placette. 

Couvert au sol sous la canopée (Cover under canopy) (disponible pour les inventaires 

par échantillonnage basés sur des placettes) :  

{L'outil Hydro n'est actuellement disponible que pour les projets américains. Veuillez ne pas 

collecter des données liées à Hydro, ex. couvert sous la canopée. Les utilisateurs européens 

seront informés lorsqu’Hydro sera disponible pour une utilisation européenne.} 

i-Tree Hydro est une application de i-Tree qui évalue les effets du couvert arboré urbain et 

des surfaces imperméables sur le débit horaire et la qualité de l'eau pour une zone d'étude 

définie. Si vous prévoyez d'effectuer une analyse à l'aide d'Hydro, il vous sera demandé de 

fournir des données concernant le pourcentage moyen de surface imperméable et de 

couvert arbustif sous la projection au sol de la couronne de votre terrain d’étude. Cette 

information pouvant être difficile à obtenir, nous avons permis de collecter ces données 

durant un projet ECO. Il faut, cependant garder à l'esprit que le périmètre du projet de votre 

analyse ECO doit correspondre à la zone que vous étudierez à Hydro pour que cela soit utile 

(ex. bassin versant ou commune).  
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Options de collecte de données 

Il existe un certain nombre de variables facultatives qui peuvent être collectées. Chaque 

variable que vous collectez renforce l'analyse mais augmente également le coût du projet. 

Faites attention aux variables requises par les analyses supplémentaires que vous 

choisissez de faire. 

Table 3. Information sur les placettes (exemple de projet basé sur un inventaire par 
échantillonnage basé sur des placettes).  
Utilisez ce tableau pour guider vos décisions de collecte de données sur le terrain : 
La colonne description fournit plus d’informations sur chaque variable. Les composants 
supplémentaires du modèle indiqués dans les colonnes de droite nécessitent la collecte de 
certaines données optionnelles. Celles qui doivent être collectées pour chaque composant 
supplémentaire sont désignées par un «x». 
{L'élimination de la pollution par les pelouses / les herbacées n'est disponible pour le 
moment que pour les projets américains. Veuillez ne pas collecter ces données.} 
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Variables Description  

Champs minimum requis   

Pourcentage mesuré 
La superficie de la placette qui peut être accessible, mesurée 
et/ou incluse dans l’étude. 

REQUISE 
 

Pourcentage de couvert 
arboré 

La surface de la placette couverte par la canopée (en 
pourcentage). 

REQUISE 
 

Champs généraux   

Occupation 
du sol 

Occupation du 
sol actuel 

Type (s) d’occupation du sol observé (s) sur le terrain   
  

Pourcentage  
La superficie de la placette couverte par chaque occupation 
du sol 

  
  

Pourcentage du couvert 
arbustif 

La superficie de la placette couverte par la canopée arbustive 
(en pourcentage) 

x  
x  

Pourcentage d’espace 
plantable 

La superficie de la placette qui peut être plantée par des 
arbres (c.-à-d. Un sol plantable qui n'est pas sous la canopée 
des arbres ou d'autres restrictions aériennes et où la 
plantation / l'établissement d'arbres ne seraient pas interdits 
en raison de l’usage du sol, comme un terrain de baseball 

 x 

  

Adresse de la placette 
Adresse actuelle de la placette ou notes pour localiser celles 
dans les zones sans adresses 

  
  

Coordonnées GPS Longitude et latitude du centre de la placette     

Objet de 
référence 

Type de l’objet 
Repère(s) visible (s), tels qu'un panneau d'arrêt ou une 
structure permanente, visibles du centre du terrain 

  
  

Direction La direction du centre de la placette à l'objet de référence     

Distance 
La distance entre le centre de la placette et l'objet de 
référence 

  
  

DHP 
Diamètre du tronc à la hauteur de la poitrine (DHP) si l'objet 
de référence est un arbre 

  
  

Couvert au 
sol 

Couvert au sol Type (s) du couvert au sol observé(s) sur le terrain   x x 

Pourcentage 
La superficie de la placette couverte par chaque couvert au 
sol 

  
x x 

Détails sur 
les arbustes 

Espèce Nom d’espèces des arbustes x    

Hauteur 
Hauteur moyenne du groupe d'arbustes (c.-à-d. les arbustes 
de la même espèce) 

x  
  

Pourcentage de 
surface 

La superficie de la placette couverte par chaque groupe 
d’arbustes 

x  
  

Pourcentage 
manquant 

Pourcentage du volume du groupe d'arbustes manquant 
(c'est-à-dire non occupé par les feuilles) 

x  
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Tableau 3 (suite): Informations sur les arbres (exemple de projet basé sur un 
inventaire par échantillonnage basé sur des placettes). Utilisez ce tableau pour guider 
vos décisions de collecte de données sur le terrain : 
La colonne Description fournit plus d'informations sur chaque variable. Les composants 
supplémentaires du modèle indiqués dans les colonnes de droite nécessitent la collecte de 
certaines données optionnelles. Celles qui doivent être collectées pour chaque composant 
supplémentaire sont désignées par un «x».  
{Le couvert au sol sous la canopée nécessite l'utilisation de l'outil Hydro, actuellement non 
disponible pour les projets en dehors des États-Unis. Les utilisateurs européens seront 
informés lorsqu’Hydro sera disponible.} 

E
n

e
rg

ie
 

R
a
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a
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e
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 (
IP

E
D

) 

H
y

d
ro

 

Variables Description 

Champs minimum requis 

Espèces Identifier et saisir l’espèce et le genre de chaque arbre REQUISE 

DHP 
Mesurer et saisir le diamètre du tronc de chaque à la 
hauteur de la poitrine 

REQUISE 

Champs généraux du site 

Occupation du sol Type d’occupation du sol dans lequel se trouve l'arbre    

Statut Statut de l'arbre planté ou auto-ensemencé    

Distance au centre de la placette Distance entre l’arbre et le centre de la placette    

Direction vers le centre de la 
placette 

Direction de l’arbre vers le centre de la placette    

Arbre de rue/Non-arbre de rue Identifier si l'arbre est un arbre de rue ou non (O / N)    

Public/privé 
La classification de chaque arbre : géré par la ville (public) 
ou non (privé) 

   

Couvert au 
sol sous la 
canopée 

Pourcent 
imperméable 

Pourcentage de la surface imperméable au niveau de la 
projection au sol de la couronne 

  x 

Pourcentage 
d’arbustes 

Pourcentage de la surface occupée par des arbustes au 
niveau de la projection au sol de la couronne   

  x 

Champs relatifs aux arbres 

Hauteur totale de l’arbre Distance entre le sol et la cime (morte ou vivant)    

Taille de la 
couronne 

Hauteur jusqu’au 
sommet vivant 

Distance entre le sol et la cime (vivante)    

Hauteur jusqu’à la 
base de la 
couronne 

Distance entre le sol et la base de la couronne    

Largeur de la 
couronne 

Largeur de la couronne en deux directions : nord-sud et est-ouest    

Pourcentage du 
volume de la 
couronne 
manquante 

Pourcentage du volume de la couronne non occupé par les branches et les 
feuilles 

   

Etat sanitaire 
de la 
couronne 

Dépérissement Estimation du pourcentage de la couronne composée de branches mortes    

Condition 
Estimation de l'état de la couronne renseignée comme 100 moins le 
pourcentage de la couronne en dépérissement (c.-à-d. Branches mortes) 

 
 

 

Exposition de la couronne à la 
lumière 

Nombre de face de l'arbre recevant la lumière du soleil par le haut 
(maximum 5) 

   

Energie 
Direction Direction de l'arbre vers la partie la plus proche du bâtiment x   

Distance Distance la plus courte entre l'arbre et la partie la plus proche du bâtiment x   

Champs relatifs à la gestion 

Gestion recommandée 
Recommandations générales de gestion définies par l'utilisateur (par 
exemple, élagage de routine) pour l'arbre 

   

Tâche de gestion 
Tâches de gestion prioritaires définies par l'utilisateur (par exemple, 
traitement des parasites) pour l'arbre 

   

Conflit arbre/trottoir Ampleur du conflit entre le trottoir et la zone de contrefort de l'arbre    

Conflit d’utilité 
Conflits potentiels ou existants définis par l'utilisateur entre les branches 
d'arbre et les lignes aériennes d’utilité publique 

   

User ID Identifiant unique pour chaque arbre    
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Tableau 3 (suite): Informations sur les arbres (exemple de projet basé sur un inventaire par 
échantillonnage basé sur des placettes ). 
Utilisez ce tableau pour guider vos décisions de collecte de données sur le terrain : 
La colonne Description fournit plus d'informations sur chaque variable. Les composants 
supplémentaires du modèle indiqués dans les colonnes de droite nécessitent la collecte de certaines 
données optionnelles. Celles qui doivent être collectées pour chaque composant supplémentaire 
sont désignées par un «x».  
{Les données relatives aux ravageurs et IPED app ne sont disponibles que pour les projets aux 
États-Unis. Une catégorie de gestion peut être personnalisée pour renseigner des données liées aux 
ravageurs / maladies.} 

E
n

e
rg
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IP

E
D

) 

H
y

d
ro

 

Data Variables Description 

Champs relatifs à la gestion (suite) 

Ravageurs 
(IPED) 

Signes et 
symptômes du 
stress des arbres 

Absence ou présence de signes et symptômes de dépérissement, 
pousses épicormiques, feuillage flétri, stress environnemental ou 
stress humain 

 x  

Signes et 
symptômes de 
feuillage/brindille
s 

 
Absence ou présence de signes et symptômes de défoliation, 
feuillage décoloré, feuillage anormal ou signes d'insectes et 
étendue du feuillage affecté 
 

 x  

Signes et 
symptômes de 
branches/fût de 
l’arbre 

Absence ou présence de signes et symptômes d'insectes ou de 
maladies sur les branches / fût et localisation des signes ou 
symptômes 

 x  
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Tableau 4 : Informations sur les arbres (inventaire complet). Utilisez ce tableau pour guider vos 
décisions de collecte de données sur le terrain : 
La colonne Description fournit plus d'informations sur chaque variable. Les composants supplémentaires 
du modèle indiqués dans les colonnes de droite nécessitent la collecte de certaines données 
optionnelles. Celles qui doivent être collectées pour chaque composant supplémentaire sont désignées 
par un «x».  

E
n

e
rg

ie
 

R
a

v
a

g
e

u
rs

 (
IP

E
D

) 

Variables Description 

Champs minimum requis 

Espèces Identifier et saisir l’espèce et le genre de chaque arbre REQUISE 

DHP Mesurer et saisir le diamètre du tronc de chaque à la hauteur de la poitrine REQUISE 

Champs généraux du site 

Strate 
Sous-unités par lesquelles la zone d'étude est divisée pour l'analyse (p. 
Ex. occupation du sol, quartier) 

  

Occupation du sol Type d’occupation du sol dans lequel se trouve l'arbre   

Statut Statut de l'arbre planté ou auto-ensemencé   

Coordonnées GPS Longitude et latitude de l’arbre   

Arbre de rue/Non-arbre de 
rue 

Identifier si l'arbre est un arbre de rue ou non (O / N)   

Public/privé La classification de chaque arbre : géré par la ville (public) ou non (privé)   

Champs relatifs aux arbres 

Adresse de l’arbre 
Adresse où se trouve l’arbre ou notes pour localiser ceux dans les zones 
sans adresses 

  

Hauteur totale de l’arbre Distance entre le pied de l’arbre et la cime (morte ou vivante)   

Taille de la 
couronne 

Hauteur jusqu’au 
sommet vivant 

Distance entre le sol et la cime (vivante)   

Hauteur jusqu’à la 
base de la 
couronne 

Distance entre le sol et la base de la couronne   

Largeur de la 
couronne 

Largeur de la couronne en deux directions : nord-sud et est-ouest   

Pourcentage du 
volume de la 
couronne 
manquante 

Pourcentage du volume de la couronne non occupé par les branches et 
les feuilles 

  

Etat 
sanitaire 
de la 
couronne 

Dépérissement Estimation du pourcentage de la couronne composée de branches mortes   

Condition 
Estimation de l'état de la couronne renseignée comme 100 moins le 
pourcentage de la couronne en dépérissement (c.-à-d. Branches mortes) 

 
 

Exposition de la couronne à la 
lumière 

Nombre de face de l'arbre recevant la lumière du soleil par le haut 
(maximum 5) 
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Tableau 4 (Suite): Informations sur les arbres (inventaire complet). Utilisez ce tableau pour guider vos 
décisions de collecte de données sur le terrain : 
La colonne Description fournit plus d'informations sur chaque variable. Les composants supplémentaires du 
modèle indiqués dans les colonnes de droite nécessitent la collecte de certaines données optionnelles. Celles 
qui doivent être collectées pour chaque composant supplémentaire sont désignées par un «x».  
{Les données relatives aux ravageurs et IPED app ne sont disponibles que pour les projets aux États-Unis. 
Une catégorie de gestion peut être personnalisée pour renseigner des données liées aux ravageurs/ 
maladies.} 

E
n

e
rg

ie
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a
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e

u
rs
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IP

E
D

) 

Variables Description 

Champs relatifs aux arbres 

Energie 
Direction Direction de l'arbre vers la partie la plus proche du bâtiment x  

Distance Distance la plus courte entre l'arbre et la partie la plus proche du bâtiment x  

Champs relatifs à la gestion 

Gestion recommandée 
Recommandations générales de gestion définies par l'utilisateur (par 
exemple, élagage de routine) pour l'arbre 

  

Tâche de gestion 
Tâches de gestion prioritaires définies par l'utilisateur (par exemple, 
traitement des parasites) pour l'arbre 

  

Conflit arbre/trottoir Ampleur du conflit entre le trottoir et la zone de contrefort de l'arbre   

Conflit d’utilité 
Conflits potentiels ou existants définis par l'utilisateur entre les branches 
d'arbre et les lignes aériennes d’utilité publique 

  

Ravageurs 
(IPED) 

Signes et 
symptômes du 
stress des arbres 

Absence ou présence de signes et symptômes de dépérissement, pousses  
épicormiques, feuillage flétri, stress environnemental ou stress humain 

 x 

Signes et 
symptômes de 
feuillage/brindille
s 

 
Absence ou présence de signes et symptômes de défoliation, feuillage 
décoloré, feuillage anormal ou signes d'insectes et étendue du feuillage 
affecté 
 

 x 

Signes et 
symptômes de 
branches/fût de 
l’arbre 

Absence ou présence de signes et symptômes d'insectes ou de maladies sur 
les branches / fût et localisation des signes ou symptômes 

 x 

 

 

 

Nous vous recommandons fortement de collecter les informations d'arbre 

suivantes, ce qui améliorera la précision de vos estimations Eco ! 

• Occupation du sol actuel 

• Hauteur totale de l’arbre 

• Hauteur jusqu’au sommet vivant 

• Hauteur jusqu’à la base de la couronne  

• Largeur de la couronne 

• Pourcentage du volume de la couronne manquante 

Exposition de la couronne à la lumière  

• Etat sanitaire de la couronne (condition ou pourcentage de 

dépérissement) 

Astuce 
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Collecte des données relatives aux strates pour les inventaires complets 

L'une des variables décrites dans le tableau 4 est la strate. Cette donnée peut être collectée 

pour des projets d'inventaire complets et utilisée pour subdiviser les arbres de votre zone 

d'étude en différentes strates ou zones, telles que l’occupation du sol et les quartiers. 

 

Pour certaines études, la stratification (subdivision) des arbres en fonction des zones peut 

aider à clarifier les différences entre celles-ci. Par exemple, un inventaire complet stratifié 

avec de nombreux arbres peut permettre une comparaison entre les types d’occupation du 

sol ou les quartiers. La décision de stratifier doit être basée sur vos objectifs de projet actuels 

et futurs et sur vos ressources disponibles. 

 

 

 

Lorsque vous êtes prêts à aller sur le terrain et à collecter vos données relatives aux arbres, 

vous avez différentes options pour les saisir. Passez en revue les descriptions et les 

avantages / inconvénients de chaque option avant d’aller sur le terrain. 

 

Utilisation du collecteur mobile de données 

i-Tree Eco propose un collecteur mobile de données pour collecter des données sur le 

terrain. Les projets peuvent être menés à l'aide d'un appareil mobile doté d’une connexion 

 Décider comment saisir vos données 

 

La réalisation de la stratification est différente pour les projets d’inventaires 

par échantillonnage basés sur des placettes. Dans ce cas, si la 

stratification vous intéresse veuillez en savoir plus dans Phase I > Plot-

Based Sample Inventory. 

Astuce 

 

Consultez  Eco Guide to Stratifying a Complete Inventory pour en savoir 

plus sur la pré-stratification ou la post-stratification de votre inventaire complet.  

    ECO Guide 
 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_StratifyingCompleteInventory.pdf
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internet. Cette fonctionnalité n'est pas une application que vous devez télécharger dans le 

store ; il s’agit d’un formulaire de collecte de donnée d’inventaire via le web. Cela signifie que 

la seule exigence est un appareil avec un navigateur Web compatible HTML5. Les 

navigateurs compatibles incluent les versions les plus récentes de Chrome et Firefox (pour 

les téléphones et tablettes Android), Safari (pour les iPhones et iPads) et, dans une moindre 

mesure, Internet Explorer 9 et 10 (pour les téléphones et les tables Windows). Internet 

explorer (IE) est limité par sa capacité à mettre les données en cache hors ligne - les 

utilisateurs doivent rester « connectés » lors de la collecte des données de terrain. Pour cette 

raison, si vous utilisez IE, vous devez être prêts à transférer fréquemment vos données de 

votre appareil mobile vers le serveur. Une déconnexion signifie la perte de vos données 

depuis votre dernière sauvegarde.  

 

Avantages 

• Importation facile des données vers ECO 

 

Inconvénients 

• Nécessite une technologie supplémentaire sur le terrain – obligation d’avoir un 

appareil mobile doté d’une connexion internet, tel qu'un smartphone ou une tablette 

 

Utilisation du formulaire papier 

i-Tree Eco propose des formulaires papier pour la collecte de données sur le terrain qui 

fournissent une méthode de saisie de données simple et peu coûteuse . 

Avantages 

• Facile à utiliser 

• Ne demande pas de technologies supplémentaires sur le terrain. Juste du papier, un 

stylo ou un crayon ! 

 

Inconvénients 

• Nécessite une saisie manuelle des données pour les importer dans Eco 

 

 

Pour avoir la liste des appareils compatibles veuillez consulter  le forum i-

Tree forum.itreetools.org ou le document de configuration du système: 

www.itreetools.org/resources/manuals.php. 

Astuce 

http://forums.itreetools.org/
http://www.itreetools.org/resources/manuals.php
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Options supplémentaires 

PDAs 

Les anciennes versions d'Eco prenaient en charge l'utilisation d'un PDA pour la collecte de 

données, qui fonctionnait parfaitement avec l'application de bureau. Eco v6.0 ne prend pas 

en charge l'utilisation de PDA pour la collecte de données. 

 

Plateformes d’inventaire extérieures (non-i-Tree) 

Si votre communauté manque de financement pour prendre en charge l'utilisation d'appareils 

mobiles ou de PDA ou si vous préférez simplement utiliser une autre méthode, ce n'est pas 

un problème. Les inventaires peuvent être effectués en utilisant des formulaires papier ou 

des tableurs et des outils d'inventaire conçus par vous-même ou par d’autres logiciels, etc. 

L'application Eco comprend un formulaire de saisie facile à utiliser pour simplifier le 

processus. L'exploration du processus de saisie manuelle des données dans l'application 

peut vous aider si vous décidez d'utiliser une plateforme extérieure (plateformes non-i-Tree).  

 

 

 

Votre dernière étape avant d'être prêt à collecter vos données de terrain est de configurer 

vos supports de collecte de données. Si votre projet est basé sur un inventaire par 

échantillonnage basé sur des placettes, lisez la section cartographie des placettes de terrain 

ci-dessous. Sinon, passez à la section Prise en main d’Eco. 

 

Cartographie des placettes de terrain 

Pour les projets d’inventaire par échantillonnage, l’une des dernières étapes avant de 

commencer la collecte de données consiste à créer des cartes identifiant l'emplacement 

physique des placettes. Si l’échantillon aléatoire des placettes a été créé avec le SIG, le 

 Se préparer pour le terrain 

 

D'autres utilisateurs d'i-Tree ont développé des fiches de données 

modifiables pour la collecte de données qui sont disponibles sur 

www.itreetools.org dans la section Eco ressources de Resources > 

Archives. 

Astuce 

http://www.itreetools.org/
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fichier shapefile des placettes peut être superposé sur des photos aériennes de la zone 

étude pour aider les équipes de terrain à localiser les placettes et leurs centres sur le terrain.  

De même, si vous avez créé vos points aléatoires à l'aide du « Google Maps Plot 

generator », ils peuvent être introduits dans le SIG et superposés sur des photos aériennes 

numériques. De plus, des cartes détaillées des placettes peuvent être très utiles pour aider 

les équipes à estimer le pourcentage des différents couverts au sol de chaque placette. Des 

exemples de cartes de placettes sont disponibles sur www.itreetools.org sous Resources > 

Archives > Eco Project Planning & Management Resources. Si des photos numériques 

ne sont pas disponibles ou si les placettes ont été générées manuellement, elles peuvent 

être localisées sur une carte d’occupation du sol, sur une carte du réseau routier ou sur des 

cartes papier. Les centres et le périmètre des placettes doivent être identifiés. 

 

Prise en main d’ECO 

Si vous avez décidé d'utiliser le collecteur mobile de données Eco ou les formulaires papiers, 

nous vous recommandons de procéder comme suit : 

Commencez à travailler avec Eco pour créer un nouveau projet. Cliquez sur le bouton 

Démarrer de votre ordinateur> Programmes> i-Tree> i-Tree Eco v6. 

Pour démarrer a nouveau: 

1 Cliquez sur File > New Project. 

2 Définissez le type de projet en choisissant dans la liste déroulante. 

3 Accédez au dossier dans lequel vous souhaitez enregistrer votre projet, saisissez un 

nom de fichier et cliquez sur Save. 

 

Pour configurer votre projet : 

1 Cliquez sur l’onglet Project Configuration. 

2 Cliquez sur la fonction Project Definition. 

3 Parcourez les onglets Project Settings, Location, et Data Collection Options de 

gauche à droite. 

4 Fermez la fonction Project Definition lorsque vous avez terminé en cliquant sur le 

bouton OK dans le coin supérieur droit pour enregistrer vos paramètres. 

 

Les instructions pour créer votre échantillon aléatoire à l’aide de Google 

Maps Plot Generator or SIG d’ESRI sont disponibles dans les guides 

suivants : 

• Eco Guide to Unstratified Samples 

• Eco Guide to Pre-stratified Samples 

Guide Eco  

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UnstratifiedSamples.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PreStratifiedSamples.pdf
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5 Parcourez de gauche à droite dans l’onglet Project Configuration pour fournir des 

informations supplémentaires sur les fonctions pertinentes pour votre projet. 

 

Préparer les formulaires papiers 

Si vous avez décidé de collecter vos données à l'aide du formulaire papier d'Eco et que vous 

avez déjà configuré votre projet (comme décrit dans la section Prise en main d'Eco): 

1 Cliquez sur l’onglet Data. 

2 Cliquez sur la fonction Paper Form. 

 

Des liens vers les divers formulaires papiers de collecte de données apparaîtront dans le 

panneau à droite. Cliquez sur un lien pour lancer le formulaire dans votre navigateur Web. 

Les types de formulaires suivants sont disponibles : 

• Pour les utilisateurs effectuant un projet d'inventaire complet, il existe une seule fiche 

technique au format xlsx pour la saisie des données relatives aux arbres 

• Pour les utilisateurs réalisant un inventaire par échantillonnage basé sur des 

placettes, il existe deux fiches techniques. Le premier au format xlsx pour la saisie 

des données relatives aux arbres et le deuxième au format doc pour la saisie des 

données des placettes. 

 

 

Préparer le collecteur mobile de données  

 

Avant de pouvoir commencer à travailler avec le collecteur mobile de 

données, vous devez soumettre la configuration de votre projet. Si vous ne 

soumettez pas votre projet, vous ne pourrez pas accéder au formulaire Web à 

partir de votre appareil mobile. 

Avertissement 

 
! 

 

Lorsque vous travaillez dans Eco, utilisez le texte d'aide à l'écran dans le panneau 

sur le côté gauche de la fenêtre. Ce texte fournira des instructions pour 

l'utilisation de chaque bouton et fonction, étape par étape. 

 

Astuce 

 

Utilisez les informations proposées dans Phase IV > Navigating the User 

Interface pour vous aider à naviguer dans les fonctions de l’onglet Project 

Configuration. 

Astuce 
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Si vous avez décidé de collecter vos données à l'aide du collecteur mobile de données d'Eco 

et que vous avez déjà configuré votre projet (comme décrit dans la section Prise en main 

d'Eco) : 

1 Cliquez sur l’onglet Data. 

2 Cliquez sur la fonction Submit to Mobile. 

3 Saisissez et confirmez votre adresse mail dans les espaces prévus à cet effet. 

4 Saisissez et confirmez le mot de passe dans les espaces prévus à cet effet. 

5 Cochez la case à côté des enregistrements que vous souhaitez soumettre. 

6 Cliquez sur Submit Project. 

7 Vérifiez le compte mail que vous avez fourni pour obtenir des instructions sur l'accès 

au collecteur mobile de données pour votre projet. 
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Phase IIIB décrit comment collecter et enregistrer les variables nécessaires pour votre projet 

Eco. Les méthodologies décrites visent à fournir à tous les utilisateurs des protocoles 

standardisés pour la collecte de leurs données. 

À ce stade, vous devriez avoir : 

• Choisi les variables que vous collecterez sur le terrain ; 

• Décidé comment vous allez collecter et saisir vos données de terrain ; 

• Conçu et créé votre échantillon de placette (uniquement pour les projets d’inventaire 

par échantillonnage basé sur des placettes uniquement) ; 

• Préparé votre matériel de collecte de données pour aller sur le terrain. 

 

Les méthodologies de collecte des données sont décrites ici pour toutes les variables 

obligatoires et facultatives qui peuvent être collectées pour un projet Eco. Les variables 

peuvent s'appliquer (A) à des projets d’inventaire par échantillonnage basé sur des placettes 

uniquement, (B) à des projets d'inventaire complets uniquement ou (C) à la fois à des projets 

d’inventaire par échantillonnage basé sur des placettes et à des projets d'inventaire 

complets. Utilisez les informations du manuel d’utilisateur Eco User’s Manual pour vous 

assurer de collecter les variables appropriées à votre projet. 

Phase IIIB est devisée en 4 catégories selon le type des variables : 

• Information concernant le relevé 

• Information concernant les placettes 

• Information concernant les arbres 

• Information concernant la gestion 

 

Chaque variable est décrite en détail. Des informations sur la manière de saisie des données 

dans les formulaires papiers fournis dans Eco ou à l’aide du collecteur mobile de données 

d’Eco sont aussi décrites. 

 

Phase IIIB: Collecte de vos données de terrain 

 Sortir sur le terrain 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6_UsersManual.pdf
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Si vous avez décidé de saisir vos données de terrain à l'aide du collecteur mobile de 

données d'Eco, vous utiliserez également un appareil mobile doté d’une connexion internet, 

tel qu'un smartphone ou une tablette. Des détails importants sont à savoir sur l'utilisation d'un 

appareil mobile avec Eco. 

Pour permettre l'accès à Eco sur le plus grand nombre d'appareils, nous avons choisi de 

créer le collecteur mobile de données sous format formulaire Web accessible à partir du 

navigateur Internet de votre appareil plutôt que sous forme d'application. Cela a plusieurs 

conséquences sur l’utilisation : 

• Lorsque vous collectez des données, elles sont stockées temporairement dans la 

mémoire cache de votre navigateur Internet. La quantité de stockage disponible varie 

considérablement en fonction de l'appareil, du navigateur et des paramètres. Vous 

pouvez augmenter la quantité de stockage disponible en effaçant l'historique et les 

données de votre navigateur. Si votre stockage est saturé par l'historique de 

navigation ou d'autres données, vos données peuvent être limitées à peu 

d'enregistrements. Avec un historique et des données effacés, vous pouvez 

probablement stocker des centaines d'enregistrements. 

 

• Pour les utilisateurs de Chrome, Firefox et Safari : Bien que vous travailliez via une 

page Web, vous n'êtes pas limités à travailler uniquement lorsque vous avez accès à 

Internet (via une connexion sans fil ou à haut débit, comme la 3G ou mieux). Le 

cache du navigateur tel que décrit ci-dessus vous permettra de travailler 

temporairement même sans connexion Internet. Vous n'avez pas à vous soucier des 

pertes de connectivité à court terme, mais à la fin, vous devez vous connecter et 

soumettre vos données. 

 

Astuces pour la saisie des données 

 Utilisation du collecteur mobile de données 

 

Envoyez fréquemment des données au serveur pour éviter de perdre des 

données ou de remplir la mémoire cache de votre navigateur. Consultez les 

descriptions du menu Options ci-dessous pour plus d'informations. 

Astuce 
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• Pour les utilisateurs d'Internet Explorer, ce n'est malheureusement pas le cas. IE est 

limité dans sa capacité à mettre en cache les données hors ligne - les utilisateurs 

doivent rester « connectés » lors de la collecte des données de terrain. Pour cette 

raison, si vous utilisez IE, vous devez être prêts à soumettre fréquemment des 

données de votre appareil mobile au serveur et à reconnaître qu'une connexion de 

données interrompue signifie que toutes les données collectées depuis votre dernière 

soumission seront perdues. 

 

• Lorsque la mémoire de votre cache est pleine, vous recevrez un message 

d'avertissement vous suggérant de vider le cache et l'historique de votre navigateur. 

Avertissement : Vous devez soumettre vos données avant de le faire, sinon elles 

seront perdues. 

 

Prise en main 

 

Le collecteur mobile de données pour Eco n'est pas une application, c'est un formulaire Web 

accessible sur Internet conçu spécifiquement pour votre projet. Pour accéder à ce formulaire 

Web et commencer à collecter des données : 

1 Ouvrez l'application de messagerie de votre smartphone ou tablette. 

 

2 Ouvrez l'e-mail contenant le lien vers le formulaire Web personnalisé de votre projet. 

 

3 Une nouvelle fenêtre s'ouvrira dans le navigateur Web de votre appareil. Pour 

commencer, entrez le nom de l'utilisateur dans la zone Surveyor et cliquez sur 

Connexion. 

 

Menu options 

 

La roue d’engrenage en haut à gauche vous permet d'accéder au menu Options, où vous 

pouvez effectuer des opérations telles que la soumission de données et le rechargement de 

la configuration du projet ainsi que le réglage du nombre de données à saisir par page. 

Settings : dans l’onglet Settings, vous pouvez ajuster le nombre de placettes et 

d'espèces qui apparaissent par page (10 par défaut) et définir le format de la liste 

 

Si vous rencontrez des problèmes avec le navigateur Internet de votre 

appareil mobile, consultez l'App Store de votre appareil et téléchargez le 

navigateur Internet qui vous convient le mieux. 

 

Astuce 
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d'espèces (noms communs, de noms scientifiques ou de codes d'espèce). 

Submit data: il est essentiel de soumettre souvent vos données au serveur Web! 

Vérifiez dans la fenêtre Submit Data le nombre de placettes à soumettre (en haut de la 

page) et cliquez sur le bouton Submit. 

Reload project: si des aspects de la configuration du projet changent après avoir 

commencé à collecter des données, vous devrez recharger le projet pour intégrer ces 

modifications. Les modifications de la configuration de votre projet doivent être effectuées 

dans l’application i-Tree Eco et soumises à partir de l’onglet Data. Après la soumission 

du projet, vous pouvez cliquer sur le bouton Reload Project dans le collecteur mobile de 

données et vous serez à jour. 

 

Fenêtre principale 

 

Pour les projets d’inventaire par échantillonnage, avec des placettes pré-chargées, la 

fenêtre principale affiche une liste numérique de toutes les placettes. Cliquez sur le numéro 

approprié de la placette pour commencer la collecte des données. Pour les projets 

d’inventaire complet, la collecte de données commence en cliquant sur le signe (+) situé au 

coin supérieur droit pour ajouter le premier arbre.  
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Description:  

Date de la collecte de données. 

Comment saisir : 

• Papier (pour un échantillon et un inventaire complet) : entrez sous DATE sur la 

première page. 

• Collecteur mobile de données (pour un échantillon et un inventaire complet) : la date 

est automatiquement enregistrée au début de la session d’inventaire lors de la 

connexion. 

 

 

Description: 

Nom ou numéro de l'équipe chargée de l'inventaire. 

Comment saisir : 

• Papier (pour un échantillon) : entrez sous CREW sur la première page. 

• Papier (pour un inventaire complet) : entrez sous CREW/DATA COLLECTOR en 

haut de la page. 

• Collecteur mobile de données (pour un échantillon et un inventaire complet) : le nom 

est entré sous Surveyor au début de la session d’inventaire lors de la connexion. 

 

 

  

Informations concernant le relevé  

 Date du relevé (Survey Date) 

 Equipe (Crew) 
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L’inventaire par échantillonnage commence par la délimitation de la placette. Si vous 

effectuez un inventaire complet, vous pouvez passer à la section suivante relative au guide 

de terrain, informations concernant les arbres. Si vous allez effectuer un inventaire basé 

sur un échantillon de placettes, assurez-vous d’obtenir la permission d’accéder à la propriété 

si nécessaire (auprès des habitants ou du propriétaire). 

 

 

Premièrement, localisez le centre de la placette et son périmètre. Si vous avez cartographié 

vos placettes comme décrit dans la Phase IIIA (voir « Se préparer pour le terrain> 

Cartographie des parcelles de terrain »), vous pouvez utiliser les photographies aériennes 

et/ou les cartes que vous avez créées pour vous aider à les délimiter. Si la placette est sur 

un terrain en pente, mesurez la pente avec un inclinomètre et ajustez la largeur de la 

placette en conséquence. Les rayons ajustés sont renseignés dans le tableau suivant : 

Pente % 5 10 12 15 17 20 22 25 27 30 

Angle de la pente 2.9 5.7 6.8 8.5 9.7 11.3 12.4 14.0 15.1 16.7 

Rayon ajusté (placette de 
0.04 ha) 

11.37 11.37 11.40 11.40 11.43 11.46 11.49 11.52 11.55 11.58 

Rayon ajusté (placette de 
0.067 ha) 

14.66 14.69 14.69 14.72 14.75 14.78 14.81 14.87 14.90 14.97 

 

Dans certains cas, le centre de la placette peut se trouver dans un endroit inaccessible, tel 

qu’en plein milieu d'un bâtiment ou d'une autoroute. Dans ce cas, ne choisissez pas une 

autre placette, mais suivez plutôt les instructions pour les Centres de placettes 

inaccessibles (voir l'encadré ci-dessous) pour sélectionner Tree Measurement Point (TMP) 

à utiliser pour la collecte de données ultérieure. 

Informations concernant les placettes 

 Délimitation de la placette 

 

Des exemples de lettre de notification d’accès et de carte-réponse ont été 

créés par d’autres utilisateurs Eco. Ces ressources sont disponibles sur le 

web : www.itreetools.org sous Resources > Archives. 

Astuce 

https://www.itreetools.org/index.php
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Ajout des placettes de remplacement 

Si vous ne parvenez pas à accéder à une placette ou à collecter des données à distance, 

vous devez en sélectionner une autre. Si vous avez une liste de placettes de remplacement, 

sélectionnez la première de la liste en respectant l’occupation du sol de la placette à 

remplacer. Dans le cas d’un plan d’échantillonnage systématique (échantillonnage par grille), 

la placette de remplacement doit être située dans la même cellule et la même occupation du 

sol que la placette inaccessible. Suivez successivement l’ordre des placettes de 

remplacement.  

Si vous n'avez pas créé des placettes supplémentaires lors de la configuration du projet, 

vous pouvez les ajouter manuellement dans la base de données dès votre retour au bureau. 

Vous pouvez cliquer sur la fonction Plots de l’onglet Data. Le groupe Action apparaitra dans 

la barre d’outils. Utilisez la fonction New pour ajouter manuellement une nouvelle placette 

dans le tableau des placettes qui sera affiché dans le panneau d’actions « action panel ».  

Avec l’identification du centre et du périmètre de la placette et la détermination, si 

nécessaire, du TMP, vous êtes prêts à commencer la collecte des données.  
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Centres de placettes inaccessibles 

Dans certains cas, le centre de votre placette peut se trouver dans un endroit inaccessible comme au milieu d’un 

bâtiment ou d’une autoroute. Cet encadré explique comment déterminer le périmètre de la placette et 

l’emplacement des arbres quand le centre d’une placette est incessible (Fig.1) (Notez que les chiffres de cet 

exemple ne sont valables que pour les placettes ayant une superficie de 0.04 ha). 

Déterminez ‘a’ en estimant approximativement la localisation du centre de la placette à l’aide d’une photo 

aérienne ou d’une carte. Calculez ‘b’ en 

soustrayant ‘a’ du rayon (ex. 11.3 m pour 

une placette de 0.04 ha). Ainsi, ‘b’ est la 

distance entre la limite de la placette et le 

mur du bâtiment.  

Pour tracer le périmètre de la placette 

marchez parallèlement au bâtiment sur 8,0 

m (y1), puis perpendiculairement au 

bâtiment sur 3,3 m (x1). Cela représente 

un point le long du périmètre à environ 45° 

du point de départ. Si vous marchez 

ensuite 3,3 m (y2) parallèlement au bord 

du bâtiment et 8,0 m (x2) 

perpendiculairement, une prochaine limite 

du périmètre de la placette serait atteinte 

représentant un point à 90 ° le long d'un 

cercle à partir du point de départ. 

Pour faciliter la localisation des arbres dans 

la placette, l’équipe doit d’abord déterminer 

les limites de la placette comme décrit ci-

dessus, puis choisir un point à partir duquel 

la distance et la direction peuvent 

facilement être mesurées qui servira de 

Tree Measurement Point (TMP). Sur la 

figure, un coin du bâtiment a été choisi 

comme TMP. (Saisissez le TMP dans les 

notes - par exemple, coin nord-ouest du 

bâtiment.).             Figure 1—Détermination du Tree Measurement Point et  

     des limites de la placette 

N'oubliez pas de relever uniquement les arbres qui se trouvent dans le rayon autour du centre de la placette. Les 

arbres c, d et f se trouvent tous à l’intérieur de la placette initiale doivent être inventoriés. L'arbre e, en revanche, 

se trouve à moins de 11,3 m du TMP, mais loin du centre. Par conséquent, il n’est pas relevé car il se trouve en 

dehors du périmètre 
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Description : 

Numéro d'identification de la placette (doit être un identifiant unique). 

Comment saisir : 

• Papier : entrez un numéro unique sous PLOT ID en haut de la première page. 

• Collecteur mobile de données : dans la fenêtre principale, sélectionnez le Plot ID de la 

liste générée de toutes les placettes. 

 

 

Description :  

Adresse de la placette ou notes pour localiser les placettes dans les zones sans adresses. 

Cette variable est particulièrement utile pour revisiter les placettes ou mettre en place des 

placettes permanentes. 

Comment saisir : 

• Papier : entrez sous Plot address de la première page. 

• Collecteur mobile de données : entrez sous Plot Info > Address. 

 

 

Description : 

Indiquer si l'emplacement des placettes permanentes a été marqué par un identificateur 

permanent (O / N).  

Comment saisir : 

• Papier : entrez Oui (O) ou non (N) sous Permanent stake used de la première page. 

• Collecteur mobile de données : mettez le champ sur oui ou sur non sous Plot Info > 

Stake. 

 

 

 

 ID de la placette (Plot ID) 

 Adresse de la placette (Plot Address) 

 Piquet (Stake) 
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Description : 

Longitude et latitude du centre de la placette. Cette variable est particulièrement utile pour 

revisiter les placettes ou mettre en place des placettes permanentes. La précision du GPS peut 

varier considérablement notamment sous les arbres.  

Comment saisir : 

• Papier : entrez la longitude et latitude sous GPS Coordinates de la première page. 

• Collecteur mobile de données : entrez sous Map Coordinates. Il y a trois options pour 

renseigner les coordonnées. Les saisir, utiliser un appareil gps, ou marquer 

l’emplacement sur une carte. 

 

 

Description :  

Numéro d'identification des photos associées à la placette. Si des photos sont prises, utilisez 

cet identifiant pour garder leur trace et celle du numéro de la carte mémoire où elles sont 

enregistrées. 

Comment saisir : 

• Papier : entrez sous Photo ID(s) de la première page  

• Collecteur mobile de données : entrez sous Plot Info > Photo. 

 

 

Description :  

Un croquis représente la distance et la direction du centre de la placette vers les objets de 

référence et/ou l’emplacement d’objets fixes par rapport au centre de la placette.  

Comment saisir : 

• Papier : dessinez dans Plot Sketch Area en bas de la deuxième page. 

• Collecteur mobile de données : N/A 

 

 

 Les coordonnées GPS (GPS Coordinates) 

 ID des photos (Photo ID) 

 Croquis de la placette (Plot Sketch) 
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Description :  

Nom et numéro de téléphone de la personne de contact. Enregistrez ces informations de 

contact si elles sont disponibles. Ne demandez pas ces informations dans le secteur résidentiel, 

en revanche vous pouvez noter le nom mentionné dans la boîte aux lettres. Le statut 

propriétaire/ locataire est utile s’il est disponible.  

Comment saisir: 

• Papier: entrez le nom et le numéro de téléphone Plot Contact Name and Phone # de la 

première page. 

• Collecteur mobile de données : entrez sous Plot Info > Contact Info. 

 

 

Description : (Remarque: cette variable est requise pour tous les projets d’inventaire par 

échantillonnage basé sur des placettes) 

Surface de la placette que l'équipe de terrain est en mesure d'y accéder et de la mesurer, 

directement ou par estimation. Cela permet la collecte partielle de données. Par exemple, si 

10% de la placette est situé derrière un bâtiment ou derrière une haute clôture de palissade sur 

un terrain auquel vous ne pouvez pas accéder, vous saisissez 90%. (Les problèmes de sécurité 

peuvent également être un facteur d’accès aux placettes.) Cependant, si vous pouviez regarder 

par-dessus d’une clôture pour identifier l’espèce et estimer le couvert arboré, le DHP ainsi que 

d’autres mesures pour les arbres situés en zone inaccessible, vous pouvez saisir 100%. 

Comment saisir : 

• Papier : entrez sous Per. of Plot Measured (%) de la première page. 

• Collecteur mobile de données : entrez sous Plot Info > % Measured 

 

 

 Coordonnées de la personne de contact de la placette (Plot Contact Info) 

 Pourcentage mesuré (Percent Measured) 
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Description: (Remarque: cette variable est requise pour tous les projets d’inventaire par 

échantillonnage basé sur des placettes ) 

Pourcentage de la surface de la placette occupée par le couvert arboré. Il correspond à la 

surface ombragée par des arbres lorsque le soleil est au Zénith. La valeur peut varier de 0 à 

100%. La placette peut être couverte de canopée provenant d’arbres situés en dehors de son 

périmètre. Ainsi, des placettes ne contenant pas d'arbres peuvent néanmoins avoir un couvert 

arboré. 

 Couvert arboré (Tree cover) 

 

 

Pour les projets stratifiés, cette mesure peut être utile dans le cas 

inhabituel où votre placette est couverte par plusieurs strates qui ont 

été conçues dans le cadre du projet. Le centre de la placette peut être 

localisée dans l’occupation du sol appropriée mais le périmètre peut 

s’étendre sur plusieurs occupations du sol ayant des caractéristiques 

de végétation très différentes. 

Dans ce cas, vous pouvez collecter des données uniquement sur la 

partie de la placette se trouvant dans l’occupation du sol désignée et 

utiliser le champ « Percent measured » pour réaliser l'ajustement. Par 

exemple : si le centre de la placette est situé dans la strate occupation 

du sol commerciale et que son périmètre s’étend aussi sur des zones 

forestières, vous pouvez indiquer le pourcentage mesuré de la 

végétation située dans la zone commerciale. Cette démarche permet 

d’éviter la prise en compte des arbres de l’occupation du sol forêt dans 

celle commerciale. 

Astuce 

 

Les photos aériennes utlisées pour localiser les placettes sont très utiles 

pour determiner les pourcentages du couvert arboré. 

Astuce 
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Comment saisir: 

Saisissez le pourcentage: 0%, 100% ou le point milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

• Papier: entrez sous Plot Tree Cover (%) de la première page. 

• Collecteur mobile de données: entrez sous Plot Info > % Tree cover. 

 

 

Description:  

Pourcentage de la surface de placette couverte par la canopée arbustive. Il correspond à la 

surface ombragée par les arbustes quand le soleil est au Zénith. La valeur varie de 0 à 100%. 

Ne comptez pas doublement plusieurs strates d’arbustes. 

Comment saisir: 

Saisissez le pourcentage: 0%, 100%, ou le point milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

• Papier: entrez sous Shrub Cover (%) de la première page. 

• Collecteur mobile de données : entrez sous Plot Info > % Shrub cover. 

 

 

Description:  

L’espace plantable représente le pourcentage de la surface de la placette qui peut être plantée 

par des arbres (ex. Un sol plantable qui n'est pas sous la canopée d’arbres ou sous autres 

restrictions aériennes et où la plantation / l'établissement d'arbres ne seraient pas interdits en 

raison de l’usage du sol, comme un sentier, un terrain de football La plantation sous les câbles 

électriques est autorisée. 

 

 

 Couvert arbustif (Shrub cover) 

 Espace plantable (Plantable Space) 

 

Pour un projet Eco, les arbustes sont généralement définis comme une 

plante ligneuse d’un diamètre à hauteur de poitrine (DHP) inférieur à 2,54 

cm tandis que les arbres ont un DHP supérieur ou égal à 2,54 cm. Les 

plantes ligneuses qui ne mesurent pas 30.5 cm de hauteur (ex. les 

plantules) sont considérées comme des herbacées. 

Astuce 



 

 
 

50 

 

Comment saisir: 

Saisissez les pourcentages : 0%, 100%, ou le point milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

• Papier: entrez sous Plantable Space (%) de la première page. 

•  Collecteur mobile de données : entrez sous Plot Info > % Plantable. 

 

 

 

 

 

Descriptions: 

Identifiez au moins un point de repère visible à partir du centre de la placette (en se plaçant au 

centre de la placette). La mise en place de placettes permanentes requiert la sélection de deux 

ou trois points de références quand le centre de la placette est inaccessible ou difficile à 

localiser. Ces points peuvent être situés en dehors du périmètre de la placette. Les données 

suivantes sont nécessaires pour décrire vos objets de référence :  

• Object type – Repère(s) visible (s), tels qu'un panneau d'arrêt ou une structure 

permanente, visibles du centre de la placette (en se plaçant au centre de la placette). 

• Direction – La direction du centre de la placette à l'objet de référence. 

• Distance – La distance entre le centre de la placette et l'objet de référence. 

• DHP – Diamètre du tronc à hauteur de poitrine (DHP) si l'objet de référence est un 

arbre. 

 

 

 Objets de référence (Reference Objects) 

 

Une mesure plus précise peut être obtenue en utilisant comme point de 

départ la somme des couverts au sol suivants (notés ci-dessous) pour 

évaluer l'espace plantable : sol, détritus organiques / paillis, herbe / lierre, 

pelouse et prairie. 

Astuce 

 

La définition de l’espace plantable étant subjective, les chefs de projet doivent 

clairement définir les espaces à prendre en considération pendant la 

formation des membres d’équipes  

 

Avertissement 

 
! 
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Comment saisir: 

Essayez d'utiliser des objets susceptibles d'être présents dans les 5 à 15 ans à venir (par 

exemple : panneaux de signalisation, poteaux téléphoniques, structures permanentes, trottoirs / 

allées). Si la placette se trouve dans une zone forestière dépourvue d’objets permanents 

(construits ou naturels), sélectionnez deux arbres témoins (espèce remarquable ou arbre de 

grande taille) qui, selon vous, resteront présents dans la placette dans le futur. Les photos de 

ces éléments sont très utiles. Décrivez chaque objet de références de manière très précise (par 

exemple, poteau téléphonique à 1,5 m du bord gauche de l’allée en face de la maison. Mesurez 

la distance et la direction (1°-360°) vers le point de référence à partir du centre de la placette.  

• Papier: entrez la description, la direction et la distance pour un ou deux points de 

référence sur la première page. 

• Collecteur mobile de données : cliquez sur le signe plus (+) du coin supérieur droit de 

la fenêtre Reference Objects et sélectionnez un type d’objet de la liste déroulante. 

Saisissez la distance et la direction et cliquez sur la flèche dans le coin supérieur droit. 

Répétez si nécessaire pour un deuxième objet. Pour modifier un objet de référence, 

cliquez sur l’entrée correspondante dans la fenêtre de Reference Objects. Quand tous 

les objets de références sont saisis, cliquez sur la flèche gauche left arrow de la 

fenêtre principale de Reference Objects pour revenir au menu principal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Utilisez un de vos points de référence pour servir de TMP si le centre de 

la placette est inaccessible. 

• Pour la collecte de données sur papier, cochez la case à côté de 

l’objet utilisé comme TMP dans les objets de référence. 

• Collecteur mobile de données, entrez TMP dans le champ Notes de 

l’objet servant de TMP 

Référez-vous au Inaccessible Plot Centers pour plus d’informations. 

Astuce 
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Pendant la collecte de données liée à Tree Information, vous pouvez saisir 

l’occupation du sol dans laquelle chaque arbre est situé. Dans le cadre d’un 

inventaire par échantillonnage, si vous avez renseigné l’occupation du sol de 

la placette, vous devez également l’identifier pour les arbres. Consultez Land 

Use descriptions dans la section Tree Information de ce guide pour plus 

d’informations. 

Avertissement 

 
! 

 

Descriptions:  

L’occupation du sol doit être déterminée par l'équipe d'inventaire sur base des impressions 

recueillies lors de la collecte des données sur le terrain (c'est-à-dire, pas à partir des cartes 

d’occupation du sol). Cette variable décrit l’usage du sol, ce qui n'est nécessairement pas la 

même chose que la propriété du terrain. 

Eco propose par défaut 13 classes d’occupation du sol parmi lesquelles les utilisateurs peuvent 

choisir. Par ailleurs, ils peuvent créer des classes personnalisées dans le logiciel i-Tree Eco. 

Les classes définies par l'utilisateur doivent être attribuées à l'une des classes par défaut. 

 

Les données suivantes sont nécessaires pour décrire vos occupations du sol :  

• Actual land use – type (s) d’occupation du sol observé (s) sur le terrain 

• Percent of plot – le pourcentage de la surface de la placette couverte par chaque 

occupation du sol 

 

 

 Occupation du sol (Land Use) 

 

 

Les catégories actuelles d’occupation du sol peuvent être modifiées, mais ne 

doivent pas être utilisées pour stratifier votre terrain d’étude. Ainsi, la 

comparaison de vos données en fonction des classes d’occupation du sol 

actuelles ne sera pas fournie. Pour vous aider à stratifier votre terrain 

d’étude, veuillez consulter “Plot-Based Sample Inventory > Will you 

stratify your sample?”. 

Avertissement 

 
! 
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Les types d’occupation du sol par défaut suivants sont inclus: 

• Agriculture (A): Terres cultivées, pâturages, vergers, vignobles, pépinières, fermes et 

bâtiments correspondants, parcs d'engraissement, prairies, exploitation forestière/ 

plantations qui témoignent d'une activité de gestion pour une culture ou une production 

d'arbres spécifiques. 

 

• Cemetery (E): Comprend toutes les petites zones non entretenues à l'intérieur du 

cimetière. 

 

• Commercial/industrial (C): Terres utilisées pour des activités commerciales, y compris  

services de vente, commerciaux et d’affaires. Comprend aussi les activités industrielles 

standards comme la fabrication, la transformation et le stockage. Les aires de 

stationnement hors zones résidentielles et institutionnelles sont aussi incluses.  

 

• Forest (F): Terres gérées ou non gérées dominées par un couvert arboré. (Remarque : 

il est recommandé de classer les pépinières ou les terres destinées à la sylviculture 

dans la classe « Agriculture ») 

 

• Golf course (G): comprend l’ensemble des terrains, qu’ils soient entretenus ou pas 

 

• Institutional (I): Écoles, hôpitaux / complexes médicaux, collèges, édifices religieux, 

édifices gouvernementaux, etc. (Remarque : Si une parcelle contient de grandes zones 

non entretenues, prévues pour une expansion ou autres, considérez-la comme un 

espace vacant. Cependant, les petits îlots boisés dans un paysagé entretenu seraient 

considérés comme institutionnels.) 

 

 

 

Eco utilise ces valeurs pour apporter des ajustements au modèle en fonction 

des différences de croissance des arbres et des caractéristiques d’évaluation 

associées aux occupations du sol actuelles prédéfinies. Par exemple, un arbre 

situé dans une placette localisée dans une zone de transport grandira à un 

rythme différent de celui d'un arbre similaire situé dans un terrain de golf ou 

dans une placette résidentielle. Pour cette raison, toutes les catégories 

personnalisées d’occupation du sol doivent être mise en correspondance avec 

les classes par défaut d'Eco. 

Astuce 
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• Multi-family residential (M): Structures contenant quatre unités résidentielles ou plus. 

(Remarque: Une structure contenant un à quatre logements familiaux serait considérée 

comme un immeuble multifamilial. Un complexe résidentiel comprenant de nombreuses 

unités de logements séparées ayant accès à des espaces verts serait également 

considéré comme un immeuble résidentiel multifamilial.  

 

• Park (P): Comprend les parcs dans les zones non développées (non entretenues) ainsi 

que les zones développées. (Remarque: les zones boisées sont mieux classées dans la 

catégorie « Forest ». 

 

• Residential (R): Structures autonomes desservant une à quatre familles 

 

• Transportation (T): Comprend les routes à accès limité et les espaces verts 

correspondants (comme le réseau interurbain avec des rampes d’entrée et de sortie 

souvent clôturées), ainsi que les gares et les voies ferroviaires, chantiers navals, 

aéroports, etc. (Remarque: classez la placette dans la catégorie d’occupation du sol la 

plus proche si elle se trouve au niveau d’un autre type de route ou au niveau d’un terre-

plein central) 

 

• Utility (U): Comprend les installations de production d'électricité, les installations de 

traitement des eaux usées, les réservoirs couverts et non couverts et les zones de 

rétention des eaux de ruissellement, les canaux de contrôle des inondations et les 

canaux de conduction. 

 

• Vacant (V): Comprend un terrain sans usage défini. (Remarque : les bâtiments 

abandonnés et les structures vacantes doivent être classés en fonction de leur usage 

initial prévu). 

 

• Water/wetland (W): Ruisseaux, rivières, lacs et autres plans d'eau, naturels ou 

artificiels. (Remarque : les petites piscines et fontaines doivent être classées en fonction 

de l’occupation du sol adjacente.) 

 

• Other (O): occupations du sol qui ne se trouvent pas dans l’une des catégories 

énumérées. (Remarque : cette désignation doit être utilisée avec parcimonie car elle 

fournit peu d'informations utiles pour le modèle.) Clarifiez avec des commentaires dans 

Notes. 

 

(Remarque : pour les bâtiments à usage mixte, choisissez l’occupation du sol dominante c’est-

à-dire l’occupation la plus fréquentée. La dominance est estimée par rapport à l’usage et non à 

l’espace occupée. Par exemple, un bâtiment avec un usage commercial au premier étage et 

des appartements dans les étages supérieurs serait classé comme « commercial / industrial ») 
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Comment saisir: 

• Occupation du sol actuel 

o Papier : entrez le type d’occupation du sol sous Actual Land Use de la 

deuxième page. 

o Collecteur mobile de données : dans la fenêtre Land Uses, cliquez sur le signe 

plus (+) dans le coin supérieur droit et sélectionnez une occupation du sol dans 

le menu déroulant. Entrez un pourcentage comme décrit ci-dessous. 

• Percent of plot: pour les placettes qui ne sont couvertes que par une seule occupation 

du sol, cette valeur est de 100 %. Pour les placettes qui comprennent deux ou plusieurs 

occupations du sol, estimez le pourcentage couvert par chacune de ces occupations. 

Par exemple, une placette se trouvant à la limite de propriété entre une maison et un 

magasin est couverte à 40% de classe résidentielle et à  60% de classe commerciale / 

industrielle. Les différences d’occupation du sol doivent être clairement identifiables au 

niveau de la placette selon l’usage du sol et pas seulement selon sa couverture ou sa 

propriété. 

o Papier: entrez le pourcentage de chaque type d’occupation du sol sous Percent 

of plot. 

o Collecteur mobile de données : dans la fenêtre Land Uses, cliquez sur le signe 

plus (+) dans le coin supérieur droit et sélectionnez un type d’occupation du sol 

dans la liste déroulante. Entrez le pourcentage dans Percent of Plot. Cliquez 

Save pour continuer. Ajoutez des occupations du sol jusqu’à atteindre la valeur 

100%. Cliquez ensuite sur la flèche gauche de la fenêtre principale d’occupation 

du sol pour revenir au menu principal de la placette. 

 

 

Description: 

Différents matériaux peuvent couvrir le sol d’une placette. Eco propose par défaut 11 classes de 

couverts au sol parmi lesquelles les utilisateurs peuvent choisir. Par ailleurs, les utilisateurs 

peuvent créer des classes personnalisées dans le logiciel i-Tree Eco. Les classes définies par 

l'utilisateur doivent être attribuées à l'une des classes par défaut. 

 

 Couvert au sol (Ground cover) 

 

Les arbres et les arbustes ne sont pas pris en considération dans cette section. 

Ils sont traités séparément. Veuillez consulter les sections Tree Cover et Shrub 

Cover pour plus d’informations. Les tiges (pour les arbres couchés), considérées 

comme couvert au sol, sont ignorées pour cette variable.  

Astuce 
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Les pelouses, les prairies et la strate herbacée jouent un rôle dans la modélisation de la 

pollution pour les projets américains. Les résultats de la pollution seront influencés par les 

nouveaux champs affectés à ces classes. 

Les données suivantes sont nécessaires pour décrire vos couverts au sol :  

• Ground cover – type (s) de couvert au sol observé sur le terrain 

 

• Percent of plot – le pourcentage de la surface de la placette couverte par chaque 

couvert au sol 

 

Les classes de couvert au sol suivants, proposées par défaut, sont incluses: 

▪ Bare soil (Soil): comprend du sable naturel. 

 

▪ Building (Bldg.): Comprend les bâtiments aux toits végétalisés. 

 

▪ Cement  

 

▪ Tar: Enrobé/asphalte 

 

▪ Rock: Surfaces rocheuses perméables telles que le gravier, les briques, les lauzes 

des passerelles ou les lauzes des patios (sans mortier). Cette classe comprend 

aussi le sable dans les terrains de jeux ou le sable ajouté comme revêtement au sol 

existant. (Remarque: les grands affleurements rocheux solides devraient être 

classés comme « other impervious » 

 

▪ Duff/mulch: Matière organique, litière de feuilles. 

 

 

Le pourcentage couvert par les bâtiments est utilisé dans la modélisation 

énergétique et la modélisation de la faune. Les utilisateurs intéressés par ces 

analyses doivent soit conserver la classe de bâtiment par défaut, soit inclure 

une classe personnalisée attribuée à la classe par défaut. 

Astuce 
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▪ Grass (Main. Grass) 

 

▪ Unmaintained grass (Unmain. Grass)  

 

 

▪ (Herb/Ivy): Couvert herbacé autre que les pelouses. Il comprend aussi les cultures 

agricoles 

 

▪ Other impervious: Surfaces imperméables, autres que les bâtiments, le ciment et 

l’asphalte, y compris les gros affleurements rocheux solides, les piscines, les 

plaques d’égout, les cabines à haute tension, les pierres tombales, le gazon artificiel, 

etc. (Remarque: le gazon artificiel doit être classé comme Rock si le matériau sous-

jacent est perméable.) 

 

▪ Water: Plans d'eau naturels et rivières sauf les eaux stagnantes temporaires.  

 

Comment saisir: 

Estimez le pourcentage de chaque type de couvert au sol à 5% près, sauf s’il est minimal. Si 

des traces sont présentes, vous pouvez simplement entrer 1, 2, 3%, etc. La somme des 

pourcentages des différents couverts doit être égale à 100 % par placette. Utilisez le tableau 

suivant pour échelonner les couverts au sol de 1 à 5%. (Quelques exemples de comparaison : 

un matelas Queen size couve 3.25 m2 ; SUV full-size couvre 8.36 m2). 

 

 

 

Le pourcentage de la pelouse est utilisé dans la modélisation de la faune. Les 

utilisateurs intéressés par cette analyse doivent soit conserver la classe par 

défaut Grass, soit inclure une classe personnalisée attribuée à cette dernière. 

Astuce 

 

 

Les pelouses, les prairies et la strate herbacée jouent un rôle dans la 

modélisation de la pollution pour les projets américains. Les résultats de la 

pollution seront affectés par la façon dont ces couverts sont classés sur le 

terrain ou si de nouveaux champs leurs sont attribués.  
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Pourcentage dans une 
placette de 0.04 ha 

Surface (m2) Diamètre du cercle (m) 

1%              4.09                     2.29 

5%            20.25                     5.03 

10%            40.60                     7.19 

25%          101.34                   11.37 

50%          202.81                   16.06 

75%          304.16                   19.69 

100%          405.52                   22.71 

 

• Papier: entrez le pourcentage de chaque couvert au sol dans la catégorie appropriée 

(indiquée entre parenthèses ci-dessus) sur la deuxième page 

• Collecteur mobile de données: dans la fenêtre Ground Covers, cliquez sur le signe 

plus (+) dans le coin supérieur droit et sélectionnez un type de couvert dans le menu 

déroulant. Entrez un pourcentage dans le champ Percent Covered et cliquez sur Save 

pour continuer. Ajoutez des couverts jusqu’à l’atteinte de la valeur maximale 100%. 

Cliquez ensuite sur la flèche gauche de la fenêtre Ground Covers pour revenir à la 

fenêtre principale de la placette.  

 

 

Description: 

À des fins d'inventaire, les arbustes doivent être regroupés selon l’espèce et la hauteur 

approximative. Par exemple, si votre placette comprend cinq azalées de hauteurs similaires 

dans différentes zones, vous pouvez les regrouper et les saisir en tant que groupe unique. Une 

plante ligneuse avec un DHP < 2,54 cm est considérée comme un arbuste. Les données 

suivantes sont nécessaires pour chaque groupe d'arbustes : 

• Species – nom des espèces d’arbustes 

• Height – hauteur moyenne d'un groupe d'arbustes (c.-à-d. groupe d'arbustes de la 

même espèce) 

 Détails sur les arbustes (Shrub Details) 

 

 

Durant la collecte de Plot Information des inventaires par échantillonnage vous 

pouvez saisir le pourcentage de la surface de la placette couverte par les arbustes. Cette 

phase ne concerne que cette surface. Si vous collectez des données relatives aux 

arbustes, vous devez également estimer le couvert arbustif. Consultez la section Shrub 

Cover  de ce guide pour plus d’informations. 

Avertisement 
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• Percent of area – pourcentage occupé de chaque groupe d’arbustes par rapport à la 

surface totale occupée par les arbustes 

• Percent missing – pourcentage du volume du groupe d'arbustes manquant (c.-à-d. non 

occupé par les feuilles) 

 

Comment saisir : 

Saisissez un maximum de 12 groupes d'arbustes. S'il y en a plus que 12, collectez les données 

pour les 11 premiers groupes, puis regroupez les arbustes restants dans le douzième groupe. 

o Papier: pour chaque groupe d'arbustes, entrez les données des quatre champs 

ci-dessous sous l’en-tête Shrubs de la deuxième page. 

o Collecteur mobile de données: cliquez sur le signe plus (+) dans la fenêtre 

Shrubs pour ajouter un nouveau groupe d'arbustes et remplir les quatre champs 

ci-dessous. 

 

• Species: identifiez les espèces d'arbustes. Si cela n'est pas possible, la plante doit être 

identifiée au minimum par son genre; si le genre n'est pas connu, prélevez un échantillon 

pour identification. 

o Papier: entrez le nom ou le code de l’espèce sous Shrubs > Species. Visitez i-

Tree website, www.itreetools.org > Resources, pour consulter le PDF et le 

fichier Excel contenant la liste des codes d’espèces. 

o Collecteur mobile de données: sélectionnez une espèce dans le menu déroulant. 

Cliquez sur le bouton Next au bas de chaque page pour voir plus d'espèces. 

Vous pouvez basculer entre le nom scientifique, le nom commun et le code 

d'espèce à l'aide du bouton en haut à droite. Vous pouvez également effectuer 

une recherche en tapant dans la zone Search. 

 

• Height: mesurez la hauteur du groupe d'arbustes à 0,10 m près. La hauteur des 

groupes d'arbustes d'une espèce peut varier dans la placette. Une hauteur moyenne 

peut être utilisée et différents massifs arbustifs peuvent être groupés ensemble lorsque 

la variation de hauteur est relativement faible. 

o Papier: enrez sous Shrubs > Height. 

o Collecteur mobile de données : entez la valeur sous Height dans la fenêtre 

Shrubs. 

 

• Percent of area: mesurez le pourcentage de la superficie totale des arbustes  (c.-à-d.,  

pas la surface totale de la placette) couverte par la combinaison espèce/hauteur 

donnée. Le pourcentage total pour tous les groupes d’arbustes doit être égal à 100% 

pour chaque placette. Lorsqu'il y a deux ou plusieurs niveaux d'espèces d'arbustes 

différentes, saisissez le pourcentage de la surface du groupe d'arbustes le plus haut et 

uniquement la surface du groupe d'arbustes le plus court qui n'est pas ombragée 

(recouverte) par le groupe d'arbustes le plus haut, c’est-à-dire, visualisez à vol d’oiseau 

la surface des groupes d'arbustes, et indiquez le pourcentage des groupes d'arbustes vu 

de dessus 

https://www.itreetools.org/index.php
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o Papier: entrez sous Shrubs > % of shrub area.  

o Collecteur mobile de données : entrez sous Percent of Shrub Area dans la 

fenêtre Shrubs.  

 

• Percent missing: considérez chaque massif arbustif groupé par la combinaison 

espèce/hauteur comme un volume (hauteur par surface au sol) et entrez le pourcentage 

de volume manquant, c.-à-d.,  non occupé par les feuilles). Les feuilles sont supposées 

se développer à partir du sol chez les arbustes. Cette variable permet d'ajuster les 

mesures de hauteur et de surface pour révéler le volume réel de feuilles et pour vous 

permettre de tenir compte des vides dans la végétation et des inexactitudes dans les 

estimations simples de la hauteur par zone (par exemple, la hauteur d’un massif ne peut 

pas être uniforme). 

 

Permettre une disposition naturelle ou un espacement des feuilles. Cependant, la partie 

intérieure du massif arbustif doit être examinée pour mieux estimer les parties 

manquantes. Dans le passé, les équipes ont sous-estimé la masse manquante en ne 

tenant pas compte de cette partie. 

Saisissez le pourcentage manquant comme 0% ou comme le point-milieu de 5 % 

d’intervalle (3, 8, 13, etc.). 

o Papier : entrez sous Shrubs > % Missing. 

o Collecteur mobile de données : entrez Percent missing dans la fenêtre Shrubs. 

Cliquez sur Save pour enregistrer le groupe d’arbustes, et cliquez sur le signe 

plus (+) pour continuer d’ajouter des groupes d’arbustes jusqu’à atteindre le total 

de 100%. Lorsque vous avez terminé, cliquez sur la flèche gauche de la fenêtre 

principale des Shrubs pour revenir au menu principal de la placette. 
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À différents stades de sa vie, un arbre peut être classé comme couvre-sol, arbuste ou arbre 

dans le modèle Eco. Les informations suivantes sont issues de l’article “A Ground-Based 

Method of Assessing Urban Forest Structure and Ecosystem Services” (disponible sur 

www.itreetools.org sous Resources > Archives) et peuvent aider les utilisateurs Eco à 

distinguer entre les options disponibles. 

En règle générale, les arbustes sont définis comme une plante ligneuse d'un diamètre à 

hauteur de poitrine (DHP) inférieur à 2,54 cm, tandis que les arbres ont un DHP supérieur ou 

égal à 2,54 cm. Les plantes ligneuses qui ne mesurent pas 30,5 cm de hauteur (par exemple, 

les plantules) sont considérées comme des herbacées. 

 

La distinction entre arbre et arbuste peut aussi se faire soit grâce à l’espèce (c.-à-d., certaines 

espèces sont uniquement des arbres ou uniquement des arbustes), soit avec différents seuils 

minimums de DHP. A titre d’exemple, dans les zones densément boisées, augmenter le DHP 

minimum à 12,7 cm permet de réduire le temps de collecte de données en diminuant le nombre 

d’arbres mais fournit moins d’informations sur les arbres. 

 

Collecte des données sur les arbres pour un inventaire par échantillonnage 

basé sur des placettes 

La collecte de données sur les arbres vivants et morts commence par l'arbre le plus proche du 

nord et se poursuit dans le sens des aiguilles d’une montre. Si deux arbres sont situés dans la 

même direction depuis le centre de la placette, les équipes de terrain doivent mesurer l'arbre le 

plus proche du centre. Si votre centre de placette est inaccessible et que vous avez désigné un 

TMP (voir Inaccessible Plot Centers pour plus d'informations), utilisez-le pour mesurer la 

Informations relatives aux arbres 

 Qu’est-ce qu’un arbre ? 

 

 

Pour un projet i-Tree Eco, les arbres sont généralement définis comme une 

plante ligneuse ayant un DHP supérieur ou égal à 2,54 cm. A des fins 

d’inventaire, il est recommandé de considérer les plants d’arbres et les 

jeunes arbres ayant un DHP inférieur à 2.54 cm comme des arbres. 

Astuce 
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distance et la direction, mais n'oubliez pas que la placette ne doit pas être déplacée pour faire 

du TMP son centre. Mesurez uniquement les arbres situés dans le périmètre initial en fonction 

du centre initial de la placette. Tous les arbres doivent être relevés tant qu’au moins la moitié de 

leurs troncs se trouve à l’intérieur de la placette. 

 

 

 

Description: 

L’ID représente le numéro d’identification de l’arbre. Il doit être un identifiant unique pour les 

inventaires complets. Pour les inventaires par échantillonnage basé sur des placettes, les 

identifiants uniques sont attribués par placette. 

Comment saisir: 

• Papier (échantillon et inventaire complet): entrez sous TREE ID. Commencez par 1 et 

attribuez séquentiellement les ID. 

• Collecteur mobile de données (échantillon et inventaire complet): cliquez sur le signe (+) 

dans le coin supérieur droit de la fenêtre Trees. Un ID est généré automatiquement et 

vous avez désormais accès aux fenêtres générées en fonction de la configuration de 

votre projet (six au maximum): General, Details, Stems, Building Interactions, 

Management Info, and Pests. Chacun sera expliqué ci-dessous. 

 

 

Description: ID unique pour les arbres pour les inventaires complets et les inventaires 

par échantillonnage basés sur des placettes. 

 

• Papier (échantillon et inventaire complet): entrez sous USER ID.  

• Collecteur mobile de données (échantillon et inventaire complet): cliquez sur (+) du coin 

supérieur droit de la fenêtre Trees. Dans la fenêtre Informations générales, entrez User 

Id. 

 ID de l’arbre (Tree ID) 

 ID de l’utilisateur (User ID) 

 

Marquer chaque arbre au fur et à mesure qu'il soit mesuré permet d’éviter 

l’oubli et le double comptage. Ne laissez pas de traces permanentes 

(traces de peinture) sur les arbres. 

Astuce 
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Description: (Remarque: cette variable facultative est collectée uniquement pour les 

inventaires par échantillonnage basés sur des placettes). 

Direction du centre de la placette vers l’arbre en degrés/azimuts (ex. nord = 360°; est = 90°; sud 

= 180°; ouest = 270°).  

Comment saisir : 

Si le centre du tracé est inaccessible, mesurez la direction à partir du point TMP. Assurez-vous 

que les informations liées au TMP sont saisies dans la section Reference Object du formulaire 

papier ou le collecteur mobile de données 

• Papier (échantillon): entrez l’azimut en degré sous DIR. 

• Collecteur mobile de données (échantillon): entrez l’azimut en degré sous Direction 

dans la fenêtre General. 

 

 

Description: (Remarque: cette variable facultative est collectée uniquement pour les 

inventaires par échantillonnage basés sur des placettes). 

Distance la plus courte (en mètres) entre le centre de la placette et le bord du tronc à hauteur 

du DHP, mesurée parallèlement au sol. Dans les placettes fortement boisées, la précision est 

essentielle pour trouver les arbres à l’avenir. 

Comment saisir : 

Si le centre du tracé est inaccessible, mesurez la direction à partir du point TMP. Assurez-vous 

que les informations liées au TMP sont saisies dans la section Reference Object du formulaire 

papier ou le collecteur mobile de terrain 

• Papier (échantillon): entrez la distance la plus courte à l'arbre sous DIST. 

• Collecteur mobile de données (échantillon): dans la fenêtre General, entrez sous 

Distance. 

 

 

 

 

 Direction vers le centre de la pcette (Direction to Plot Center) 

 Distance au centre de la placette (Distance to Plot Center) 
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Pendant la collecte de donnée Plot Information pour les projets par 

échantillonnage basés sur des placettes, vous pouvez saisir la composition en 

termes d’occupations du sol qui couvrent votre placette. Si vous avez collecté 

des données d’occupation du sol pour les arbres ici, vous devez également les 

déterminer à l’échelle de la placette. Voir les descriptions du Land Use dans la 

section Plot Information de ce guide pour plus d’informations. 

 

Avertissement 

 
! 

 

Description : 

Occupation du sol dans laquelle l'arbre se trouve. Eco propose 13 classes d’occupation du sol 

par défaut parmi lesquelles les utilisateurs peuvent choisir. Par ailleurs, ils peuvent créer des 

classes personnalisées dans le logiciel i-Tree Eco. Les classes définies par l'utilisateur doivent 

être attribuées à l'une des classes d’occupation du sol par défaut. Les classes par défaut sont 

décrites dans la section Plot Information. 

Comment saisir : 

Saisissez l’occupation du sol dans laquelle l'arbre se trouve. 

• Papier (échantillon et inventaire complet): utilisez les codes d’occupation du sol définis 

ci-dessus et entrez sous LAND USE. 

• Collecteur mobile de données (échantillon): dans la fenêtre General, sélectionnez 

l’occupation du sol dans la liste déroulante. Seules les classes que vous avez identifiées 

dans la placette seront incluses. 

• Collecteur mobile de données (inventaire complet): dans la fenêtre General, 

sélectionnez l'occupation du sol dans la liste déroulante. 

 

 

Description : (Remarque: cette variable est requise pour tous les projets.) 

Genre et espèce d'arbre. Lisez Identifying Tree Species qui suggère des directives à suivre 

dans des scénarios spécifiques.  

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous TREE SPECIES. Si vous 

souhaitez utiliser des codes d'espèces, vous trouverez un PDF et une feuille Excel de la 

 Occupation du sol (Land Use) 

 Espèce (Species) 
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liste des codes d'espèces sur le site i-Tree www.itreetools.org sous Resources. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre 

General, sélectionnez une espèce dans la liste. Cliquez sur Next en bas de la page 

pour parcourir la liste des espèces. Vous pouvez basculer entre le nom scientifique, le 

nom commun et le code d'espèce à l'aide du bouton en haut à droite. Vous pouvez 

également effectuer une recherche en tapant dans Search box. 

 

Identification des espèces 

Lisez les directives suggérées pour les scénarios suivants qui peuvent être rencontrés 

sur le terrain : 

• Les espèces ne peuvent pas être identifiées : si les espèces ne peuvent pas 

être identifiées, prélevez un échantillon, numérotez-le et enregistrez-le dans 

votre cahier sous le numéro Placette # XXX inconnu # 1, etc. Chaque fois qu'une 

même espèce inconnue est rencontrée sur la placette, elle doit être enregistrée 

avec le même numéro. Numérotez-les séquentiellement dans le cahier et tentez 

de les identifier plus tard. Une fois que les échantillons soient identifiés au 

bureau, saisissez le code d'espèce correct sur le formulaire papier ou sur le 

collecteur mobile de données. Si, l’identification reste difficile même après 

l’utilisation de tous les guides (ex. en raison de l’hybridation), saisissez le genre 

si possible. 

 

• L’arbre est mort : Seuls les arbres morts debout ou penchés doivent être 

inventoriés. Le genre ou l'espèce doivent être identifiés dans la mesure du 

possible. 

 

Lorsque l'identification des espèces est extrêmement difficile, comme c’est le cas pour 

les arbres morts, l'une des classes taxonomiques suivantes peut être utilisée : 

Magnoliopsida, Pinopsida, Ginkgoopsida, Liliopsida, Filicopsida, or Cycadopsida. Ces 

classes doivent être utilisées avec parcimonie lors de l'identification des espèces 

d'arbres vivants. Ces classes peuvent être utilisées pour représenter des classifications 

plus génériques comme le suggèrent leurs noms communs.  Cependant, ces classes ne 

sont pas nécessairement exhaustives de la classification générique décrite par leur nom 

commun. 

Nom scientifique Code d’espèces Nom commun 

Cycadopsida CYCLASS Classe des palmiers 
Filicopsida FICLASS Classe des fougères  
Ginkgoopsida GICLASS Classe des Ginkgo 
Liliopsida LICLASS Monocotylédone  
Magnoliopsida MACLASS Dicotylédone 
Pinopsida PICLASS Conifère 

 

 

https://www.itreetools.org/index.php
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Description :  

Saisissez si l'arbre est un arbre de rue ou non. 

Comment saisir : 

• Papier (échantillon et inventaire complet): entez oui (Y) ou non (N) sous STREET 

TREE/NON-ST S/N. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre 

General, utilisez le bouton pour indiquer oui ou non sous Street Tree. 

 

 

Description :  

Saisissez si l’arbre est géré par la ville (public) ou par le privé (private). 

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous PUBLIC or PRIV. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre 

General, utilisez le bouton pour indiquer oui ou non sous Public Tree. 

 

 

 Arbre de rue/Non-arbre de rue (Street Tree/Non-Street Tree) 

 Public/privé (Public/Private) 

 

Les classes taxonomiques (c.-à-d., Magnoliopsida, Pinopsida, 

Ginkgoopsida, Liliopsida, Filicopsida, Cycadopsida) doivent être utilisées 

avec parcimonie lors de l'identification des espèces d'arbres vivants. Elles 

peuvent être utilisées pour représenter des classifications plus génériques. 

Cependant, les données sur les espèces sont importantes pour le calcul des 

services écosystémiques - une identification précise d’espèces fournit de 

meilleures estimations du modèle. 

Avertissement 

 
! 
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Descriptions : 

Statut de l'arbre planté ou  auto-ensemencé. Les huit statuts possibles d'un arbre sont indiqués 

ci-dessous. Dans un premier inventaire d’un site donné, tous les arbres seront identifiés comme 

Planted (P), Ingrowth (I), or Unknown (U). Dans les inventaires futurs du même site, seuls les 

nouveaux arbres seront identifiés comme P, I ou U. Les arbres qui étaient déjà présents lors du 

premier inventaire doivent être identifiés avec les cinq autres codes du statut. 

Lors des inventaires initiaux ou lors de l'inventaire de nouveaux arbres dans les inventaires 

ultérieurs, veuillez faire un effort concerté pour déterminer si les arbres ont été plantés [Planted 

(P)] ou auto-ensemencé [Ingrowth (I)] car ces informations seront plus précieuses pour 

améliorer les estimations et le modèle Eco. Vous pouvez aussi choisir Inconnu (U) si vous ne 

pouvez pas déterminer si un arbre a été planté ou s’il est auto-ensemencé. Néanmoins cette 

option est à éviter dans la mesure du possible. 

▪ Planted (P): l’arbre est planté intentionnellement  

 

▪ Ingrowth (I): l’arbre est auto-ensemencé 

 

▪ Unknown (U): statut inconnu 

 

Lors des inventaires ultérieurs des placettes, utilisez les codes suivants pour définir l'état actuel 

des arbres qui existaient déjà dans l'inventaire précédent. 

▪ No change in status (N): cet arbre était présent dans un inventaire précédent et est 

actuellement présent 

 

▪ Removed for hazard/health problem (H): l'arbre a été abattu depuis l'inventaire 

précédent pour des raisons sanitaires ou de sécurité 

 

▪ Removed but healthy (C): un arbre sain a été abattu par le propriétaire 

 

▪ Removed owing to land use change (L): l'arbre a été abattu en raison d'un 

changement d'affectation du sol (ex. réaménagement du site) 

 

▪ Removed, unknown (R): arbre abattu pour une raison inconnue 

 

(Remarque: le modèle n’inclura pas ces calculs pour les arbres ayant le statut « abattu » : H, C, 

L ou R.) 

 

 

 Statut (Status) 
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Comment saisir : 

• Papier (échantillon et inventaire complet): entrez le code du statut sous STAT.  

• Collecteur mobile de données (échantillon et inventaire complet) : dans la fenêtre 

General, sélectionnez le Status dans le menu déroulant. 

 

 

Description : 

Indiquez si l'arbre est mort.  

Comment saisir : 

• Papier (échantillon et inventaire) : saisissez manuellement les options « par défaut » 

pour les arbres morts en saisissant les données suivantes :   

o Total tree height: (prendre la mesure actuelle), entrez sous TOT TREE HEIGHT. 

o Height to live top: entrez -1 sous LIVE CROWN HEIGHT. 

o Height to crown base: entrez -1 sous CROWN BASE HEIGHT. 

o Crown width: entrez -1 sous CROWN WIDTH > N-S et E-W. 

o Percent crown missing: entrez 100% sous CROWN % MISS. 

o Condition & percent dieback: entrez 100% sous CROWN COND. 

o Crown light exposure: entrez -1 sous CLE. 

o DHP: (prendre la mesure actuelle) entrez sous DHP. 

• Collecteur mobile de données (échantillon et inventaire): dans la fenêtre Details, cochez 

la case à côté de Dead. Cochez cette case remplira automatiquement toutes les options 

par défaut pour les arbres morts. 

 

 

 

 Mort (Dead) 

 

Seuls les arbres morts debouts ou penchés doivent être inventoriés. Le 

genre ou l'espèce doivent être identifiés dans la mesure du possible. 

Lorsque cela n'est pas possible, saisissez l'une des classes taxonomiques 

suivantes : Magnoliopsida, Pinopsida, Ginkgoopsida, Liliopsida, Filicopsida 

ou Cycadopsida. 

Lorsque vous utilisez le collecteur mobile de données, les valeurs par 

défaut des arbres morts sont automatiquement saisies. Pour les entrées 

sans valeurs par défaut (tels que la hauteur de l'arbre et le DHP), les 

mesures actuelles doivent être toujours prises. 

Astuce 
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Description : 

Hauteur depuis la base de l’arbre jusqu’à sa cime (vivante ou morte). 

Comment saisir : 

Mesurez la hauteur au sommet de l'arbre (à 0,10 mètre près). Pour les arbres morts sur pied, 

arbre vivant à terre ou les arbres fortement inclinés, la hauteur est considérée comme la 

distance le long du tronc principal du sol au sommet de l'arbre (la cime) (N'incluez pas les 

arbres morts au sol). 

• Papier (échantillon et inventaire): entrez la hauteur de l’arbre sous TOT TREE HEIGHT. 

• Collecteur mobile de données (échantillon et inventaire): dans la fenêtre Details, entrez 

sous Height. 

 

 

Hauteur jusqu’au sommet vivant (Height to Live Top) 

 

Description : 

Hauteur depuis la base de l’arbre jusqu'à sa cime vivante. Cette hauteur sera la même que la 

hauteur totale de l'arbre à moins que l'arbre ne soit pas vivant mais le sommet de la couronne 

soit mort.  

 

Comment saisir : 

Mesurez la hauteur jusqu’à la cime vivante, saisissez au mètre prés. 

• Papier (échantillon et inventaire): entrez sous LIVE CROWN HEIGHT. 

• Collecteur mobile de données (échantillon et inventaire): dans la fenêtre Details entrez 

sous Crown Top Height. 

 

 Hauteur totale de l’arbre (Total Tree Height) 

 Taille de la couronne (Crown Size) 

 

 

La hauteur jusqu’à la cime vivante ne peut pas être supérieure à la hauteur 

totale de l’arbre. 

Caution 

 
! 
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Hauteur jusqu’à la base de la couronne (Height to Crown Base) 

 

Description : 

Hauteur depuis la base de l’arbre jusqu’à la base de la cime vivante. La base de la cime vivante 

est le point du tronc principal qui est perpendiculaire au feuillage vivant de la dernière branche 

la plus basse et inclus dans la cime vivante. Notez que la base de la cime vivante est 

déterminée par le feuillage vivant et non par le point d’intersection entre une branche et le tronc 

principal. Par conséquent, si la base de la couronne touche le sol, la valeur peut être égale à 

zéro. Voir la Fig.2 pour vérifier la visualisation de la couronne de l'arbre. 

Comment saisir : Mesurez la hauteur jusqu’à la base de la couronne vivante (au 0,10 m près). 

Si vous saisissez sur du papier, entrez -1 pour les arbres morts. Si vous utilisez un collecteur 

mobile de données, la valeur par défaut de -1 se remplira automatiquement si la case «Dead» a 

été cochée. 

• Papier (échantillon et inventaire complet): entrez sous CROWN BASE HEIGHT. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre 

Details, entrez sous Crown Base Height. 
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Fig. 2 – Comment se positionner pour mesurer la couronne. 

 

 

Largeur de la couronne (Crown Width) 

 

Description :  

Largeur de la couronne dans deux directions : nord-sud (N-S) et est-ouest (E-W). 

Comment saisir : 

Mesurez la largeur de la couronne (à 0,10 mètre près) dans deux directions, aussi près de N-S 

et E-W que le permettent des considérations de sécurité ou des obstructions physiques. Si 

l'arbre est couché au sol ou penché, prenez des mesures de largeur perpendiculaires au tronc 

d'arbre. Si vous saisissez sur le formulaire papier, notez -1 pour les arbres morts. Si vous 

utilisez un collecteur mobile de données, la valeur -1 par défaut se remplira automatiquement si 

la case «Dead» est cochée. 
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• Papier (échantillon et inventaire complet): entrez sous CROWN WIDTH > N-S et E-W. 

• Collecteur mobile de données (échantillon et inventaire complet) : dans la fenêtre 

Details, entrez sous Crown NS Width et Crown EW Width 

 

Pourcentage du volume de la couronne manquante (Percent Crown 

Missing) 

 

Description : 

Pourcentage du volume de la couronne non occupée par les branches et les feuilles. 

Comment saisir : 

La canopée manquante doit être mesurée par deux personnes se tenant à des angles 

perpendiculaires de l'arbre (Fig. 2). Visualisez la « couronne typique » attendue de l'espèce 

d’arbre spécifique comme un contour créé par les mesures de la hauteur totale de l'arbre, de la 

largeur de la couronne vivante et de la hauteur jusqu’à la base de la couronne vivante déjà 

prises sur le terrain. Imaginez ce contour, spécifique à l'espèce, rempli de branches et de 

feuilles comme s'il s'agissait d'un arbre sain en excellent état. Estimez maintenant le 

pourcentage de feuillage absent dû à la taille, au dépérissement, à la défoliation, à l’irrégularité 

de la couronne, ou à des feuilles petites ou clairsemées. Ne pas inclure les vides intérieurs 

normaux de la couronne dû à l'ombrage des feuilles. Assurez-vous d'estimer le pourcentage du 

volume de la couronne manquante en fonction d’une couronne existante déjà mesurée (c.-à-d. 

Hauteur totale, largeur de la couronne et base de la couronne). (Fig.3) 

• Si les deux observateurs sont en désaccord dans leurs estimations, suivez les directives 

ci-dessous sous Crown Rating Precautions. Saisissez le pourcentage du volume de la 

couronne manquante à 0%, 100%, ou point-milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

Si vous utilisez un formulaire papier, saisissez 100% pour les arbres morts. Si vous 

utilisez un collecteur mobile de données, la valeur par défaut de 100% se remplira 

automatiquement si la case «Dead» a été cochée. Papier (échantillon et inventaire 

complet): entrez sous CROWN% MISS. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre 

Details, sélectionnez une valeur dans le menu déroulant pour Crown Percent Missing. 

 

 



 

 
 

73 

Fig. 3 – Illustration de la mesure de la hauteur jusqu’à la base de la couronne et du pourcentage du volume de la 

couronne manquante 

Précautions d’évaluation de la couronne 

Pour garantir la précision, les équipes de terrain doivent être particulièrement prudentes lors de 
l'évaluation dans certaines conditions et doivent suivre les procédures ci-dessous. 

Distance de l’arbre : essayez de rester à une distance de l’arbre évalué dans l’intervalle 
compris entre la moitié et la totalité de son hauteur. Certaines observations changent en 
fonction de la proximité de l'arbre. Dans certaines situations, il est impossible de réussir cette 
étape, mais faites de votre mieux dans chaque cas. Toutes les évaluations sont faites au niveau 
du sol (même élévation que la base de l'arbre) ou à partir de la pente ascendante par rapport à 
l’arbre. Cela peut ne pas être possible dans tous les cas, mais ne prenez jamais l'habitude 
d'évaluer les arbres du côté de la pente descendante. 

Visualisation de la couronne : deux membres de l’équipe doivent se positionner en formant 
un angle l’un par rapport à l’autre en veillant à avoir une bonne visualisation de la couronne. Sur 
un terrain plat, l’angle idéal est de 90 degrés (Fig. 3). Les deux membres ne doivent pas évaluer 
l'arbre à partir de la même position ou directement en face (à 180 degrés l'un de l'autre) sauf s'il 
n'existe aucune autre option. Dans les zones fortement couvertes par la canopée, il devient 
difficile d'avoir une bonne perspective. Le chevauchement des branches, des arbres d'arrière-
plan et le manque d'une bonne zone de visualisation peuvent causer des problèmes lors de 
l'évaluation de certains arbres. Les membres de l’équipe doivent se déplacer latéralement pour 
rechercher une bonne vue. Faites particulièrement attention lorsque vous évaluez ces arbres. 
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Précautions d’évaluation de la couronne—suite 

Conditions climatiques : un ciel nuageux ou couvert, du brouillard, de la pluie et de mauvais 
angles solaires peuvent affecter les estimations. Les diamètres des couronnes peuvent être 
affectés mais dans une moindre mesure que les autres indicateurs relatifs à la couronne. Le 
dépérissement de la couronne peut être sous-estimé car il est difficile de voir des rameaux 
morts ou de différencier les rameaux défoliés des rameaux morts. Soyez particulièrement 
prudent quand les conditions d'éclairage sont mauvaises. Déplacez-vous autour d'un arbre pour 
obtenir une autre vue, même si la vue semble adéquate à un endroit spécifique. 

Forte défoliation : Lors d'une défoliation lourde, le dépérissement de la couronne peut être 
surestimé. L'utilisation de jumelles peut aider à séparer les rameaux morts des rameaux 
défoliés. 

Couronnes d’arbres couvertes par des plantes grimpantes : les plantes grimpantes dans la 
couronne de l’arbre ne doivent pas être considérées comme une surface foliaire supplémentaire 
lors de l'estimation du pourcentage du volume de la couronne manquante et du pourcentage de 
dépérissement. Ne les considérez pas comme faisant partie de la couronne  

Arbres ayant des branches épicormiques et des brindilles : les arbres densément couverts 
de rejets épicormiques ne sont pas considérés comme des cas particuliers pendant la collecte 
de données sur le terrain. Il existe deux méthodes pour gérer cette situation. Le premier choix 
est de ne pas considérer les rejets épicormiques comme faisant partie de la base de la 
couronne vivante (s'ils sont situés sous ses branches). Le feuillage produit par les branches 
épicormiques de l'arbre serait pris en compte pour estimer le pourcentage du volume de la 
couronne manquante, ce qui le diminuerait proportionnellement. 

Exemple : Un arbre ayant des rejets épicormiques s'étendant jusqu'à 1,22 mètre depuis la base 
de l’arbre, mais sa base de couronne vivante est mesurée à 2,44 mètres d’hauteur. Les 
membres de l’équipe estiment le pourcentage du volume de la couronne manquante à 15%, 
mais estiment également les 1,22 mètres supplémentaires de germes épicormiques comme 5% 
de la canopée. Le pourcentage de la canopée manquante serait alors saisi à 10%. Tous les 
pourcentages seraient basés sur les mesures de la couronne (largeurs de la couronne, hauteur 
totale et hauteur de la base de la couronne). 

La deuxième méthode consisterait à prendre en compte les rejets épicormiques les plus bas 
pour mesurer la hauteur jusqu’à la base de la couronne, puis ce point serait utilisé pour estimer 
le pourcentage du volume de la couronne manquante de l'arbre. Plus souvent, cette méthode 
augmentera le pourcentage du volume de la couronne manquante. 
 
Les deux méthodes fonctionneront avec Eco, mais essayez d’utiliser la même méthode d’une 
manière systématique sur le terrain. Utilisez l’une ou l’autre de ces deux méthodes pour la 
plupart ou la totalité des cas qui présentent les rejets épicormiques. 
Considérez ces rejets comme faisant partie de la canopée s’ils la constituent entièrement ou 
s'ils sont situés au-dessus de la base de la canopée. Mesurez-les comme s'ils faisaient partie 
de la couronne. 
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Précautions d’évaluation de la couronne—suite 

Résolution des différences de mesure : si les estimations de deux membres de l’équipe ne 

correspondent pas, obtenez la valeur finale en : 

• prenant une moyenne, si les chiffres diffèrent de 15% (2 classes) ou moins. 

• changeant de position, si les chiffres diffèrent de 15% ou plus et essayez de réduire 

l’écart à 10% ou moins  

• faisant la moyenne des deux estimations pour les arbres qui ont deux différentes 

évaluations des deux zones d'observation (les estimations 30 et 70 seraient notées comme 50) 

 

 

 

Description : 

L’état sanitaire de la couronne est basé sur une évaluation visuelle de la quantité de branches 

mortes (c.-à-d., le dépérissement) dans la couronne d'un arbre et peut être estimé comme 

dépérissement ou condition sanitaire. Etant donné que le modèle standard d’évaluation de la 

condition comprend de nombreux paramètres qui ne sont pas pris en compte par i-Tree, 

l’édition Suisse n'évaluera que le dépérissement. 

• Pour saisir le dépérissement (dieback), les utilisateurs entreront le pourcentage de la 

couronne composée de branches mortes. 

Eco propose aux utilisateurs 22 classes par défaut. Pour obtenir de l'aide supplémentaire, 

consultez la section Estimating Percent Dieback. 

 

Par ailleurs, les utilisateurs peuvent créer des classes personnalisées de l’état sanitaire de la 

couronne dans le logiciel i-Tree Eco. Ces classes définies par l'utilisateur doivent être associées 

à un pourcentage de condition ou de dépérissement pour le modèle processing et doivent être 

créées avant de sortir sur le terrain. 

 

 Etat sanitaire de la couronne (Crown Health) 

 

 

Pour les utilisateurs qui créent un nouveau projet, il est fortement 

recommandé de travailler avec les classes de la santé de la couronne 

proposées par défaut par Eco. Travailler avec les classes par défaut permet 

une collecte de données plus précise sur le terrain et une standardisation 

lors de l’analyse des résultats 

Astuce 
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Comment saisir : 

Si vous travaillez avec les classes par défaut d'Eco, saisissez-les à 0%, 100% ou le point milieu 

de 5 % d’intervalle (3, 8, 13, 18, etc.). Si vous utilisez le formulaire papier, saisissez 0% de 

condition ou 100% de dépérissement quand il s’agit d’arbres morts. Si vous utilisez le collecteur 

mobile de données, la valeur par défaut de 0% de condition ou 100% de dépérissement se 

remplira automatiquement si la case «Dead» est cochée. 

Si vous travaillez avec des classes définies par l'utilisateur, saisissez l’état sanitaire de la 

couronne en fonction des classes définies dans le logiciel i-Tree Eco.  

• Papier (échantillon et inventaire complet): entrez sous CROWN HEALTH. 

• Collecteur mobile de données (échantillon et inventaire complet): Dans la fenêtre 

Details, sélectionnez une valeur dans le menu déroulant pour Dieback. 

 

Estimation du pourcentage de dépérissement  

 

Le pourcentage de dépérissement n'inclut pas le dépérissement normal et naturel des 

branches, c'est-à-dire élagage naturel en raison de la compétition de la couronne ou de 

l'ombrage dans sa partie inférieure. Cependant, le dépérissement des branches sur les 

côtés et la cime lié à l'ombrage d'un bâtiment ou d'un autre arbre serait inclus. Consultez 

Forest Inventory and Analysis National Core Field Guide pour plus d’informations. 

 

Supposons que le périmètre de la couronne est un contour bidimensionnel d’une extrémité 

de branche à une autre en excluant les branches mortes et les larges trous au niveau de 

la couronne (Fig.4). Le dépérissement de la couronne est obtenu par deux personnes 

(Fig.2) à l'aide des jumelles. Vous devez être conscients des conditions d'éclairage et de la 

façon dont la lumière affecte les observations de la journée. Prenez plus de temps quand 

les conditions d'éclairage sont limitées. 

 

Chaque personne doit virtuellement dessiner un contour de couronne bidimensionnel, 

identifiez le dépérissement et estimez sa surface. Si les deux observateurs sont en 

désaccord dans leurs estimations, suivez les directives énumérées dans Crown Rating 

Precautions 

  

http://www.fia.fs.fed.us/library/field-guides-methods-proc/index.php
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Figure 4—Exemples d’évaluation du dépérissement 

 

 

 

Description : 

Nombre de face de la couronne de l'arbre recevant de la lumière par le dessus ou sur les côtés 

(maximum cinq). 

Comment saisir : 

La cime est comptée comme une face. Les quatre autres faces sont déterminées en divisant la 

couronne verticalement en quatre quadrants autour du tronc. Comptez le nombre de faces (0-5) 

qui recevraient la lumière (c'est-à-dire que la lumière n'est pas obstruée par des objets à 

 Exposition de la couronne à la lumière (Crown Light Exposure) 
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proximité) (Fig.5). Pour chacune des cinq faces, si une partie d'une couronne d'un arbre 

adjacent ou d'un bâtiment adjacent :  

a) dépasse une partie de ce côté de la couronne 

b)   se trouve à une distance équivalente à la largeur moyenne de la couronne par 

rapport au tronc de l’arbre mesuré et est au moins aussi haut que l'arbre mesuré, alors 

ce côté de l'arbre n'est pas compté comme recevant une lumière directe. 

Utilisez les codes suivants: 

• Arbre mort: pas de saisie 

• 0: l'arbre ne reçoit pas de lumière directe car il est ombragé par des arbres, des plantes 

grimpantes ou d'autres végétaux / objets..  

• 1: 1 des 5 faces de l’arbre reçoit directement la lumière.  

• 2: 2 des 5 faces de l’arbre reçoivent directement la lumière 

• 3: 3 des 5 faces de l’arbre reçoivent directement la lumière 

• 4: 4 des 5 faces de l’arbre reçoivent directement la lumière. 

• 5: les 5 faces de l’arbre reçoivent directement la lumière (arbre dans un milieu ouvert) 

 

Papier (échantillon et inventaire complet) : entrez sous CLE. 

Mobile Data Collector (échantillon et inventaire complet): dans la fenêtre Details, entrez sous 

Crown Light Exposure. 
 

 
Figure 5. Schéma illustrant les cinq faces (4 face et la cime). 
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Description : (Remarque : cette variable est requise pour tous les projets.) 

Diamètre du tronc de l'arbre à hauteur de poitrine (DHP), estimé à 1,37 mètre au-dessus de la 

base de l’arbre. 

 

 

Comment saisir : 

Mesurez le DHP sur le côté en amont de l’arbre, à 0,01 cm près. Pour les cas spéciaux, suivez 

les directives dans DBH Special Cases. 

• Papier (échantillon et inventaire complet): dans des conditions normales, entrez sous  

DBH1. Utilisez DBH2 – DBH6 pour entrer plusieurs troncs comme indiqué dans DBH 

Special Cases. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de saisie 

des DHP sont accessibles sous la fenêtre Stems. Cliquez sur le signe plus (+) dans le 

coin supérieur droit pour commencer par entrer les DHP. L'ID du tronc sera généré 

automatiquement. Saisissez une valeur sous Diameter. 

 

Cas Spéciaux de DHP 

Arbre à plusieurs troncs : Si le point d’intersection des axes centraux des troncs est en 

dessus de la base de l’arbre (Fig. 6), l’arbre est compté comme un arbre unique. Mesurez 

séparément les DHP de chaque tronc jusqu’à un maximum de 6 troncs. Si l’arbre en a plus de 6 

ayant un DHP ≥ 2.54 cm, la mesure sera effectuée à 30,4 cm au-dessus de la base de l’arbre 

sur 6 troncs maximum (en sélectionnant les plus larges). Si le point d’intersection est en 

dessous du de la base de l’arbre, chaque tronc sera considéré comme un arbre séparé 

(l'inclusion de l’écorce (l’entre-écorce) jusqu’à la base de l’arbre est un bon indicateur montrant 

que le point d’intersection des axes centraux des troncs est en dessous de la base de l’arbre)  

 

 DHP (DBH) 

 

 

Certains bénéfices rendus par les arbres comme le stockage de carbone 

sont estimés à l’aide du DHP. Pour les arbres ayant un DHP inférieur ou 

égal à 2.54 cm, la mesure de DHP collectée sur le terrain sera utilisée pour 

estimer ces bénéfices. Pour les arbres ayant un DHP supérieur à 2.54 cm, 

l’évaluation des bénéfices sera basée sur un DHP maximum de 2.54 cm. 

Astuce 
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Figure 6—Mesure de DHP sur des arbres à plusieurs troncs 

 

Cas spéciaux de DHP—suite 

Rejets racinaires ou racines aériennes : chaque rejet racinaire ayant un DHP ≥ 2.54 cm doit 

être mesuré comme un arbre séparé. Les rejets ayant un DHP < 2.54 cm peuvent être ignorés. 

Arbres avec des contreforts ou des renflements : mesurez ces arbres à 45,7 cm à la fin du 

contrefort ou du renflement si ces derniers sont à 91,4 cm au-dessus de la base de l’arbre. 

(Fig.7).  

 
Figure 7—Mesures du DHP pour les arbres avec des irrégularités 

 

Arbres avec des irrégularités au niveau du DHP : pour un arbre avec renflement, une bosse, 

un creux ou une branche à hauteur de poitrine, le diamètre sera mesuré juste au-dessus de 

l’irrégularité où le tronc reprend sa forme normale. (Fig. 7). 

Arbre en terrain en pente : mesurez le diamètre à 1,37 m depuis la base de l’arbre, le long du 

tronc, à l’amont de l'arbre. (Fig.7). 
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Cas spéciaux de DHP—suite 

Arbre incliné : mesurez le diamètre à 1,37 m depuis la base de l’arbre, le long du tronc. La 

distance de 1.37 m est mesurée sur la face de dessous du tronc d’arbre. (Fig. 7). 

Arbre couché vivant : mesurez à 1,37 m à partir du haut de l'évasement du tronc / du collet 

racinaire (Fig. 7). 

 

Hauteur de la mesure du DHP (DBH Measurement Height) 

 

Description : 

Hauteur à laquelle la mesure de DHP a été prise si elle n'est pas mesurée à 1,37 mètre au-

dessus depuis la base de l’arbre. 

Comment saisi: 

Si le DHP n'a pas été mesuré à 1,37 m, saisissez la hauteur où le DHP a été pris. 

• Papier (échantillon et inventaire complet): entrez sous HT DBH. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre Stems, 

la valeur 1.37 m est automatiquement générée. Corrigez si nécessaire. 

 

DPH mesuré (DBH Measured) 

 

Description : 

Le DHP doit mesurée dans la mesure du possible. Mais, il peut être visuellement estimée si 

nécessaire. 

Comment saisir : 

Notez si le DHP a été mesuré ou non. 

• Papier (échantillon et inventaire complet): N/A 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre Stems, 

cochez la case à côté de Measured si des mesures directes ont été effectuées. Une 

fois que toutes les informations ont été saisies pour un tronc donné, cliquez sur Save 

pour continuer. Une fois que tous les troncs sont entrés, cliquez sur la flèche gauche 

de la page principale Stems pour revenir au menu principal de cet arbre. 
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Pourcentage imperméable (Percent Impervious) 

 

Description : (Remarque: cette variable facultative est collectée uniquement pour les projets 

d’échantillonnage basés sur des placettes aux États-Unis). 

Pourcentage de la surface imperméable au niveau de la projection de la couronne au sol  

 

Comment saisir : 

Si la couronne de l'arbre dépasse la limite de la placette, toute la zone sous l'arbre est 

considérée. Saisissez 0%, 100% ou le point milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

• Papier (échantillon) : entrez sous UNDER CANOPY > % IMPER. 

• Collecteur mobile de données (échantillon) : dans la fenêtre Details, sélectionnez une 

valeur dans le menu déroulant Percent Impervious. 

 

Pourcentage d’arbuste (Percent Shrub) 

 

Description : (Remarque: cette variable facultative est collectée uniquement pour les projets 

d’échantillonnage basés sur des placettes). 

Pourcentage de la surface occupée par des arbustes au niveau de la projection au sol de la 

couronne   

Comment saisir : 

Si la couronne de l'arbre dépasse de la limite de la placette, toute la zone sous l'arbre est 

considérée. Saisissez 0%, 100% ou or ou le point milieu de 5 % d’intervalle (3, 8, 13, 18, etc.). 

• Papier (échantillon): entrez sous UNDER CANOPY > % SHRUB. 

• Collecteur mobile de données (échantillon): dans la fenêtre Details sélectionnez une 

valeur dans le menu déroulant Percent Shrub. 

 

 

 

Si vous avez décidé de collecter des informations relatives aux effets énergétiques, les deux 

champs direction et distance sont requis. Les interactions énergétiques arbre / bâtiment 

peuvent être collectées pour les arbres (≥ 6,1 m de haut) qui sont situés à moins de 18,3 m des 

bâtiments résidentiels hauts de trois étages ou moins (par exemple, deux étages et un grenier), 

chauffés et/ou climatisés. Pour les logements multifamiliaux, traitez toutes les unités du 

bâtiment comme un seul bâtiment. Pour les projets basés sur des placettes, le bâtiment lui-

 Couvert au sol sous la canopée (Cover Under Canopy) 

 Energie (Energy) 
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même n'a pas besoin d'être localisé au niveau de la placette. Jusqu'à trois bâtiments peuvent 

être enregistrés à l'aide des formulaires papier ou d'un appareil mobile. Les arbres morts sur 

pied qui remplissent les conditions ci-dessus doivent être inclus. 

 

Direction vers le bâtiment (Direction to Building) 

 

Description : 

Direction de l'arbre vers la partie la plus proche du bâtiment, pour les arbres qui remplissent les 

conditions ci-dessus. 

Comment saisir : 

Saisissez la direction (azimut en degrés) de l'arbre vers la partie la plus proche du bâtiment. 

• Papier (échantillon et inventaire complet): entrez la direction de chacun des trois 

bâtiments les plus proches sous TREES NEAR BUILDINGS > BLDG DIST 1/BLDG 

DIST 2/BLDG DIST 3. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs relatifs au 

bâtiment sont accessibles dans la fenêtre  Building Interactions. Cliquez le signe plus 

(+) en haut à droite pour ajouter le premier bâtiment. Entrez une valeur sous Direction. 

 

Distance au bâtiment (Distance to Building) 

 

Description : 

Distance la plus courte entre l'arbre et la partie la plus proche du bâtiment, pour les arbres qui 

remplissent les conditions ci-dessus. 

Comment saisir : 

Mesurez la distance la plus courte entre l'arbre et la partie la plus proche du bâtiment (à 0,10 

mètre près). 

• Papier (échantillon et inventaire complet): entrez la distance de chacun des trois 

bâtiments les plus proches sous TREES NEAR BUILDINGS > BLDG DIR 1/BLDG DIR 

2/BLDG DIR 3. 

• Collecteur mobile de données (échantillon et inventaire complet): dans la fenêtre  

Building Interactions, ajoutez des valeurs sous Distance et cliquez sur Save pour 

continuer. Cliquez sur le signe plus (+) en haut à droite pour ajouter un autre bâtiment. 

Une fois tous les bâtiments saisis, cliquez sur la flèche gauche de la page principale 

Building Interactions pour revenir au menu principal de cet arbre. 
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Description : 

Longitude et latitude de l’arbre 

Comment saisir : 

• Papier (échantillon et inventaire complet): saisissez la latitude et la longitude sous TREE 

GPS > LAT COORD Y et LONG COORD X. 

• Collecteur mobile de données (échantillon et inventaire complet):  entrez sous  Trees > 

Map Coordinates, il existe trois options pour l’acquisition des coordonnées. Saisie des 

coordonnées, utilisation d’un appareil GPS ou marquage de l’emplacement sur la carte. 

 

 

  

 Coordonnées GPS (GPS Coordinates) 
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Description : 

Nécessité d'un entretien de routine ou immédiat pour l'arbre. Eco propose 6 classes par défaut 

parmi lesquelles il faut choisir. Par ailleurs, les utilisateurs peuvent créer des classes 

personnalisées dans le logiciel i-Tree Eco qui sont plus pertinentes pour les objectifs de leur 

projet. Ces classes personnalisées doivent être créées avant de sortir sur le terrain. 

Les recommandations de gestion suivantes sont des options par défaut: 

▪ Aucune (None) 

▪ Petit arbre (routine) (Small tree (routine)) 

▪ Petit arbre (immédiat) (Small tree (immediate)) 

▪ Grand arbre (routine) (Large tree (routine)) 

▪ Grand arbre (immédiat) (Large tree (immediate)) 

▪ Problème critique (sécurité publique) (Critical concern (public safety)) 

 

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous MANAGEMENT FIELDS > 

MAINT RECOM. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de gestion 

sont accessible via la fenêtre Management Info. Sélectionnez une description dans le 

menu déroulant pour Maintenance Recommendation. 

 

 

Description : 

Nécessité de tâches prioritaires spécifiques pour l'arbre. Eco propose 7 classes par défaut 

parmi lesquelles il faut choisir. Par ailleurs, les utilisateurs peuvent créer des classes 

personnalisées dans le logiciel i-Tree Eco qui sont plus pertinentes pour les objectifs de leur 

projet. Ces classes personnalisées doivent être créées avant de sortir sur le terrain. 

Les taches de gestion suivantes sont des options par défaut: 

▪ Aucune (None) 

▪ Taille de formation (Formative pruning) (corriger les anomalies de structure des 

jeunes arbres) 

Informations relatives à la gestion 

 Gestion recommandée (Maintenance recommended) 

 Tâche de gestion (Maintenance Task) 
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▪ Elagage d’assainissement (Crown cleaning) (élagage sélectif pour supprimer un 

ou plusieurs des éléments suivants : branches mortes, malades, infestés, 

interférantes (qui se frottent), faible, détachées et/ou brisées)  

▪ Rehaussement de la couronne (Crown raising) (taille des branches pour fournir 

un dégagement vertical sous la couronne) 

▪ Réduction de la couronne (Crown reduction) (réduction de la longueur des 

branches, ou la hauteur de la plante et / ou son étalement, ex. pour réduire les 

conflits avec les lignes électriques) 

▪ Abattage (Remove) 

▪ Traitement de ravageurs/ maladie (Treat pests / disease) 

 

Comment saisir : 

• Papier (échantillon et inventaire complet) : entrez sous MANAGEMENT FIELDS > 

MAINT TASK. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de gestion 

sont accessibles via la fenêtre Management Info.  Sélectionnez une description dans le 

menu déroulant pour Priority Task. 

 

 

Description : 

Étendue du conflit entre la zone de contrefort de l’arbre / les racines principales et les structures 

inertes/ les trottoirs environnants. Eco propose 3 classes par défaut parmi lesquelles il faut 

choisir. Par ailleurs, les utilisateurs peuvent créer des classes personnalisées dans le logiciel i-

Tree Eco qui sont plus pertinentes pour les objectifs de leur projet. Ces classes personnalisées 

doivent être créées avant de sortir sur le terrain. 

 La valeur de déplacement de la structure inerte / trottoir initiée par le conflit est mesurée selon 

les options par défaut suivantes : 

▪ 0 to 1.90 cm  

▪ > 1.90 to 3.81 cm 

▪ > 3.81 cm  

 

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous MANAGEMENT FIELDS > 

SIDEWALK CONFL. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de gestion 

sont accessibles via la fenêtre Management Info. Sélectionnez une description dans le 

menu déroulant pour Sidewalk Conflict. 

 

 Conflit arbre/trottoir (Sidewalk Conflict) 
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Description : 

Conflits potentiels ou existants entre les branches d'arbre et les lignes aériennes d’utilité 

publique. Eco propose 3 classes par défaut parmi lesquelles il faut choisir. Par ailleurs, les 

utilisateurs peuvent créer des classes personnalisées dans le logiciel i-Tree Eco qui sont plus 

pertinentes pour les objectifs de leur projet. Ces classes personnalisées doivent être créées 

avant de sortir sur le terrain. 

Les conflits d’utilité suivants sont des options par défaut : 

▪ Pas de lignes (No lines) 

▪ Présent et aucun conflit potentiel (Present and no potential conflict) 

▪ Présent et conflictuel (Present and conflicting) 

 

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous MANAGEMENT FIELDS > 

UTILITY CONFL. 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de gestion 

sont accessibles via la fenêtre Management Info. Sélectionnez une description dans le 

menu déroulant pour Utility Conflict. 

 

 

Description : 

Les utilisateurs peuvent définir jusqu'à trois champs personnalisés supplémentaires pour 

décrire les arbres évalués de manière plus détaillée. Les catégories associées aux champs 

personnalisés sont définies par l'utilisateur lors de la configuration du projet. 

Comment saisir : 

• Papier (échantillon et inventaire complet): entrez sous Custom Fields > 1, 2, or 3 

• Collecteur mobile de données (échantillon et inventaire complet): les champs de gestion 

sont accessibles via la fenêtre Management Info. Sélectionnez une description dans le 

menu déroulant pour le champ personnalisé que vous avez défini. 

 

 

Dans le collecteur mobile de données, les champs relatifs aux ravageurs sont accessibles via la 

fenêtre Pests.  

 Conflit d’utilité (Utility Conflict) 

 Champs personnalisés (Custom Fields) 

 Ravageurs (Pests (IPED) 
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La fenêtre initiale de détection des ravageurs vous demande de noter si tout l’arbre, le 

feuillage/les rameaux ou les branches/le tronc présentent des signes de ravageurs ou de 

maladies. Si vous répondez «oui» à l'une de ces trois catégories, une fenêtre supplémentaire 

apparaît vous demandant de caractériser davantage les dommages. Pour chaque catégorie où 

vous avez identifié des signes ou des symptômes, vous devrez sélectionner Primary Pest s'il 

est connu (États-Unis uniquement). Si vous n'êtes pas sûr, sélectionnez Unknown (utilisateurs 

internationaux) car le protocole n'est pas censé être un outil de diagnostic mais plutôt une 

méthode systématique pour évaluer et documenter les signes et symptômes des ravageurs et 

des maladies. Si aucun signe ou symptôme de présence de ravageur ou de maladie n'a été 

identifié, sélectionnez None. 
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Pour les inventaires complets, continuez à entrer les arbres jusqu'à ce que tous les arbres du 

site soient inventoriés. Vérifiez soigneusement pour vous assurer que tous les champs 

obligatoires sont remplis et que toutes les entrées sont raisonnables. 

Pour les inventaires par échantillon, continuez à entrer les arbres jusqu'à ce que tous les 

arbres d'une placette soient comptabilisés. Il est de la responsabilité de chaque équipe de 

compléter toutes les variables avant de quitter la placette-échantillon. Vérifiez soigneusement 

pour vous assurer que tous les champs obligatoires sont remplis et que toutes les entrées sont 

raisonnables. 

Pour les utilisateurs du collecteur mobile de données, une fois que tous les arbres sont saisis, 

cliquez sur left arrow pour retourner au menu principal de la placette Plot. Cliquez sur Mark 

Plot as Completed. Vous êtes prêt à passer à la placette suivante. 

 

 

  

Finalisation de la collecte de données 

N'oubliez pas qu'avec le collecteur de données mobile, vos données ne sont 

pas envoyées automatiquement au serveur - elles sont uniquement 

enregistrées dans le cache du navigateur! Pour enregistrer vos données sur 

le serveur, vous DEVEZ les soumettre comme décrit dans la section Data 

Recording Tips de ce guide. Soumettez tôt et souvent! 

Averstissement 

 
! 



 

 
 

90 

 

 

Throughout this section of the manual, we will refer to certain components of the i-Tree Eco 

application. Here’s a guide to show you what the components of the Eco window look like. See 

the Glossary for more details! 

 

 

 

 

 

 

 

 

 

 

Phase IV: Working with Eco 

 Getting to Know Eco 

Tabs 

Select one of the tabs on the ribbon to 

display the buttons and functions available. 

Window display 

Use these buttons to 

           minimize; 

           restore down/maximize; or 

           close the window. 

File menu 

Create new, open, save, and manage your 

Eco projects here. 

Need help? 

Use the on-screen help text in this panel 

as guidance through the process of 

creating, editing, and viewing your Eco 

project and results. 

 
Use this button to 

           auto hide. 

What is the action panel? 

The action panel is this part of the window where 

you input and edit your project settings and data, 

as well as view reports. When you click on a 

button or function in the ribbon, the feature will 

be available here. 
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The Eco application is so versatile that rather than provide step-by-step directions we have 

chosen to explain what you can do in each tab and function and why that might be important to 

you. Review the information in this section to help you navigate through the application’s user 

interface. 

 

  

 Navigating the User Interface 

 

 

While working in Eco, use the on-screen help text in the panel on the left-

hand side of the window. This help text will provide step-by-step directions 

for using each button and function. 

Tip 

 

 

This is a complete list of tabs, functions, and buttons that are available for the 

Eco user interface. Depending on whether you are doing a plot-based sample 

inventory or a complete inventory, certain functions may not appear or may 

be “greyed out.” Do not worry about the “missing” functions – they are not 

available because they are not relevant to your specific project. 

Caution 

 
! 

 

 

i-Tree Eco provides example projects that you can look at to explore the 

application before working with your own project. Check out the Eco Guide to 

Exploring Example Projects for more details.  

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
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File Menu 

 

New Project 

Description: This menu option allows you to create a new Eco project. 

 

Open Project 

Description: This menu option allows you to open an existing Eco project. 

 

Open Example Project 

Description: This menu option allows you to open one of Eco’s example projects.  

 

Why It’s Important: i-Tree Eco provides example complete inventory and plot-based 

inventory projects that you can view to become more familiar with the Eco application. 

 

Save Project (Automatic). 

Description: This option is disabled, but included in the menu to indicate that your Eco 

project is automatically saved as edits are made. 

 

Save a Copy 

Description: This menu option allows you to save your open project under a new name.  

 

Why It’s Important: This feature is especially useful if you want to view the same project 

in different ways. For example, let’s say you decide to post-stratify your results. You can 

try stratifying your plots several different ways and save your Eco project each time you 

stratify using the Save a Copy feature. 

 

Pack Project 

Description: This menu option allows you to put all of your project materials into a single 

compressed folder that saves storage space and can be shared easily.  

 

Close Project 

Description: This menu option allows you to close your open project without closing the 

Eco application. 

 

Exit 

Description: This menu option allows you to close the Eco application. 
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Project Configuration 

 

On this tab, you can set up your new i-Tree Eco project, make changes, or view the settings that 

you provided for an existing project. 

 

Project Definition 

 

Project Definition 

Description: In this function, you can identify many of your most important project 

settings, including project name, series, and year, the location of your study area, and 

what data variables you will be collecting. 

 

Why It’s Important: You can’t run Eco without filling out the forms here. Plus, you’ve 

probably spent a lot of time planning and designing your project. All of the decisions that 

you have made to customize your project are used to inform the Eco model and must be 

entered here. 

 

Define Data Fields 

 

Land Use 

Description: In this function, you can view the actual land use classes in your study area. 

Eco provides 13 default land use classes that you can choose to work with or create 

your own list of custom land use classes. 

 

Why It’s Important: If you have decided to collect land use data, which is optional, this 

function is a good place to reference your default options or to customize the list to 

better suit your project. 

 

 

 

 

 

Remember the data collection decisions that you made in Phase III: 

Collecting Your Field Data? This is where that data is specified in the Eco 

application. 

Tip 

 

 

The actual land uses should not be confused with your project strata. If you 

are choosing to stratify by land use, those fields should be defined in the 

Project & Strata Area function. 

Caution 

 
! 
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Ground Cover 

Description: In this function, you can view the ground cover classes in your study area. 

Eco provides 11 default ground cover classes that you can choose to work with or create 

your own list of custom ground cover classes. 

 

   Why It’s Important: If you have decided to collect ground cover data, which is optional,  

   this function is a good place to reference your default options or to customize the list to  

   better suit your project. Grass, unmaintained grass, and herbs factor in to pollution  

   modeling for U.S. projects. Pollution results will be affected by how these ground covers  

   are categorized in the field or if new fields are mapped to these ground cover  

   designations. 

 

 

  DBH Class 

   Description: In this function, users can view Eco’s default dbh classes or enter custom    

   classes. There are 10 default dbh classes users can choose from when identifying dbh  

   during data collection. Users can choose to customizes these classes using the tools in  

   the Actions group of the ribbon. 

 

   Why It’s Important: You don’t have to do anything in this function unless you want to edit  

   the dbh classes. Measuring dbh is mandatory and this function is a good way to  

   customize your project. The dbh classes that are displayed here will be available in the  

   mobile data collector if you collect your field data using a mobile device, as well as in the  

   Data tab of the ribbon. 

 

 

Condition 

Description: In this function, you can view Eco’s default condition classes or enter 

custom classes. There are 22 default condition classes that you can choose from when 

you identify condition during data collection out in the field. You can also choose to add 

or edit the list of condition classes using the tools in the Actions group of the ribbon. 

 

Why It’s Important: You don’t actually have to do anything in this function unless you 

want to edit your condition classes. Assessing condition is optional and this function is 

simply a good place to reference if you want a refresher of your default or user-defined 

options. The condition classes that are displayed here will be available in the mobile 

data collector if you collect your field data using a mobile device, as well as in the Data 

tab of the ribbon. 

 

Dieback 

Description: In this function, you can view Eco’s default dieback classes or enter custom 

classes. There are 22 default dieback classes that you can choose from when you 

identify dieback during data collection out in the field. You can also choose to add or edit 

the list of dieback classes using the tools in the Actions group of the ribbon. 
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Why It’s Important: You don’t actually have to do anything in this function unless you 

want to edit your dieback classes. Assessing dieback is optional and this function is 

simply a good place to reference if you want a refresher of your default or user-defined 

options. The dieback classes that are displayed here will be available in the mobile data 

collector if you collect your field data using a mobile device, as well as in the Data tab of 

the ribbon. 

 

Maintenance 

 

• Maintenance Recommended 

Description: In this function, you can view broad types of recommended maintenance 

that can be specified during data collection in the field. There are six default 

maintenance recommendations (e.g., small tree routine), but we strongly encourage 

users to define maintenance recommendations that are relevant to their project 

goals. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The recommended maintenance options that are 

displayed here will be available in the mobile data collector if you collect your field 

data using a mobile device, as well as in the Data tab of the ribbon. 

 

• Maintenance Task 

Description: In this function, you can view priority maintenance tasks that can be 

specified during data collection in the field. There are seven default maintenance 

tasks (e.g., staking), but we strongly encourage users to define maintenance tasks 

that are relevant to their project goals using the tools in the Actions group of the 

ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The maintenance task options that are displayed here will 

be available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

• Sidewalk Conflict 

Description: In this function, you can view possible sidewalk conflicts with nearby 

trees that can be recorded during data collection in the field. There are three default 

measurements of sidewalk displacement (e.g., > 3.81 cm), but we strongly 

encourage users to define sidewalk conflicts in a way that is relevant to their project 

goals using the tools in the Actions group of the ribbon. 
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Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The sidewalk conflict classes that are displayed here will 

be available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

• Utility Conflict 

Description: In this function, you can view possible conflicts between tree branches 

and overhead utility lines that can be recorded during data collection in the field. . 

There are three default utility conflicts (e.g., present and conflicting), but we strongly 

encourage users to define utility conflicts in a way that is relevant to their project 

goals using the tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The utility conflict classes that are displayed here will be 

available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

Custom Fields 

Description: In this function, you can define the categories associated with your custom 

fields using the tools in the Actions group of the ribbon. Your custom fields are defined 

in the Project Definition function and would be included in your data collection out in 

the field. 

 

Why It’s Important: This is a great way to customize your Eco project! You may add up 

to three additional custom fields to describe your assessed trees in even more detail. 

The classes that you define here are available in the mobile data collector if you collect 

your field data using a mobile device, as well as in the Data tab of the ribbon. 

 

Define Plots 

 

Load from File 

Description: This function provides one of the methods for identifying your sample plots 

in Eco. Here you can load the three files that are necessary to identify your sample plots. 

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. More importantly, if 

you have created your sample using ArcGIS software, this function provides the means 

by which to load the files that you created in GIS. 

 

via Google Maps 

Description: This function provides one of the methods for identifying your sample plots 

in Eco. The Google Maps Plot Generator creates your plot sample directly in Eco! 
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Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. More importantly, if 

you have chosen to do a simple or stratified random sample, this tool provides an easy 

way to create your sample.  

 

User Defined 

Description: This function provides one of the methods for identifying your sample plots 

in Eco.  

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. This option allows 

you to define your plot sample manually by simply entering the plot size and number of 

plots that you would like to add to each strata. 

 

Project & Strata Area 

 

Project & Strata Area 

Description: In this function, you can add your project or strata area and view or edit the 

strata that you will be using for your project. Stratifying your study area allows you to 

subdivide the study area into smaller units, such as land use classes or political 

boundaries, so that you can compare urban forest effects between each stratum. 

 

Why It’s Important: The size entered in the “Area” column is used to calculate the per 

unit area, or density, estimates that are included in some of the Eco results on the 

Reports tab. The more accurate the area entered here, the better your density 

estimates will be. You can use the tools in the Actions group to add or delete strata. 

This is also simply a good place to reference the strata for your project! If you are doing 

a plot-based sample project, the strata that you define here will be visible in the User 

Defined function. The strata that you define here are also available in the mobile data 

collector if you collect your field data using a mobile device, as well as in the Data tab of 

the ribbon. 

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 
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Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that 

requires the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that 

is open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 

 

Restore Defaults 

Description: This tool will restore any default classes or categories of data to the table 

that is open in the action panel. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to 

the project settings in the Project Configuration tab. 

 

Why It’s Important: After you run the Eco model in the Reports tab, the Project 

Configuration tab will be locked so it cannot be edited unintentionally. However, the 

project settings that you enter in the Project Configuration tab may be edited with 

caution. In order to do this, you will need to switch to Editing mode by clicking on the 

Editing Mode function. If you choose to work in Editing mode, you will need to submit 

your data to the server again and retrieve your updated results. 

 

Data 

 

On this tab, you can add, edit, or view your inventory data (i.e., the plot and/or tree data that you 

collect in the field). 
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Data Collection 

 

Paper Form 

Description: This function displays the paper data collection forms provided by Eco. 

 

Why It’s Important: If you have decided to collect and record your field data on paper 

forms, this is where you will find Eco’s ready-made forms so you can save and print 

them. 

 

Submit to Mobile 

Description: This function submits your project configuration settings to the mobile data 

collector. If you are not planning to record your data in the field using the mobile data 

collector, then you do not need to use this tool. 

 

Why It’s Important: Your project configuration is unique to your project. Submitting your 

project settings using this tool ensures that your mobile data collector has the correct 

classes or categories when you go into the field to collect your data. If you do not first 

submit your project configuration using this tool, you will not be able to access the 

mobile data collector. 

 

Retrieve from Mobile 

Description: This function imports your inventory data from the mobile data collector into 

Eco. If you did not record your data in the field using the mobile data collector, then you 

will not need to use this tool. 

 

Why It’s Important: If you recorded your data in the field using the mobile data collector, 

this is how you will import your data. This tool offers an easy way of bringing your 

inventory data into the application. 

 

From the Complete Inventory Importer 

If you have an existing tree inventory, you can import your data directly into your complete 

inventory project: 

 

1 Click on the Data tab. 

 

2 Click on the Trees function. (Note: The Import tool will become available in the ribbon.) 

 

3 Click on the Import tool to import your existing tree inventory. 

 

4 In the Data Import Wizard, click Browse. 

 

a Navigate to the file containing your inventory data.  
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b Select the file and click Open. 

 

5 Confirm that the data that appears in the table is correct and click Next. 

 

6 Match your existing data fields to Eco’s data fields. 

 

 

a Select an inventory column from the table. The column header will appear in the 

“Your Source Column” space towards the bottom of the window. 

 

b Choose the “Eco Field” from the drop-down list that defines the type of data in 

your selected column. 

 

c Check the box indicating whether or not you will need to map your field values to 

the Eco field values. (Note: You will be prompted to complete the value mapping 

later. See step 8.) 

 

d CONDITIONALLY REQUIRED: As previously described, Eco data variables can 

often be displayed in several ways. For example, species data can be entered as 

common name, scientific name, or species code. For data variables where this 

applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the 

field type that matches your existing data. 

 

e Repeat steps 6a through 6d until each variable that you would like imported has 

been matched to the appropriate Eco field. 

 

7 Click Next. 

 

8 CONDITIONALLY REQUIRED: For data variables that you indicated the need to map 

field values (step 6c), match your field values to Eco’s. 

 

a In the upper table, select a row. 

 

b In the lower table, choose the “Eco Value” from the drop-down list that matches 

“Your Value.”  

 

 

 

Try moving from left to right clicking on each column in turn. This can help 

ensure that you match all of the necessary columns to an Eco field. 

Tip 
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c Move through the lower table until all of your values have been matched to an 

Eco value. 

 

d Repeat steps 8a through 8c until all necessary data variables have been 

mapped. 

 

9 Click Next. 

 

10 Review the results of your processed data at the top of the Data Import Wizard. This 

information will tell you how many records from your inventory data will be imported. 

 

11 When you are satisfied with the data that will be imported, click Finish. (Note: Use the 

Back button to return to previous steps to make adjustments.) 

 

 

Inventory Data 

 

Plots 

Description: Field data collected for each plot are entered in this function. You can also 

edit the plot data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 

 

Why It’s Important: If you are doing a plot-based sample project, this is where you can 

manually enter or edit your plot data. If you have already entered or imported your data, 

this function can simply be a place for viewing that data. 

 

Trees 

Description: Field data collected for each tree are entered in this function. You can also 

edit the tree data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 

 

Why It’s Important: For all projects, this is where you can manually enter or edit your tree 

data. If you have already entered or imported your data, this function can simply be a 

place for viewing that data. 

 

Shrubs 

Description: Field data collected for shrubs are entered in this function. You can also edit 

the shrub data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 

 

Why It’s Important: If you are doing a plot-based sample project and collected shrub 

data, this is where you can manually enter or edit that data. If you have already entered 

or imported your data, this function can simply be a place for viewing that data. 
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Check Data 

Description: The field data that you have imported or manually entered in the Plots, 

Trees, and/or Shrubs functions can be validated using the Check Data function. When 

you click on the Check Data function, Eco will check for invalid data and report issues 

that need to be corrected before you can submit your data to the server and retrieve 

your results.  

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 

 

KML 

Description: This function allows you to export tabular data from an open function to a 

“keyhole markup language” (kml) file format. 

 

Why It’s Important: If you have recorded the map coordinates of plot centers and/or 

trees, you will be able to make use of Eco’s KML function. Data exported as a kml file 

are compatible with software programs that include Google Earth and ArcGIS. This 

function allows you to view plot and tree data locations spatially. 

 

Inventory Value 

 

Benefit Prices 

Description: In this function, you can view or customize the benefit prices that will be 

used by the Eco model to estimate the economic value associated with the 

environmental benefits, such as carbon storage, provided by your urban forest. 

 

Why It’s Important: This is a great way to localize your results! Many of the default 

benefit prices available for Eco come from the scientific literature. This function allows 

you to enter data that is more relevant to your study area. Benefit prices may be edited 

at any time without requiring you to submit your project to the server again. The change 

to your monetary values will be reflected in the Reports tab immediately.  
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Annual Costs 

Description: In this function, you can include the annual costs associated with your 

project. There are no default costs for this function because they can vary significantly 

from place to place. The values that you provide here are primarily the annual costs 

associated with the management of your urban forest, such as tree planting or removal. 

However, there may be less obvious tree-related costs to consider, such as sidewalk 

repair costs or litigation fees. 

 

Why It’s Important: Providing annual cost information makes it possible to calculate a 

benefit-cost ratio which can be a valuable public-policy tool. Annual costs may be edited 

at any time without requiring you to submit your project to the server again. The change 

to your annual costs will be reflected in the Reports tab immediately. 

 

Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that 

requires the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that 

is open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

 

International Users: Remember the valuation data you collected in Phase 

II: Setting Up Your Project? The Benefit Prices function is where you 

will input your local values for estimating the economic value associated 

with certain tree benefits. Don’t forget – if you are choosing to use Eco’s 

default values, supply an exchange rate so your results will be given in 

your local currency.  

Tip 
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Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to 

the inventory data in the Data tab. 

 

Why It’s Important: After you run the Eco model in the Reports tab, the Data tab, with 

the exception of the Benefit Prices and Annual Costs functions, will be locked so it 

cannot be edited unintentionally. The data that you enter in the Data tab may still be 

edited with caution. In order to do this, you will need to switch to Editing mode by clicking 

on the Enable Mode function. If you choose to work in Editing mode, you will need to 

submit your data to the server again and retrieve your updated results. 

 

View 

 

On this tab, you can specify how you would like to view your project data, including which 

dataset you would like to view and the style of the user interface. 

 

Specify Data 

 

Specify Data 

Description: This function offers three drop-down menus for you to specify which dataset 

you would like to view in the application. 

 

Why It’s Important: i-Tree Eco projects are stored in databases that may contain multiple 

datasets. Use this function to specify the project, series, and year of the dataset that you 

want to view in Eco. 

 

Species 

 

Species Codes 

Description: This function is a lookup tool that identifies the common name, scientific 

name, and species code associated with a tree species when you supply any one of the 

three descriptors. For example, if you know that the common name of one of your tree 

species is Red Maple, then supplying that name in the lookup tool will provide you with 

the corresponding species code and scientific name. 

 

Why It’s Important: i-Tree Eco features data for over 7,500 tree and shrub species, each 

of which is associated with a particular common name, scientific name, and species 

code. This lookup tool enables you to find those descriptors easily. 
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 Species Lists 

Description: This function includes a table that identifies the species code, scientific 

name, and common name of all of the tree species that are available in Eco. This list can 

be exported to a “comma separated values” (csv) file for use outside of Eco. 

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 

 

Configuration 

 

Style 

Description: The user interface of the Eco application can be customized by choosing 

one of the different color schemes from the drop-down list.  

 

Always Minimize Help Panel 

Description: Help text is available in the panel on the left-hand side of the i-Tree Eco 

window. This function allows you to have that help panel minimized at all times. You can 

also choose to maximize the help panel again by deselecting this option. 

 

Reports 

 

On this tab, you can run the i-Tree Eco model and view your results. Eco features a number of 

charts, tables, and reports to summarize the structure, function, and ecosystem services 

provided by the urban forest in your study area. 

 

 

 

 

 

 

Go to Phase V: Viewing Your Reports to explore all of the reports that are 

available for your custom Eco project in more detail. 

Tip 
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Project Metadata 

 

Project Metadata 

Description: This report summarizes important metadata for your project, including the 

date your project was created, number of plots and / or trees, pollution and weather data 

used, benefit prices, and available reports. 

 

Why It’s Important: The Project Metadata report is a good place to check if and when 

you ran the model and view some of the key information about your project.  

 

Submit Data for Processing 

 

Submit Data for Processing 

Description: This function begins data processing. When you click on this button, your 

project settings and inventory data will be sent to the i-Tree server where the Eco model 

will run. 

 

Why It’s Important: After you have established your project settings in the Project 

Configuration tab and entered your field data in the Data tab, it is time to run the i-Tree 

Eco model. 

 

Track & Retrieve Results 

 

Track & Retrieve Results 

Description: This function is essential after data processing. When you click on this 

button, you can retrieve your results from the i-Tree server and view your Eco reports. 

 

Why It’s Important: After the i-Tree Eco model has run on the server you can retrieve the 

results for your project – the big payoff for all your efforts! This function also allows you 

to track the status of your data submission and see where you are in the processing 

queue. 

 

 

 

 

Formatted Reports 

 

 

 

If you make changes in the Project Configuration or Data tabs, you will need 

to send your data to the server again and retrieve your results so that the 

provided reports will be populated. 

Caution 

 
! 
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Written Report 

Description: This is a summary, narrative report of your project results. This report gives 

a great overview of the trees in your study area, while describing urban forest benefits 

and the basic methodology used in i-Tree Eco. 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about 

the composition and structure of the trees in your study area, including DBH (diameter at 

breast height), condition, and leaf area and biomass. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Benefits and Costs 

Description: The standard reports in this drop-down menu summarize information about  

the benefits and costs of the trees in your study area, including carbon storage and 

sequestration, energy effects, and pollution removal. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Measured Tree Details 

Description: The standard reports in this drop-down menu summarize information about 

the individual trees sampled in your study area. Reports include data about the 

composition and structure of the sampled trees, as well as benefits and costs. These 

reports are in tabular or chart format and can be saved or printed for use outside of the 

Eco application. 

 

Air Quality Health Impacts and Values 

Description: This is a standard report that provides estimates of the number of adverse 

health incidents avoided due to changes in pollutant concentration levels, as well as the 

economic value of reduced health incidents. This report is in tabular format and can be 

saved or printed for use outside of the Eco application. 

 

 

 

 

 

 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 
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Pest Analysis 

Description: The standard reports in this drop-down menu summarize information about 

the pest susceptibility of trees in your urban forest (USA only), as well as signs and 

symptoms of pests in your study area. These reports are in tabular or chart format and 

can be saved or printed for use outside of the Eco application. 

 

Charts 

 

Pollution and Weather 

Description: The standard reports in this drop-down menu summarize information about 

the pollution and weather data used for your project, such as air pollutant concentration, 

rain, temperature, air quality improvement, transpiration, avoided runoff and isoprene 

emitted by trees. These reports are in tabular or chart format and can be saved or 

printed for use outside of the Eco application. 

 

Settings 

 

 Coordinates, Comments, User ID 

 Turn these on to view in reports when available. 

 

English or Metric Units 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 

 

Why It’s Important: This function converts your results to English or metric units so you 

can view them in a way that suits your needs. This is also helpful if you have chosen to 

record your field data using one set of units, but would like to see results reported in 

different units. 

 

Common or Scientific Species Names 

Description: Choose to view your species by scientific name (e.g., Acer rubrum) or 

common name (e.g., Red maple). 

 

Why It’s Important: Many of the model outputs are reported by species. This function 

converts your results to scientific or common name so you can view them in a way that 

suits your needs. 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require additional pest data to be collected. Please refer back to 

Phase IIIB: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 
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Model Notes 

 

Model Notes 

Description: The notes available here provide more information about the data 

processing that occurs within the Eco model. For example, notes displayed here may tell 

a user that because energy data collected for a specific tree was invalid, it has not been 

included in estimated energy effects. 

 

Why It’s Important: This function provides a good opportunity to see if any errors have 

occurred during data collection or data entry. You can use the key below your 

processing notes to decipher any errors that occurred and determine how to resolve 

them. 

 

Map Active Report (beta) 

Description: The map that can be viewed here contains pollution stations used for this 

project and, if latitude and longitude were collected, locations of plots and/or trees. 

 

Forecast 

 

On this tab, you can run Eco’s Forecast component at a basic or advanced level and view the 

results of that run. To estimate what your urban forest will look like in the future, Forecast uses 

the structural estimates (e.g., number of trees, species composition) generated by running the i-

Tree Eco model along with anticipated growth and mortality rates. You can even include future 

tree planting scenarios or possible adverse events, such as a storm or pest infestation, to 

predict their impact on your urban forest. 

 

 

 

 

 

 

 

 

 

 

Don’t be shy – try just clicking the Run Forecast button in the ribbon bar! 

The Forecast model will use the provided default values and give you a 

basic estimate of what your urban forest will look like in the future. You can 

choose to make changes to the defaults later if you like. 

 

Tip 
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Configuration Summary 

 

Configuration Summary 

Description: This is a summary report that displays all of the parameters that you defined 

for the active configuration. This includes parameters defined under the Basic Options 

function, such as number of years to forecast, frost-free days, and base annual mortality 

rates, as well as any additional annual mortality rates or tree planting and extreme event 

scenarios that you defined. If you have chosen to run Forecast using the defaults 

provided, you will see those values here as well. 

 

 

Run Forecast 

 

Run Forecast 

Description: This function is used to begin running the Forecast model. 

 

Why It’s Important: Clicking on the Run Forecast button starts the process of estimating 

your future urban forest. The configuration selected in the Active Configuration drop-

down menu on the ribbon defines the settings for your Forecast results. Make sure that 

the desired configuration is selected before running Forecast. 

 

Basic Options 

 

Basic Options 

Description: In this function, you can set the number of years into the future your results 

will be forecasted, the number of days without frost in your study area, and basic annual 

mortality rates.   

 

Why It’s Important: The variables that you can set in this function allow you to customize 

your Forecast results at a very basic level. Please note that making changes here is 

optional. You can always run the model using the defaults provided! 

 

Custom Options 

 

Annual Mortality Rates 

Description: In this function, you can define your annual mortality rates. 

 

 

 

Look at the Eco Guide to Using the Forecast Model for detailed 

directions. 

Eco Guide  

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UsingForecast.pdf
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Why It’s Important: The rates that you set in this function allow you to customize your 

Forecast results at a more advanced level. One of the advantages of setting advanced 

mortality rates is that you can apply annual mortality rates to specific condition classes, 

strata, or genera. Please note that making changes here is optional. You can always run 

the model using the defaults provided! 

 

Trees to Plant 

Description: In this function, you can define one or more tree planting scenarios. 

 

Why It’s Important: The tree planting scenarios that you define in this function allow you 

to customize your Forecast results at a more advanced level. One of the advantages of 

including tree planting scenarios is that you can model what your urban forest will look 

like in the future as a result of one or more tree planting events, allowing you to account 

for tree planting in your study area (or even natural regeneration, which can be factored 

in as if it were tree planting). Please note that adding scenarios here is optional. You do 

not need planting scenarios to run the model! 

 

 

Extreme Events 

 

• Pest Outbreaks 

Description: In this function (USA only), you can define one or more pest outbreaks, 

such as an emerald ash borer infestation, and the annual mortality rate associated 

with each event. 

 

• Weather Events 

Description: In this function, you can define one or more weather events, such as 

hurricane or tropical storm, and the annual mortality rate associated with each event. 

 

Why It’s Important: The extreme events that you define in this function allow you to 

customize your Forecast results at a more advanced level. One of the advantages of 

defining extreme events is that you can model what your urban forest will look like in the 

future as a result of the loss of trees. Extreme events can be set as a single incident or 

recurring event. Please note that adding events here is optional. You do not need 

extreme events to run the model! 

 

Configurations 

 

The Configurations group of the Forecast tab encompasses multiple functions, including the 

Active Configuration drop-down list and Rename, New, Duplicate, Delete, and Restore 

Defaults functions. One of the useful features of Forecast is that you can make use of the 

component many different ways by projecting future estimates with any number of combinations 

of settings, tree planting scenarios, and extreme events. Each one of these combinations is a 

different configuration and can be defined by going through the Basic or Custom Options of 
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the ribbon. You can also choose to run Forecast without providing any special information and 

simply using the defaults provided. 

 

Active Configuration 

Description: This drop-down menu includes all of the Forecast configurations that you 

have created for your Eco project. 

 

Why It’s Important: The settings associated with the “active” configuration displayed here 

are what will be used when you decide to run Forecast. 

 

Rename 

Description: This tool allows you to rename the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

New 

Description: This tool allows you to create a new Forecast configuration. Your new 

configuration will contain all of the default Forecast settings until you make changes. 

 

 

Duplicate 

Description: This tool allows you to duplicate the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

Why It’s Important: This a useful tool if you have created a custom configuration. By 

duplicating your custom configuration, you can start with whatever changes you have 

already made to the settings and just make desired modifications to create different 

scenarios more easily. 

 

Delete 

Description: This tool allows you to delete the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

Restore Defaults 

Description: This tool will restore the default Forecast settings to the configuration that is 

displayed in the Active Configuration drop-down menu. 

 

 

You can choose to work with a different configuration at any time. Simply 

select the desired configuration from the Active Configuration drop-down 

menu! When you click on one of the other buttons or functions in the 

ribbon, the settings or reports will then be associated with that 

configuration.  

Tip 
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Reports 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about 

the structure of your future urban forest, including number of trees, tree cover, DBH 

(diameter at breast height), and leaf area and biomass. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Benefits 

Description: The standard reports in this drop-down menu summarize information about 

the function of your future urban forest, including carbon storage and sequestration and 

pollution removal. These reports are in tabular or chart format and can be saved or 

printed for use outside of the Eco application. 

 

Units 

 

English or Metric 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 

Why It’s Important: This function converts your Forecast results to English or metric units 

so you can view them in a way that suits your needs. This is also helpful if you have 

chosen to record your field data using one set of units, but would like to see results 

reported in different units. 

 

 

Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode in the Forecast tab. 

 

Why It’s Important: After the Forecast model has been run using a specified 

configuration, the settings of that configuration will be locked so they cannot be edited 

unintentionally. In order to edit those settings, first make sure that the appropriate 

configuration is selected in the Active Configuration drop-down menu and then switch 

to Editing mode by clicking on the Editing Mode function. If you choose to work in 

Editing mode, you will need to run Forecast again using that configuration to get updated 

results. 

 

 

 

 

 



 

 
 

114 

Support 

 

On this tab, you can access i-Tree Eco’s numerous support resources. 

 

User Manual 

Description: This function provides detailed specifications on setting up a project and 

carrying out data collection in the field. 

 

User Guides 

Description: This function provides topic-specific information to help users work through 

specific tasks for their project. The user guides available here are the same that are 

referenced throughout this manual.  

 

User Forum 

Description: This function links you to the webpage where you can participate in a 

moderated discussion forum to solicit advice, get technical questions answered, 

communicate experiences, and view frequently asked questions (FAQs). 

 

i-Tree Website 

Description: This function links you to the webpage where you can learn about all of the 

i-Tree applications and utilities, access i-Tree support resources, and read about what’s 

new with i-Tree. 

 

Software Update 

Description: This function checks for new versions of the i-Tree Eco software and 

downloads software updates. 

 

 

About 

Description: This option provides general information for the i-Tree Eco application. You 

can read an overview of the i-Tree Eco model and view version information, 

acknowledgements, and credits. 

 

License Agreement 

Description: This function opens the i-Tree End User’s License Agreement that you 

agree to when you download the i-Tree software and run an Eco project. 

 

Feedback 

Description: This function links you to the webpage where you can provide feedback 

about your experience using the i-Tree Eco application. 
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What’s New 

Description: This option provides you with a list of new features in Eco v6.0. You can 

read an overview of significant upgrades over previous versions and other important 

differences. 

 

 

 

To add or edit your project data in Eco, click on your computer’s Start button > (All) Programs 

> i-Tree > i-Tree Eco v6. You should have already created a new project before going out in 

the field to collect data. However, if you have not, refer back to Phase III > Preparing for the 

Field for directions on Getting Started in Eco or follow Eco’s on-screen help text. 

 

To open an existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click 

Open. 

 

From Paper Forms 

 

If you recorded your data using Eco’s paper form, you will have to enter your data manually: 

 

1 Click on the Data tab. 

2 Use the functions in the Inventory Data group of the ribbon.  

 

The data entry forms are in table format and allow you to enter or edit data for plots, trees, and 

shrubs, depending on how you customized your project. The tools in the Action group allow you 

to add new records, delete existing records, and undo or redo the last actions that you took. 

 

From the Mobile Data Collector 

 

If you recorded your data using Eco’s mobile data collector, you can import your data directly 

into Eco: 

 
1 Click on the Data tab. 

 Adding Data 

 

 

The Data tab is where you add your new data manually or edit data that has 

already been entered.  

Tip 
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2 Click on the Retrieve from Mobile function. 

3 Enter your password in the space provided. 

4 Click Show List and a description of your data will appear. 

5 Check the box next to the record(s) that you would like to retrieve. Each record includes 

a description and date to help you determine which records should be imported. 

6 Click Retrieve Data. 

 

From the Complete Inventory Importer 

 

If you have an existing tree inventory, you can import your data directly into your complete 

inventory project: 

 

1 Click on the Data tab. 

 

2 Click on the Trees function. (Note: The Import tool will become available in the ribbon.) 

 

3 Click on the Import tool to import your existing tree inventory. 

 

4 In the Data Import Wizard, click Browse. 

 

a Navigate to the file containing your inventory data.  

 

b Select the file and click Open. 

 

5 Confirm that the data that appears in the table is correct and click Next. 

 

6 Match your existing data fields to Eco’s data fields. 

 

 

a Select an inventory column from the table. The column header will appear in the 

“Your Source Column” space towards the bottom of the window. 

 

b Choose the “Eco Field” from the drop-down list that defines the type of data in 

your selected column. 

 

 

 

Try moving from left to right clicking on each column in turn. This can help 

ensure that you match all of the necessary columns to an Eco field. 

Tip 
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c Check the box indicating whether or not you will need to map your field values to 

the Eco field values. (Note: You will be prompted to complete the value mapping 

later. See step 8.) 

 

d CONDITIONALLY REQUIRED: As previously described, Eco data variables can 

often be displayed in several ways. For example, species data can be entered as 

common name, scientific name, or species code. For data variables where this 

applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the 

field type that matches your existing data. 

 

e Repeat steps 6a through 6d until each variable that you would like imported has 

been matched to the appropriate Eco field. 

 

7 Click Next. 

 

8 CONDITIONALLY REQUIRED: For data variables that you indicated the need to map 

field values (step 6c), match your field values to Eco’s. 

 

a In the upper table, select a row. 

 

b In the lower table, choose the “Eco Value” from the drop-down list that matches 

“Your Value.”  

 

c Move through the lower table until all of your values have been matched to an 

Eco value. 

 

d Repeat steps 8a through 8c until all necessary data variables have been 

mapped. 

 

9 Click Next. 

 

10 Review the results of your processed data at the top of the Data Import Wizard. This 

information will tell you how many records from your inventory data will be imported. 

 

11 When you are satisfied with the data that will be imported, click Finish. (Note: Use the 

Back button to return to previous steps to make adjustments.) 

  

 

 

For more information on importing a complete inventory, please see the Eco 

Guide to Importing an Existing Inventory. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
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After you have established your project settings in the Project Configuration tab and entered 

your field data in the Data tab, it is time to run the i-Tree Eco model and get the results for your 

project! 

 

i-Tree Eco presents model results in the Reports tab that include charts, tables, and a 

summary, narrative report. Functions that are greyed out cannot be accessed at that point. If 

you have not yet run the i-Tree Eco model, most of the reports, charts, and tables will not be 

available until after you have done so. Depending on the type of project and data collected, 

some analyses may not be completed.  

 

 

To start, open your existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click 

Open. 

 

Running the Eco model is a two-step process that is necessary to view your reports or use 

Forecast. The first step is to send your data to the i-Tree server where the Eco model will be 

run. The second step is to retrieve your results from the server. 

 

First, send your data to the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Submit Data for Processing function. 

3 Read the i-Tree End User’s License Agreement and click OK if you consent. 

4 In the Contact Information window, enter your personal information in the spaces 

provided.  

5 To confirm your email address, enter the same email address in the spaces labeled 

“Email” and “Confirm.” This information is critical. 

6 Click OK. 

 

Please be patient – model processing time depends on the number of projects that have been 

recently submitted to the server as well as the size of your project. You can click on the Track & 

Retrieve Results function to track your status in the queue. 

 

When your data have been processed, an auto-generated email notifying you that the results 

are ready to download will be sent to the email address that you provide in the Contact 

Information window. This email will be from info@itreetools.org; please check your spam 

Phase V: Viewing Your Reports 

 Running the Eco Model 

mailto:info@itreetools.org


 

 
 

119 

folders if you do not receive the email. Likewise, you will be notified of processing errors that 

require data to be submitted again. If you do not receive your results within 24 hours, please 

contact info@itreetools.org. 

 

Second, retrieve your results from the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Track & Retrieve Results function. 

3 In the Retrieve Processed Results window, click OK. 

4 Please be patient while results are downloaded. 

 

You will see that many of the reporting options listed in the ribbon bar are greyed out and 

unavailable until after you load your results from the server. 

 

If you are unsure whether or not you have run the Eco model, you can check the Project 

Metadata report of the Reports tab. This information is especially useful since you may find it 

necessary to run the i-Tree Eco model more than once throughout the duration of your project. 

 

 

Read through the descriptions in this section of the manual to learn more about the reports 

provided in Eco. The reports that are available to you are entirely based on the nature of your 

project and the data that you collected in the field or provided during project configuration. The 

Project Metadata report in the Reports tab provides a list of all possible Eco reports and 

indicates which ones are available for your specific project. 

 

 

i-Tree Eco provides a wide variety of standard reports to users.  

 

 Overview of Reports 

 

 

Need help interpreting some of your results? The Glossary of this manual 

is a great resource for definitions of key terms!  

Tip 

 

 

If you make changes to your project settings or add or edit your field data, you 

will need to send your data to the server and retrieve your results again to 

ensure that your changes are reflected in your reports. 

Caution 

 
! 

mailto:info@itreetools.org
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The Formatted Reports group contains four drop-down lists to choose reports from: 

• Composition and Structure charts and tables present information on the structural 

aspects of the urban forest of your study area, including population size, species 

composition, leaf area, tree condition, and biomass information. Results are provided in 

a variety of ways, such as classified by DBH size class or by strata or presented on a 

per-unit-area (per-acre or per-hectare) basis. 

 

• Benefits and Costs charts and tables present information on the environmental benefits 

that are provided by the urban forest in your study area. Results are provided in 

functional units (e.g., tons of carbon sequestered) and in associated monetary values.  

 

• Measured Tree Details charts and tables present information on the characteristics of 

the sampled trees in your study area, including structural aspects and ecosystem 

services. Results are provided for each individual tree, as well as by species.  

 

• Pest Analysis charts and tables include a standard report for all users on the 

susceptibility of their urban forest to known pests (USA only). For users who choose to 

conduct the Pest Detection Module, additional reports summarize the results of that 

analysis. 

 

The Charts group contains one drop-down list to choose reports from: 

• Pollution and Weather charts and tables present information from the weather and 

pollution data used for your project, such as rain, temperature, air pollutant 

concentration, air quality improvement, and transpiration. 

 

The Model Notes function provides more information about the data processing that occurs 

within the Eco model. 

 

The Units and Species Names groups include functions that allow you to set how units (i.e., 

metric or English) and species names (i.e., common or scientific) are displayed in your reports. 

You may choose to switch between the available options while you view your reports. 

 Reports 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 
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Project Metadata 

 

This report provides important information describing your project, including: 

• Version of i-Tree Eco used 

• Date when the project was created 

• Whether or not the model has been run 

• Project name, series, and year 

• Description of project settings 

• Details about pollution and weather data used 

 

One important piece of information that can be gathered here is whether or not the i-Tree Eco 

model has been run. This information is especially useful since you may find it necessary to run 

the i-Tree Eco model more than once throughout the duration of your project. 

 

Written Report 
 

This report includes a summary and discussion of the following results from your project: 

• Tree characteristics of the urban forest 

• Urban forest cover and leaf area 

• Ecosystem services (air pollution removal, carbon storage, etc.) 

• Structural and functional values of trees 

• Potential pest impacts 

• i-Tree Eco methods 

 

Composition and Structure Reports 

 

Structure Summary > By Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf 

area, leaf biomass, tree biomass, and average condition, for each species in your study area. 

 

Structure Summary > By Stratum and Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf 

area, leaf biomass, tree biomass, and average condition, for the tree species in each stratum in 

your study area. 

 

Population Summary > By Species 

This report provides total estimates and percent contributions of the number of trees for each 

species in your study area. Results are displayed in pie chart and table formats. 

 

Population Summary > By Stratum 

This report provides total estimates and percent contributions of the number of trees found in 
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each stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 

 

Population Summary > By Stratum per Unit Area 

This report provides per area (density) estimates of the number of trees found in each stratum in 

your study area. Per area estimates are calculated by dividing the total number of trees in each 

stratum by the area of the stratum. This report displays results in bar chart and table formats. 

 

Population Summary > Street Trees by Stratum 

This report provides estimates of the number of trees and percent of trees that were designated 

as street trees or non-street trees. Street tree and non-street tree results are summarized in 

separate tables by stratum. The tables display the following information: 

• Number of Trees – number of trees in stratum that were classified as street trees or non-

street trees. 

• % of Strata Trees – percent of trees in stratum that were classified as street trees or 

non-street trees. For example, in the “Summary of Street Trees” table, 100% would 

indicate that all trees located in that stratum were classified as street trees. 

• % of Street Trees – percent of all trees classified as street trees that were located in 

each stratum. For example, 50% would indicate that half of all street trees were located 

in that stratum.   

• % of Non-Street Trees – percent of all trees classified as non-street trees that were 

located in each stratum. For example, 25% would indicate that one quarter of all non-

street trees were located in that stratum.  

• % of All Trees – percent of the total number of trees that were classified as street trees 

or non-street trees and located in each stratum. For example, in the “Summary of Street 

Trees” table, 0% would indicate that none of the total number of trees were classified as 

street trees and located in that stratum. 

 

Species Distribution > By DBH Class (chart) 

This report provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed in chart format for the 10 most 

common species, showing the percent of the tree species population by DBH class. 

 

Species Distribution > By DBH Class (vertical table) 

This table provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the vertical display breaks the results into several tables so 

you can scroll down through all species in your study area before reaching the remaining DBH 

classes. 

 

Species Distribution > By DBH Class (horizontal table) 

This table provides estimates of the proportion of trees of each tree species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 



 

 
 

123 

cannot fit across the top of the table, the horizontal display breaks the results into several tables 

so you can scroll to the right through all DBH classes. 

 

Species Distribution > By DBH Class and Stratum (vertical table) 

This table provides estimates of the proportion of trees of each tree species by stratum that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of 

the tree species population by DBH class and include estimates of standard error. If all DBH 

classes cannot fit across the top of the table, the vertical display breaks the results into several 

tables so you can scroll down through all species in your study area before reaching the 

remaining DBH classes. 

 

Species Distribution > By DBH Class and Stratum (horizontal table) 

This table provides estimates of the proportion of trees of each tree species by stratum that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of 

the tree species population by DBH class and include estimates of standard error. If all DBH 

classes cannot fit across the top of the table, the horizontal display breaks the results into 

several tables so you can scroll to the right through all DBH classes. 

 

Importance Value > By Species 

This table provides estimates of the percent population, percent leaf area, and importance value 

for each tree species in your study area. Results are ordered from the highest to lowest 

importance value. Importance value (IV) is calculated as the sum of the percent population and 

percent leaf area. High importance values do not mean that these trees should necessarily be 

encouraged in the future; rather, these species currently dominate the urban forest structure. 

 

Diversity Indices > By Stratum 

This table provides estimates of various diversity indices by stratum in your study area. The 

diversity indices presented here serve as indicators of species richness, dominance, and 

evenness. This table displays the following information by stratum: 

• Richness – number of species sampled. 

• Per area estimates of number of species – density estimates calculated by dividing the 

total number of species in each stratum by the area of the stratum. 

• Shannon-Wiener diversity index – a diversity index that serves as an indicator for 

species richness. Because this index assumes that all species within a stratum or study 

area have been sampled, it has a moderate sensitivity to sample size; therefore, strata 

and/or cities may not be comparable.  

• Menhinick’s diversity index – another diversity index that also serves as an indicator for 

species richness. This index has a low sensitivity to sample size and therefore may be 

more appropriate for comparison between strata. 

• Simpson’s diversity index – a diversity index that serves as an indicator for species 

dominance. It also has a low sensitivity to sample size and therefore may be more 

appropriate for comparison between strata. 

• Shannon-Wiener evenness index – an evenness index that, like the Shannon-Wiener 

diversity index, assumes that all species within a stratum or study area have been 
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sampled. Similarly, it has a moderate sensitivity to sample size; therefore, strata and/or 

cities may not be comparable. 

• Sander’s rarefaction technique – a technique used for assessing species richness of 

samples. For a particular stratum, this value is the number of species one would expect 

to find if four trees were sampled in the stratum. For the city, this value is the number of 

species one would expect to find if 250 trees were sampled within the city. 

 

Species Range > Native Status by Stratum 

This table provides estimates of the percent of the trees in each stratum that are native to the 

state that the study area is located in. Possible places of origin include: 

• State (for U.S. projects only) 

• Africa 

• Africa & Asia 

• Asia 

• Asia & Australia 

• Asia & Australia + 

• Australia 

• Europe 

• Europe & Africa 

• Europe & Asia 

• Europe & Asia + 

• North America 

• North America + 

• North & South America 

• North & South America + 

• Other 

• South America 

• Unknown 

 

”Unknown” indicates that the origin of the tree species is unknown; places of origin that include 

two continents indicate that the tree species is native to both continents; and places of origin 

marked with a “+” indicate that the tree species is native to the place of origin listed plus another 

continent that is not listed. For projects in the U.S., “State” is an additional place of origin that is 

reported and refers to the state in which the study area is located. 

 

Condition > By Species 

This table provides estimates of the percent of each tree species found in each condition class. 

The following condition classes are included in the table: 

• Excellent 

• Good 

• Fair 

• Poor 

• Critical 
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• Dying 

• Dead 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Condition > By Stratum and Species 

This table provides estimates of the percent of each tree species by stratum found in each 

condition class. The following condition classes are included in the table: 

• Excellent 

• Good 

• Fair 

• Poor 

• Critical 

• Dying 

• Dead 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Leaf Area > By Stratum 

This report provides total estimates and percent contributions of the leaf area found in each 

stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 

 

Leaf Area > By Stratum per Unit Area 

This report provides per area (density) estimates of the leaf area found in each stratum in your 

study area. Per area estimates are calculated by dividing the total leaf area in each stratum by 

the area of the stratum. Results are displayed in bar chart and table formats. 

 

Leaf Area and Biomass > Of Shrubs by Stratum 

This table provides per area (density) and total estimates of leaf area and leaf biomass for each 

shrub species by stratum. Per area estimates are calculated by dividing the total leaf area or 

total leaf biomass in each stratum by the area of the stratum. Results include estimates of 

standard error. 

 

Leaf Area and Biomass > Of Trees and Shrubs by Stratum 

This table provides per area (density) and total estimates of leaf area and leaf biomass for tree 

and shrub species by stratum. Per area estimates are calculated by dividing the total leaf area 

or total leaf biomass in each stratum by the area of the stratum. Results include estimates of 

standard error. 
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Ground Cover Composition > By Stratum 

This table provides estimates of percent ground cover for each stratum in your study area. 

Results include estimates of standard error. The ground cover classes included here are 

defined in the Ground Cover function on the Project Configuration tab. 

 

Land Use Composition > By Stratum 

This table provides estimates of the amount of each stratum in your study area classified 

according to the actual land uses measured in the field. If you have chosen to stratify your 

project by land use, this table provides a useful look at how closely aligned your strata 

classifications are with actual land uses. Strata are defined in the Project & Strata Area 

function of the Project Configuration tab. Land uses are defined in the Land Use function on 

the Project Configuration tab. 

 

Relative Performance Index > By Species 

This table provides estimates of relative performance index (RPI) by tree species. RPI 

compares the overall condition of each species to all the others. Values that are higher than 1 

indicate that a species has a proportionately better condition rating.  

 

Maintenance > Recommended 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as needing some kind of recommended maintenance. Results are 

presented by recommended maintenance type, species, and DBH size class. 

 

Maintenance > Task 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were as assigned to receive a particular maintenance task. Results are presented by 

maintenance task, species, and DBH size class. 

 

Maintenance > Sidewalk Conflicts 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as exhibiting a sidewalk conflict. Results are presented by type of sidewalk 

conflict, species, and DBH size class. 

 

Maintenance > Utility Conflicts  

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as a utility conflict class. Results are presented by type of utility conflict, 

species, and DBH size class. 

 

Other > Other One / Two / Three 

If you created one or more custom data fields (maximum of three) during project configuration, 

these tables will provide estimates of the number of trees, percent of species, and percent of all 

trees that were designated according to those custom fields. Results are presented by type of 

custom data, species, and DBH size class. 
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Miscellaneous > All Plots 

This table provides information of the stratum, address, date, crew, and whether or not the data 

collection was completed for each plot. 

 

Miscellaneous > Plot Comments 

This table lists any comments that were collected related to plots. 

Benefits and Costs Reports 

 

Benefits Summary > By Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for each 

species in your study area. 

 

Benefits Summary > By Stratum and Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for the tree 

species in each stratum in your study area. 

 

Carbon Storage of Trees > By Species 

This report provides total estimates and percent contribution of carbon storage of trees by 

species in your study area. Results are also reported in carbon dioxide equivalent by multiplying 

carbon storage by the ratio of their atomic weights (44/12). Results are displayed in table 

format. 

 

Carbon Storage of Trees > By Stratum 

This report provides total estimates and percent contribution of carbon storage of trees by 

stratum in your study area. Results are also reported in carbon dioxide equivalent by multiplying 

carbon storage by the ratio of their atomic weights (44/12). Results are displayed in bar chart, 

pie chart, and table formats. 

 

Carbon Storage of Trees > By Stratum per Unit Area 

This report provides (density) per area estimates of carbon storage of trees by stratum in your 

study area. Per area estimates are calculated by dividing the total carbon storage in each 

 

 

Monetary values are based on the Benefit Prices function of the Data tab. 

To edit benefit prices, open that function and follow the steps outlined in 

the Help panel. This form can be edited at any time and you will not be 

required to submit your project again. Results on the Reports tab will 

reflect the change in benefit prices immediately. 

Tip 
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stratum by the area of the stratum. Per area estimates are also reported for the carbon dioxide 

equivalent. Results are displayed in bar chart and table formats. 

 

Annual Carbon Sequestration of Trees > By Species 

This report provides total estimates of gross carbon sequestration of trees by species in your 

study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

sequestration by the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Annual Carbon Sequestration of Trees > By Stratum 

This report provides total estimates of gross carbon sequestration of trees by stratum in your 

study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

sequestration by the ratio of their atomic weights (44/12). Results are displayed in bar chart and 

table formats. 

 

Annual Carbon Sequestration of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of gross carbon sequestration of trees by 

stratum in your study area. Per area estimates are calculated by dividing the total gross carbon 

sequestration in each stratum by the area of the stratum. Per area estimates are also reported 

for the carbon dioxide equivalent. Results are displayed in bar chart and table formats. 

 

Annual Net Carbon Sequestration of Trees > By Species 

This report provides total estimates of net carbon sequestration of trees by species in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree death. 

Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Annual Net Carbon Sequestration of Trees > By Stratum 

This report provides total estimates of net carbon sequestration of trees by stratum in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree death. 

Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in bar chart and table formats. 

 

Annual Net Carbon Sequestration of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of net carbon sequestration of trees by stratum 

in your study area. Net sequestration is a measure of the carbon sequestered by trees 

calculated as the gross carbon sequestered minus the carbon emissions due to decomposition 

after tree death. Per area estimates are calculated by dividing the total gross carbon 

sequestration in each stratum by the area of the stratum. Per area estimates are also reported 

for the carbon dioxide equivalent. Results are displayed in bar chart and table formats. 
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Compensatory Value Factors for European Countries 

Compensatory value for trees is calculated using the Trunk Area formula found in the CTLA 

guide’s 8th edition. Some factors that determine the final value are species rating, base value, 

and for palm trees the cost per linear foot of clear trunk. These values were compiled from 

numerous states within the United States for i-Tree Eco, but comparable factors for European 

nations are not readily available. 

 

The species value is a rating from 0-100 (where 100 is the most desirable). For each species, 

this rating might change from one location to another. The average U.S. rating by species was 

applied for all European countries (see table 1). If no species value is found for an individual 

species then the average from the same genus is used. If no genus value is found, the average 

of results from all broadleaf or conifer equations is used. There are numerous other methods to 

estimate structural value throughout the world, but the CTLA approach is commonly used in the 

US and is also used in non-US countries within i-Tree for consistency in estimation of 

compensatory values. 

 

Table 1. Average species values used in i-Tree for Europe 

Scientific Name Average of rating 

Abies alba 62 

Abies amabilis 62 

Abies balsamea 60 

Abies bracteata 62 

Abies concolor 79 

Abies concolor v lowiana 62 

Abies fraseri 63 

Abies grandis 62 

Abies holophylla 62 

Abies homolepis 62 

Abies lasiocarpa 62 

Abies magnifica 62 

Abies procera 62 

Abies spp. 62 

Acer barbatum 73 

Acer buergerianum 73 

Acer campestre 73 

Acer circinatum 73 

Acer ginnala 73 

Acer glabrum 73 

Acer grandidentatum 73 

Acer griseum 73 

Acer japonicum 73 

Acer leucoderme 73 
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Acer macrophyllum 51 

Acer mono 73 

Acer negundo 33 

Acer nigrum 78 

Acer palmatum 73 

Acer pensylvanicum 73 

Acer platanoides 65 

Acer pseudoplatanus 63 

Acer rubrum 74 

Acer saccharinum 40 

Acer saccharum 77 

Acer spicatum 73 

Acer tataricum 73 

Acer spp. 73 

Aesculus flava 68 

Aesculus glabra 63 

Aesculus hippocastanum 60 

Ailanthus altissima 31 

Arbutus menziesii 50 

Betula alleghaniensis 61 

Betula lenta 57 

Betula nigra 70 

Betula occidentalis 59 

Betula papyrifera 60 

Betula pendula 59 

Betula populifolia 59 

Betula pubescens 59 

Betula pumila 58 

Betula spp. 59 

Carya alba 66 

Carya aquatica 61 

Carya cordiformis 62 

Carya floridana 51 

Carya glabra 65 

Carya illinoinensis 61 

Carya laciniosa 60 

Carya myristiciformis 51 

Carya ovalis 51 

Carya ovata 67 

Carya pallida 51 

Carya texana 51 
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Carya spp. 51 

Castanea dentata 48 

Catalpa speciosa 47 

Cedrus atlantica 82 

Cedrus deodara 64 

Celtis laevigata 63 

Celtis occidentalis 69 

Cercidiphyllum japonicum 79 

Chamaecyparis thyoides 71 

Chrysolepis chrysophylla 75 

Cryptomeria japonica 62 

Cupressocyparis leylandii 64 

Eucalyptus botryoides 52 

Eucalyptus camaldulensis 52 

Eucalyptus camphora 52 

Eucalyptus cinerea 52 

Eucalyptus diversicolor 52 

Eucalyptus globulus 52 

Eucalyptus grandis 52 

Eucalyptus gunnii 52 

Eucalyptus leucoxylon 52 

Eucalyptus polyanthemos 52 

Eucalyptus pulchella 52 

Eucalyptus rudis 52 

Eucalyptus sideroxylon 52 

Eucalyptus tereticornis 52 

Eucalyptus viminalis 52 

Eucalyptus spp. 52 

Fagus grandifolia 86 

Fagus sylvatica 83 

Fraxinus americana 67 

Fraxinus anomala 63 

Fraxinus berlandieriana 64 

Fraxinus caroliniana 64 

Fraxinus cuspidata 64 

Fraxinus excelsior 64 

Fraxinus greggii 64 

Fraxinus holotricha 64 

Fraxinus latifolia 64 

Fraxinus nigra 58 

Fraxinus ornus 64 
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Fraxinus oxycarpa 64 

Fraxinus pennsylvanica 65 

Fraxinus profunda 64 

Fraxinus quadrangulata 69 

Fraxinus texensis 64 

Fraxinus uhdei 64 

Fraxinus velutina 64 

Fraxinus spp. 64 

Ginkgo biloba 81 

Gleditsia triacanthos 65 

Gymnocladus dioicus 75 

Juglans cinerea 52 

Juglans nigra 63 

Juglans regia 54 

Juniperus virginiana 63 

Larix decidua 72 

Larix laricina 69 

Liquidambar styraciflua 72 

Liriodendron tulipifera 75 

Lithocarpus densiflorus 65 

Magnolia acuminata 73 

Magnolia grandiflora 70 

Metasequoia glyptostroboides 79 

Nyssa sylvatica 84 

Paulownia tomentosa 41 

Picea abies 69 

Picea abies x asperata 75 

Picea asperata 75 

Picea bicolor 75 

Picea breweriana 75 

Picea engelmannii 75 

Picea glauca 71 

Picea glehnii 75 

Picea jezoensis 75 

Picea koraiensis 75 

Picea koyamai 75 

Picea mariana 74 

Picea montigena 75 

Picea omorika 75 

Picea pungens 76 

Picea rubens 75 
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Picea sitchensis 75 

Picea spp. 75 

Pinus albicaulis 60 

Pinus aristata 60 

Pinus attenuata 60 

Pinus balfouriana 60 

Pinus banksiana 45 

Pinus canariensis 60 

Pinus cembroides 60 

Pinus clausa 60 

Pinus contorta 60 

Pinus coulteri 60 

Pinus densiflora 60 

Pinus discolor 60 

Pinus echinata 50 

Pinus edulis 60 

Pinus elliottii 57 

Pinus engelmannii 60 

Pinus flexilis 60 

Pinus glabra 55 

Pinus halepensis 60 

Pinus jeffreyi 60 

Pinus lambertiana 60 

Pinus longaeva 60 

Pinus monophylla 60 

Pinus monticola 60 

Pinus mugo 60 

Pinus muricata 60 

Pinus nigra 66 

Pinus palustris 75 

Pinus parviflora 60 

Pinus pinea 60 

Pinus ponderosa 60 

Pinus pungens 60 

Pinus quadrifolia 60 

Pinus radiata 60 

Pinus resinosa 65 

Pinus rigida 58 

Pinus sabiniana 60 

Pinus serotina 60 

Pinus strobiformis 60 
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Pinus strobus 73 

Pinus sylvestris 65 

Pinus taeda 70 

Pinus thunbergiana 60 

Pinus torreyana 60 

Pinus virginiana 53 

Pinus washoensis 60 

Pinus spp. 60 

Platanus hybrida 67 

Platanus occidentalis 63 

Populus alba 36 

Populus angustifolia 39 

Populus balsamifera 39 

Populus balsamifera ssp. trichoca 37 

Populus x canadensis 39 

Populus x canescens 33 

Populus deltoides 45 

Populus deltoides ssp. monilife 39 

Populus fremontii 39 

Populus grandidentata 43 

Populus heterophylla 30 

Populus nigra 33 

Populus tremuloides 42 

Populus spp. 39 

Prunus alleghaniensis 48 

Prunus americana 48 

Prunus angustifolia 48 

Prunus armeniaca 48 

Prunus avium 48 

Prunus x blireiana 48 

Prunus caroliniana 48 

Prunus cerasifera 48 

Prunus domestica 48 

Prunus dulcis 48 

Prunus emarginata 48 

Prunus fremontii 48 

Prunus glandulosa 48 

Prunus hortulana 48 

Prunus ilicifolia ssp. lyon 48 

Prunus japonica 48 

Prunus laurocerasus 48 
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Prunus maackii 48 

Prunus maritima 48 

Prunus mexicana 48 

Prunus munsoniana 48 

Prunus myrtifolia 48 

Prunus nigra 48 

Prunus padus 48 

Prunus pensylvanica 48 

Prunus persica 48 

Prunus pumila 48 

Prunus pumila v. besseyi 48 

Prunus sargentii 48 

Prunus serotina 45 

Prunus serrulata 48 

Prunus spinosa 48 

Prunus subcordata 48 

Prunus subhirtella 48 

Prunus triloba 48 

Prunus umbellata 48 

Prunus virginiana 48 

Prunus spp. 48 

Pseudotsuga menziesii 75 

Quercus acutissima 78 

Quercus agrifolia 83 

Quercus alba 88 

Quercus arizonica 83 

Quercus austrina 83 

Quercus berberidifolia 83 

Quercus bicolor 82 

Quercus cerris 77 

Quercus chapmanii 83 

Quercus chrysolepis 84 

Quercus coccinea 86 

Quercus douglasii 80 

Quercus dunnii 83 

Quercus ellipsoidalis 80 

Quercus emoryi 83 

Quercus engelmannii 83 

Quercus falcata 78 

Quercus gambelii 83 

Quercus garryana 81 
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Quercus grisea 83 

Quercus hemisphaerica 83 

Quercus hypoleucoides 83 

Quercus ilicifolia 83 

Quercus imbricaria 74 

Quercus incana 83 

Quercus kelloggii 79 

Quercus laevis 71 

Quercus laurifolia 76 

Quercus lobata 82 

Quercus lyrata 85 

Quercus macrocarpa 87 

Quercus margaretta 83 

Quercus marilandica 56 

Quercus michauxii 81 

Quercus muehlenbergii 81 

Quercus myrtifolia 78 

Quercus nigra 74 

Quercus oblongifolia 83 

Quercus oglethorpensis 83 

Quercus pagoda 83 

Quercus palustris 66 

Quercus petraea 83 

Quercus phellos 76 

Quercus prinoides 83 

Quercus prinus 78 

Quercus robur 79 

Quercus rubra 75 

Quercus shumardii 83 

Quercus sinuata 83 

Quercus stellata 61 

Quercus suber 83 

Quercus texana 83 

Quercus velutina 76 

Quercus virginiana 84 

Quercus wislizeni 80 

Quercus spp. 83 

Robinia pseudoacacia 41 

Salix nigra 37 

Salix x sepulcralis 41 

Sequoia sempervirens 70 
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Sequoiadendron giganteum 70 

Taxodium distichum 79 

Thuja occidentalis 57 

Thuja plicata 55 

Tilia americana 67 

Tilia cordata 81 

Tilia tomentosa 73 

Tsuga canadensis 71 

Ulmus alata 59 

Ulmus americana 52 

Ulmus crassifolia 62 

Ulmus glabra 60 

Ulmus parvifolia 74 

Ulmus procera 66 

Ulmus pumila 31 

Ulmus rubra 52 

Ulmus serotina 60 

Ulmus thomasii 62 

Ulmus spp. 59 

Umbellularia californica 60 

Zelkova serrata 68 

 

The base value is comprised of 3 factors: 1) replacement cost, 2) maximum size for 

replacement, and 3) average cost per square inch of trunk area, which varies by state. For 

Europe, the average replacement cost and cost per sq. inch for trees with a maximum 

replacement size of 4 inch (10 cm) dbh is based on an average of all species with values within 

hardwood and softwood categories (Table 2).  

 

Table 2. Average base values used in Europe 

Category Cost Trunk Area Replacement Cost Max. Transplant Size 

Hardwood $30.31 / sq. inch $820 4-inches 

Softwood $29.55 / sq. inch $769 4-inches 

 

 

Palm trees are valued differently from hardwood and softwood trees. To calculate the 

replacement cost, a dollar value per clear trunk length is added to a planting cost. Clear trunk is 

determined by the length of trunk which is free from fronds. An average dollar per foot of clear 

trunk from Florida and California was used for Europe; these were the only two states that had 

reported values in the CTLA guide. The cost per linear foot and planting costs (based on CTLA 

planting cost categories by species) are given in Table 3. 
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Table 3. Palm factors for determining replacement costs by i-Tree species code 

Scientific Name $/clear foot of trunk Planting cost ($) 

Acoelorrhaphe wrightii 15 275 

Archontophoenix alexandrae 103 275 

Archontophoenix cunninghamiana 103 275 

Arecastrum romanzoffianum 103 275 

Brahea armata 171 350 

Brahea edulis 171 350 

Butia capitata 62 350 

Chamaerops humilis 71 350 

Cocos nucifera 140 750 

Cycas circinalis 140 750 

Cycas revoluta 205 750 

Livistona chinensis 60 350 

Phoenix canariensis 321 2000 

Phoenix dactylifera 134 700 

Phoenix reclinata 86 850 

Phoenix roebelenii 73 350 

Phoenix sylvestris 95 350 

Roystonea elata 90 275 

Sabal palmetto 6 275 

Syagrus romanzoffiana 33 350 

Trachycarpus fortunei 55 350 

Washingtonia filifera 43 400 

Washingtonia robusta 25 275 

Yucca aloifolia 103 275 

Yucca guatemalensis 103 275 

 

 

Energy Effects > Of Trees 

This table provides total estimates of the effect of trees in your study area on energy usage. 

Estimates are included for the following energy effects: 

• Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

• Effect on carbon emissions (i.e., increases or decreases in carbon emissions from power 

sources as a result of changes in energy use) 

• Value of effects (i.e., economic values associated with the changes in building energy 

use and carbon emissions) 

 

 

 



 

 
 

139 

European Energy Savings Calculations 

For i-Tree energy calculations to function outside the US, cities in Europe need to be assigned a 

US climate region to ascertain energy and fuel type values. The European associations with 

climate regions were compiled at the national level based on the following criteria in sequence: 

1) User assignments through the i-Tree Database. If multiple cities were assigned with a 

European country or no cities were assigned, the following procedures were used 

2) Location of the county based on similarities with US latitude and coastal/interior 

geographic similarities 

3) Climate similarities based on average annual temperature (Figure 1, Table 1) 

 

Figure 1. U.S. climate zones from the Carbon Reduction through Urban Forestry guidelines 

(McPherson and Simpson 1999). 

 
 

 

 

 

https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
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Table 2. U.S. climate zones assigned to countries in Europe. 

Country U.S. Climate Zone 

Austria Southeast 

Belgium Pacific Northwest 

Bulgaria Southwest 

Croatia Southwest 

Cyprus California Coast 

Czech Republic Southeast 

Denmark Pacific Northwest 

Germany California Coast 

Greece California Coast 

Estonia Northern Tier 

Finland Northern Tier 

France California Coast 

Hungary Southeast 

Iceland Northern Tier 

Ireland Pacific Northwest 

Italy California Coast 

Latvia Northern Tier 

Liechtenstein Southeast 

Lithuania Northern Tier 

Luxembourg Pacific Northwest 

Malta California Coast 

Montenegro California Coast 

Netherlands Pacific Northwest 

Norway Northern Tier 

Poland Pacific Northwest 

Portugal California Coast 

Republic of Macedonia California Coast 

Romania Southwest 

Spain California Coast 

Slovakia Southwest 

Slovenia Southwest 

Switzerland Southeast 

Sweden Northern Tier 

Turkey Pacific Northwest 

United Kingdom Pacific Northwest 

Note: not all countries in Europe are assessed in i-Tree due to limited data for the missing 

countries 

 

The cost of electricity and fuels for all European countries came from Eurostat (2017). 

All other variables used in the energy savings calculations in Europe are based on the formulas 

and lookup tables in the Carbon Reduction through Urban Forestry guidelines (McPherson and 

Simpson 1999).  

https://ec.europa.eu/eurostat/statistics-explained/index.php/Electricity_price_statistics
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf
https://www.fs.fed.us/psw/topics/urban_forestry/products/cufr_43.pdf


 

 
 

141 

Warning: this procedure of estimating tree effects on energy use was developed for US building 

types and energy uses. Applications of this process outside of the United States will produce 

results that assume that the U.S. conditions (e.g., climate, building types, heating fuel usage) 

apply to the European country. The only local values used in the estimates for Europe are 

electricity and fuel costs. The remainder of the estimation is based US conditions from the 

assigned climate zone. 

 

Hydrology Effects of Trees > By Species 

This table provides total estimates of stormwater runoff avoided due to trees by species in your 

study area. This table includes estimates for the following: 

• Number of trees 

• Leaf area 

• Potential evapotranspiration 

• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Hydrology Effects of Trees > By Stratum 

This table provides total estimates of stormwater runoff avoided due to trees by stratum in your 

study area. This table includes estimates for the following: 

• Number of trees 

• Leaf area 

• Potential evapotranspiration 

• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Oxygen Production of Trees > By Stratum 

This report provides total estimates of oxygen production of trees by stratum in your study area. 

Results are displayed in bar chart and table formats. 

 

Oxygen Production of Trees > By Stratum per Unit Area 

This report provides per area (density) estimates of oxygen production of trees by stratum in 

your study area. Per area estimates are calculated by dividing the total oxygen production in 

each stratum by the area of the stratum. Results are displayed in bar chart and table formats. 

 

Pollution Removal by Trees and Shrubs > Monthly Removal 

This table provides total monthly and annual estimates of pollution removal and associated 

value by the trees and shrubs in your study area. This table displays minimum, maximum, and 
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mean pollution removal and value results for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is 

not included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 

microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

Pollution Removal by Trees and Shrubs > Monthly Removal (chart display) 

This report provides total monthly estimates of pollution removal and associated value by the 

trees and shrubs in your study area. The report displays charts and tables for the following 

pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Several of the charts and tables in this report present pollution removal and the associated 

value for all of the pollutants studied. The remaining charts show pollution removal and value for 

each pollutant individually. (Note: While particulate matter smaller than 10 microns (PM10) is a 

significant air pollutant, it is not included in this analysis because i-Tree Eco analyzes particulate 

matter less than 2.5 microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant 

in discussions concerning air pollution effects on human health.) 

 

Pollution Removal by Grass / Herbaceous Material > Monthly Removal 

This table provides total monthly and annual estimates of pollution removal and associated 
value by grasslands (a combination of maintained and wild grass as well as herbaceous) in your 
study area. This table displays minimum, maximum, and mean pollution removal and value 
results for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is 

not included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 

microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 
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Pollution Removal by Grass / Herbaceous Material > Monthly Removal (chart display) 

This report provides total monthly estimates of pollution removal and associated value by 
grasslands (a combination of maintained and wild grass as well as herbaceous) in your study 
area. The report displays charts and tables for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Several of the charts and tables in this report present pollution removal and the associated 

value for all of the pollutants studied. The remaining charts show pollution removal and value for 

each pollutant individually. (Note: While particulate matter smaller than 10 microns (PM10) is a 

significant air pollutant, it is not included in this analysis because i-Tree Eco analyzes particulate 

matter less than 2.5 microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant 

in discussions concerning air pollution effects on human health.) 

 

VOC Emissions of Trees > By Species 

This table provides total estimates of volatile organic compounds (VOC) emissions from the tree 

species in your study area, including monoterpene, isoprene, and the sum of both. 

 

VOC Emissions of Trees > By Stratum 

This table provides total estimates of volatile organic compounds (VOC) emissions of trees by 

strata in your study area, including monoterpene, isoprene, and the sum of both. 

 

UV Effects of Trees > By Stratum 

This table provides estimates of the effects that trees have on the ultraviolet (UV) radiation 

received in your study area. UV radiation is emitted by the sun and while beneficial to humans in 

small doses, can have negative health effects when people are overexposed. The UV index 

scale was developed by the World Health Organization to more easily communicate daily levels 

of UV radiation and alert people to when protection from overexposure is needed most. UV 

index values are estimated from UV radiation and adjusted based on local elevation and cloud 

cover. Tree canopies help to reduce the amount of UV radiation that reaches the ground thus 

providing people with additional protection from the sun’s harmful rays. UV effects are reported 

in this table for each stratum and the study area as a whole and broken into the following 

results: 

• UV Effects in Tree Shade – changes in UV for a person who is always shaded by tree 

canopy. For example, someone who is sitting under a tree. 

• UV Effects Overall – changes in UV for a person who is in both areas that are shaded by 

tree canopy and areas that are not. For example, someone who is walking down a street 

may find themselves under tree canopy at some times and exposed to full UV radiation 

at others. 
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Results are additionally reported for the following: 

• Protection factor – a unit-less value meant to capture the UV radiation-blocking capacity 

of trees. It is comparable to the SPF rating in sunscreen and calculated as unshaded UV 

index divided by shaded or overall UV index. 

• Reduction in UV Index – the change in UV index as the result of trees and calculated as 

unshaded UV index minus shaded or overall UV index. 

• Percent reduction – the reduction in UV index expressed as a percent change and 

calculated as the reduction in UV index divided by unshaded UV index. 

 

Wildlife Suitability > By Plot 

This table provides estimates of wildlife suitability for each plot in your study area. The suitability 

index reported here is a unit-less value meant to capture the ability of an area to sustain a 

population based on the habitat features that relate to and influence the patterns of abundance 

of each species. Two suitability index values are given for each plot. One value is based on the 

trees that were sampled on the plot and the other value assumes an absence of trees on the 

plot. The index change due to trees is estimated as the following: 

• A relative change calculated as the absolute change (see below) divided by the 

suitability index with trees. 

• An absolute change calculated as the suitability index with trees minus the suitability 

index without trees. 

 

The wildlife species reported here are based on species’ ranges so only those species present 

in the study area will be included in the report. Data is available for up to nine bird species, 

including American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, 

European starling, northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 

 

Wildlife Suitability > By Stratum 

This table provides estimates of wildlife suitability for each stratum and your study area as a 

whole. The suitability index reported here is a unit-less value meant to capture the ability of an 

area to sustain a population based on the habitat features that relate to and influence the 

patterns of abundance of each species. Two suitability index values are given for each stratum. 

One value is based on the trees in that stratum and the other value assumes an absence of 

trees in the stratum. The index change due to trees is estimated as the following: 

• A relative change calculated as the absolute change (see below) divided by the 

suitability index with trees. 

• An absolute change calculated as the suitability index with trees minus the suitability 

index without trees. 

 

The wildlife species reported here are based on species’ ranges so only those species present 

in the study area will be included in the report. Data is available for up to nine bird species, 

including American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, 

European starling, northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 
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Management Costs > By Expenditure 

This table reports the user-defined expenditures for managing the trees in your study area. 

From the total costs reported, the cost per tree and cost per capita are also estimated and 

presented in this table. Management costs are defined by the user in the Annual Costs function 

of the Data tab. To edit your annual costs, open that function and follow the steps outlined in the 

Help panel. This form can be edited at any time and you will not be required to submit your 

project again. Results on the Reports tab will reflect the change in annual costs immediately. 

 

Net Annual Benefits > Net Annual Benefits for All Trees 

This table reports the economic value of the environmental benefits provided by all of the trees 

in your study area. The user-defined management costs are reported so that net benefits and 

benefit-cost ratio can be estimated for your study area. From the total benefits and costs 

reported, per tree and per capita estimates are also presented in this table. Management costs 

are defined by the user in the Annual Costs function of the Data tab. To edit your annual costs, 

open that function and follow the steps outlined in the Help panel. This form can be edited at 

any time and you will not be required to submit your project again. Results on the Reports tab 

will reflect the change in annual costs immediately. 

 

Foodscape Benefits of Trees > By Species 

The report seen in the action panel to the right provides information about the characteristics, 

productivity and services provided by edible/useful species of trees.  It is intended to 

communicate the value of this subset of trees in order to guide users in the planning, 

management and selection of the appropriate species. 

Only those species for which data has been gathered are included in the report. Additionally, if 

an entry in the report is blank, no data is currently available for that attribute. In the future, more 

species will be added. These data were gathered by the Community Food Forestry Initiative 

(CFFI). 

 

Measured Tree Details Reports 

 

Composition and Structure > Individual Tree Data 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the trees sampled in your study area. The table includes 

estimates for the following characteristics: 

• Tree ID 

• Species name 

• Diameter at breast height (DBH) 

• Height 

• Canopy cover 

• Tree condition 

• Leaf area 

• Leaf biomass 

http://inhabit.earth/community-food-forestry/
http://inhabit.earth/community-food-forestry/
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• Leaf area index – estimated by dividing leaf area by canopy cover 

• Basal area 

• Street tree 

• Native to state 

 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Composition and Structure > By Species 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the species in your study area. The table includes estimates for 

the following characteristics: 

• Tree count 

• Canopy cover 

• Leaf area 

• Leaf biomass 

• Basal area 

 

Composition and Structure > By Stratum 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the stratum in your study area. The table includes estimates for 

the following characteristics: 

• Tree count 

• Canopy cover 

• Leaf area 

• Leaf biomass 

• Basal area 

 

Benefits and Costs > Individual Tree Benefits Summary 

This table provides a summary of Eco’s benefit estimates, including structural value, energy 

savings, carbon storage and sequestration, avoided runoff, and pollution removal, for each of 

the trees sampled in your study area. 

 

Benefits and Costs > Carbon Storage 

This table provides estimates of carbon storage for each of the trees sampled in your study 

area. The percent contribution to the total carbon storage of all sampled trees is also reported. 

 

Benefits and Costs > Carbon Sequestration 

This table provides estimates of carbon sequestration for each of the trees sampled in your 

study area. The percent contribution to the total carbon sequestration of all sampled trees is 

also reported. 
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Benefits and Costs > Energy Effects 

This table provides total estimates of the effect of each tree sampled in your study area on 

energy usage. The table includes estimates for the following energy effects: 

• Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

• Value of effects (i.e., values associated with the changes in building energy use) 

 

Benefits and Costs > Hydrology Effects 

This table provides total estimates of the stormwater runoff avoided due to each tree sampled in 

your study area. The table includes estimates for the following: 

• Leaf area 

• Potential evapotranspiration 

• Evaporation 

• Transpiration 

• Water intercepted 

• Avoided runoff 

• Avoided runoff value 

 

Benefits and Costs > Pollution Removal 

This table presents total estimates of pollution removal, associated pollution removal value, and 

volatile organic compound emissions for each of the trees sampled in your study area. The table 

reports estimates for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

• Monoterpene 

• Isoprene 

 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is 

not included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 

microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

Benefits and Costs > Oxygen Production 

This table provides total estimates of the oxygen production of each tree sampled in your study 

area. 

 

Benefits and Costs > VOC Emissions 

This table provides total estimates of the volatile organic compounds (VOC) emissions of each 

tree sampled in your study area, including monoterpene, isoprene, and the sum of both. 
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Air Quality and Public Health Reports 

 

These reports provides estimates of the number of adverse health incidents that were avoided 

due to changes in pollutant concentration levels attributed to trees, shrubs, and grass. The 

estimates in the tables reflect the population of your study area. The dollar values reflect the 

economic value of those reductions in health incidents. The same health effects are not 

necessarily analyzed for each pollutant. Blank values indicate that incidence reduction and 

value are not estimated for that pollutant and health effect. For example, acute bronchitis is only 

estimated for particulate matter less than 2.5 microns (PM2.5) 

 

Pest Analysis Reports (USA only) 

 

Susceptibility to Pests > By Stratum 

This table displays results for 36 pests and diseases (USA only). Results are reported as the 

number of trees by strata that are susceptible or not susceptible to each pest. Structural value 

and leaf area are also estimated based on the number of trees. 

 

Primary Pest > Impacts by Stratum 

This table displays results for the pests that were detected in your study area (based on signs 

and symptoms reported following the Pest Detection Module protocol). 

 

Primary Pest > Impacted Tree Details 

This table displays results for the pests that were detected in your study area (based on signs 

and symptoms reported following the Pest Detection Module protocol). 

 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require the collection of additional pest data. Please refer back to 

Phase III: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 

 

 

The susceptibility report does not reflect field-collected data about actual risks 

and harm, but rather calculates the damage from a potential outbreak based 

on species diversity in your population. This susceptibility report will continue 

to be fully functional whether or not you choose to collect the supplemental 

pest detection data. 

 

Tip 
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Signs & Symptoms > Totals by Species 

This table displays the percent of trees that are affected by pests for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The 

table shows a summary of the more detailed results as well as the percent of trees affected by 

each sign or symptom for each of the tree species sampled. 

 

Signs & Symptoms > Details by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The 

table shows the complete detailed results as well as the percent of trees affected by each sign 

or symptom for each of the tree species sampled. 

 

Signs & Symptoms > Totals by Stratum 

This table displays the percent of trees that are affected by pests in each stratum (based on 

signs and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Stratum 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows a 

summary of the more detailed results as well as the percent of trees affected by each sign or 

symptom for each stratum. 

 

Signs & Symptoms > Details by Stratum 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows the 

complete detailed results as well as the percent of trees affected by each sign or symptom for 

each stratum. 

 

Signs & Symptoms > Impacted Tree Finder 

This table is an interactive display that allows you to choose which pest signs and symptoms 

you are most interested in. 

 

Pest Review > Of Assessed Trees 

This table is an interactive display that allows you to choose which pest you are most interested 

in and view the tree species that exhibit the signs and symptoms associated with that pest. 
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Pollution and Weather Reports 

 

Raw and Source Data > Air Pollutant Concentration 

This report displays the hourly pollution concentration based on air quality data. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Raw and Source Data > Photosynthetically Active Radiation 

This report displays the hourly photosynthetically active radiation based on weather data. 

Results are displayed in line chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Rain 

This report displays the hourly precipitation based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Temperature 

This report displays hourly air temperature based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > UV Index 

This report displays the daily ultraviolet (UV) index in your study area. UV radiation is emitted by 

the sun and while beneficial to humans in small doses, can have negative health effects when 

people are overexposed. The UV index scale was developed by the World Health Organization 

to more easily communicate daily levels of UV radiation and alert people to when protection 

from overexposure is needed most. UV index values are estimated from UV radiation and 

adjusted based on local elevation and cloud cover. Results are displayed in line chart and table 

formats. UV data is from the same year as the user-designated weather and pollution year. It is 

presented as a daily value at solar noon when the sun is highest in the sky. 

 

Air Quality Improvement > By Trees 

This report displays hourly air quality improvement provided by the tree cover in your study 

area. Results are displayed in line chart and table formats for the user-designated pollution 

year. Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 
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Air Quality Improvement > By Shrubs 

This report displays hourly air quality improvement provided by the shrub cover in your study 

area. Results are displayed in line chart and table formats for the user-designated pollution 

year. Estimates are reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Air Quality Improvement > By Grass / Herbaceous Material 

The report seen in the action panel to the right displays the hourly dry deposition of air 
pollutants per unit of grass / herbaceous cover. This report displays results in line chart and 
table formats for the user-designated pollution year. Estimates are reported for the following 
pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 
 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Tree Cover 

This report displays hourly dry deposition of air pollutants per unit of tree cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Shrub Cover 

This report displays hourly dry deposition of air pollutants per unit of shrub cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 
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Air Pollutant Flux (Dry Deposition) > Per Unit Grass / Herbaceous Cover 

The report seen in the action panel to the right displays the hourly dry deposition of air 
pollutants per unit of grass / herbaceous cover. This report displays results in line chart and 
table formats for the user-designated pollution year. Estimates are reported for the following 
pollutants: 

• Nitrogen dioxide (NO2) 

• Sulfur dioxide (SO2) 

• Ozone (O3) 

• Carbon monoxide (CO) 

• Particulate matter less than 2.5 microns (PM2.5) 

Transpiration > By Trees 

This report displays hourly transpiration by trees. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

 

Transpiration > By Shrubs 

This report displays hourly transpiration by shrubs. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Evaporation > By Trees 

This report displays the hourly evaporation by trees. Evaporation is the amount of water that is 

released to the atmosphere from the plant’s surface. Results are displayed in line chart and 

table formats for the user-designated weather year. 

 

Evaporation > By Shrubs 

This report displays the hourly evaporation by shrubs. Evaporation is the amount of water that is 

released to the atmosphere from the plant’s surface. Results are displayed in line chart and 

table formats for the user-designated weather year. 

 

Water Intercepted > By Trees 

This report displays the hourly water interception by trees. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Water Intercepted > By Shrubs 

This report displays the hourly water interception by shrubs. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 
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Avoided Runoff > By Trees 

This report displays the hourly avoided runoff by trees. Avoided runoff is the amount of water 

that would become surface runoff to streams, but does not. Estimates incorporate water 

interception by plants, ground depression storage, infiltration on pervious ground covers, and 

overland flow on impervious ground covers. Results are displayed in line chart and table formats 

for the user-designated weather year. 

 

Avoided Runoff > By Shrubs 

This report displays the hourly avoided runoff by shrubs. Avoided runoff is the amount of water 

that would become surface runoff to streams, but does not. Estimates incorporate water 

interception by plants, ground depression storage, infiltration on pervious ground covers, and 

overland flow on impervious ground covers. Results are displayed in line chart and table formats 

for the user-designated weather year. 

 

Potential Evapotranspiration > By Trees 

This report displays the hourly potential evapotranspiration by trees. Potential 

evapotranspiration is the sum of the evaporation from the soil and the transpiration from plants 

that would occur if an unlimited amount of water were available. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Potential Evapotranspiration > By Shrubs 

This report displays the hourly potential evapotranspiration by shrubs. Potential 

evapotranspiration is the sum of the evaporation from the soil and the transpiration from plants 

that would occur if an unlimited amount of water were available. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

UV Index Reduction by Trees > Effects in Tree Shade 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 

health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce 

the amount of UV radiation that reaches the ground thus providing people with additional 

protection from the sun’s harmful rays. Effects in tree shade are changes in UV for a person 

who is always shaded by tree canopy. For example, someone who is sitting under a tree. 

Reduction in UV Index in tree shade is calculated as unshaded UV index minus shaded UV 

index. Results are displayed in line chart and table formats. UV data is from the same year as 

the user-designated weather and pollution year. It is presented as a daily reduction at solar 

noon when the sun is highest in the sky. 

 

UV Index Reduction by Trees > Effects Overall 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 
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health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce 

the amount of UV radiation that reaches the ground thus providing people with additional 

protection from the sun’s harmful rays. Overall effects are changes in UV for a person who is in 

both areas that are shaded by tree canopy and areas that are not. For example, someone who 

is walking down a street may find themselves under tree canopy at some times and exposed to 

full UV radiation at others. Reduction in UV Index overall is calculated as unshaded UV index 

minus overall UV index. Results are displayed in line chart and table formats. UV data is from 

the same year as the user-designated weather and pollution year. It is presented as a daily 

reduction at solar noon when the sun is highest in the sky. 

 

Isoprene > By Trees 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of trees sampled in your study area as oz / hr. 
 
 
Isoprene > By Shrubs 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of shrubs measured in your study area as oz / hr. 
 
Monoterpene > By Trees 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of trees sampled in your study area as oz / hr. 
 
Monoterpene > By Shrubs 
The table and chart seen in the action panel to the right provides total estimates of the isoprene 
emissions of shrubs measured in your study area as oz / hr. 
 

Model Notes 

 

This report provides more information about the data processing that occurs within the Eco 

model. For example, notes here may indicate that energy data collected for a specific tree was 

invalid and therefore the estimated energy effects do not include that specific tree. The key 

below the processing notes can be used to decipher any errors that occurred and determine 

how to resolve them. 

 

 

 
The standard reports provided by Eco can easily be saved or printed so you can make use of 
them outside the application. After opening a report, a toolbar will become available in the action 
panel of the Eco window. Reports can be saved in pdf, xlsx, xls, rtf, or docx format.   

 Sharing Your Project 
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Pack Project 

 

The Pack Project option allows you to create a zip folder that includes all the necessary 

information to transfer your Eco project from one computer to another or to share the project 

with another user. To begin the process: 

 

1 Click File > Pack Project. 

2 Browse to the folder where you would like to save your zip file, enter a file name, and 

click Save. 

 

To unpack the project on the new computer: 

 
1 Navigate to the folder where you saved your zip file. 

2 Right-click on the zip file and extract files. 

The project can now be accessed from the Eco application by opening the project file. 
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i-Tree Eco 

 

The user interface of the i-Tree Eco program is organized as shown below. Throughout the help 

text and User’s Manual, there will be references to the various features explained here. 

 

Features: 

1 File menu – This drop-down menu provides options to start a new project, open an 

existing project, save your project, etc. 

2 Tabs – i-Tree Eco has six tabs to choose from that bring up specific functions in the 

ribbon. Tab options include: 

• Project Configuration 

• Data 

• View 

Glossary 

1 2 

3 
5 

4 

6 7 
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• Reports 

• Forecast 

• Support 

3 Ribbon – The ribbon bar provides access to the groups and functions that are available 

for each selected tab. 

4 Group – Similar functions are organized into each group. 

5 Function – The various buttons or drop-down lists in the ribbon make project settings, 

data entry, and report features available in the action panel. 

6 Action Panel – This is where you input and edit your project settings and data, as well 

as view reports. 

7 Info Panel – This is where you can view help text for the many features of i-Tree Eco. 

The panel can be minimized and maximized as desired. 

 

Resource Structure 

 

Condition – Relating to the tree crown health (e.g., poor condition, good, dead/dying). This 

variable is assessed in the field by identifying a tree’s crown condition or dieback. 

 

Diameter at breast height (DBH) – The diameter of the tree stem measured at 1.37 meters 

above planted grade (breast height). 

 

Importance value (IV) –Relating to the dominance of a tree species in the urban forest. 

Importance value is calculated as the sum of the percent population and percent leaf area.  High 

importance values do not mean that these trees should necessarily be encouraged in the future; 

rather these species currently dominate the urban forest structure. 

 

Leaf area – The total one-sided surface area contributed by all of the leaves on the trees. Leaf 

area is estimated using measurements of crown dimensions and percentage of crown canopy 

missing. 

 

Leaf area index (LAI) – The total one-sided leaf surface area per unit of ground surface area. 

Leaf area index is estimated by dividing the leaf area by the ground area. Higher LAIs indicate a 

greater number of leaves per unit of ground area. 

 

Leaf biomass – The total living mass contributed by all of the leaves on the sampled trees. 

 

Origin – Relating to the continent or region that a particular tree species is native to (i.e., where 

the species developed or occurs naturally). 

 

Rarefaction – A technique used for assessing species richness of a sample of trees. Using this 

technique, species richness in estimated by plotting the number of species against the number 

of samples to create rarefaction curves. For i-Tree, the value produced using the rarefaction 

technique is the number of species one would expect to find if 4 trees were sampled in each 
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stratum. For the entire study area, this value is the number of species one would expect to find if 

250 trees were sampled within the study area. 

 

Species diversity – The number of different species that are represented in the study area. 

Species diversity takes into account both species richness and species evenness. 

 

Species dominance – A measure of the degree to which a species is more numerous than 

others or contributes more of the total biomass. 

 

Species evenness – A measure of how closely matched the numbers of each species are to 

each other. 

 

Species richness – The number of different species that are represented in the study area. 

 

Ecosystem Services 

 

Avoided runoff – A measure of the stormwater runoff that is avoided because of rainfall 

interception by trees, which partially intercept precipitation on their leaves and other surfaces. 

Avoided runoff is estimated by comparing the hourly precipitation processes and total annual 

surface runoff volume modeled for the study area as it occurs with trees present and as it would 

occur if there were no trees. 

 

VOC Emissions – A measure of the volatile organic compounds (VOC) released. Trees release 

VOC emissions, specifically isoprene and monoterpene, which can contribute to the formation of 

ozone and carbon monoxide. The amount of emissions depends on tree species, leaf, biomass, 

air temperature, and other environmental factors.  

 

Carbon sequestration – A measure of the carbon (in the form of carbon dioxide) that is 

removed from the atmosphere by trees. 

• Gross sequestration – A measure of the carbon sequestered by trees calculated as the 

difference in estimates of carbon storage between Year X and Year X +1. 

• Net sequestration – A measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree 

death. 

 

Carbon storage – A measure of the carbon that is stored within trees. This is the amount of 

carbon that is bound up in both the above-ground and below-ground parts of woody vegetation. 

 

Energy effects – A measure of the seasonal effects of trees on residential building energy use 

and consequent emissions from power plants. Energy effects are estimated based on tree 

distance and direction to residential structures, tree height, and tree condition. 

• Energy use – Increases or decreases in the number of MBTUs and MWHs used for 

heating or cooling residential buildings that are affected by trees, which affect energy 
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use by modifying local the immediate climate, producing shade, and reducing wind 

speeds. 

• Emissions – Increases or decreases in carbon emissions from power plants as a result 

of changes in energy use. 

 

Evaporation – The amount of water that is released to the atmosphere from the plant’s surface. 

 

Oxygen production – A measure of the oxygen produced by trees during photosynthesis, 

taking into account the amount consumed during plant respiration. This net oxygen production is 

calculated from carbon sequestration estimates based on atomic weight. 

 

Pollution removal – A measure of the air pollution that is removed from the atmosphere by 

trees. Pollution removal is calculated for nitrogen dioxide (NO2), sulfur dioxide (SO2), ozone 

(O3), carbon monoxide (CO), and particulate matter less than 2.5 microns (PM2.5). Trees remove 

gaseous air pollution primarily by uptake via leaf stomata, though some gases are removed by 

the plant surface. Trees also remove pollution by intercepting airborne particles. Some particles 

can be absorbed into the tree, though most particles that are intercepted are retained on the 

plant surface. 

 

Potential evapotranspiration – The sum of the evaporation from the soil and the transpiration 

from plants that would occur if an unlimited amount of water were available. 

 

Transpiration – The amount of water moved through plants and released to the atmosphere. 

 

UV index – Ultraviolet (UV) radiation is emitted by the sun and while beneficial to humans in 

small doses, can have negative health effects when people are overexposed. The UV index 

scale was developed by the World Health Organization to more easily communicate daily levels 

of UV radiation and alert people to when protection from overexposure is needed most. 

 

Water intercepted – The amount of rainfall that fell on plants and was intercepted by the plant’s 

leaves. This water is eventually evaporated to the atmosphere. 

 

Values 

 

Avoided runoff value – A functional value provided by the trees (i.e., a value that results from 

an environmental function of trees). This is the monetary value of stormwater runoff that is 

avoided because of rainfall interception by trees. This value is estimated based on the economic 

damages associated with runoff and costs of stormwater control. 

 

Carbon sequestration value - A functional value provided by the trees (i.e., a value that results 

from an environmental function of trees). This is the monetary value associated with tree effects 

on atmospheric carbon. This value is estimated based on the economic damages associated 

with increases in carbon or carbon dioxide emissions. 
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Carbon storage value – A structural value based on the tree itself. This is the monetary value 

associated with tree effects on atmospheric carbon. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Compensatory value – A structural value based on the tree itself. The compensatory value is 

based on the cost of having to replace a tree with a similar tree. 

 

Energy effects value – A functional value provided by the trees (i.e., a value that results from 

an environmental function of trees). 

• Energy use – The monetary value of increased or decreased energy costs as a result of 

a tree’s effect on residential building energy use. This value is estimated based on the 

dollar value per MBTU or MWH. 

• Emissions – The monetary value of increases or decreases in carbon emissions from 

power plants as a result of changes in energy use. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Pollution removal value – A functional value provided by the trees (i.e., a value that results 

from an environmental function of trees). This is the monetary value associated with tree effects 

on atmospheric pollution. This value is estimated based on the economic damages associated 

with increases in pollution emissions and/or the impact of air pollution on human health. 
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i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service that 

provides urban and community forestry analysis and benefit assessment tools. The i-Tree 

tools help communities of all sizes to strengthen their urban forest management and 

advocacy efforts by quantifying the environmental services that trees provide and assessing 

the structure of the urban forest. 

 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, and 

students to report on the urban forest at all scales from individual trees to parcels, 

neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem 

services that trees provide, i-Tree users can link urban forest management activities with 

environmental quality and community livability. Whether your interest is a single tree or an 

entire forest, i-Tree provides baseline data that you can use to demonstrate value and set 

priorities for more effective decision-making. 

 

Developed by the USDA Forest Service and numerous cooperators, i-Tree is in the public 

domain and available by request through the i-Tree website (www.itreetools.org). The Forest 

Service, Davey Tree Expert Company, Arbor Day Foundation, Society of Municipal Arborists, 

International Society of Arboriculture, Casey Trees, and State University of New York College of 

Environmental Science and Forestry have entered into a cooperative partnership to further 

develop, disseminate, and provide technical support for the suite. 

 

 

The use of trade, firm, or corporation names in this publication is solely for the information 

and convenience of the reader. Such use does not constitute an official endorsement or 

approval by the U.S. Department of Agriculture or the Forest Service of any product or 

service to the exclusion of others that may be suitable. The software distributed under the 

label “i-Tree 2017 Suite” is provided without warranty of any kind. Its use is governed by the 

End User License Agreement (EULA) to which the user agrees before installation. 

 

 

The i-Tree Development Team actively seeks feedback on any component of the project: the 

software suite itself, the manuals, or the process of development, dissemination, support, and 

refinement. Please send comments through any of the means listed on the i-Tree support page: 

www.itreetools.org/support/. 

  

About i-Tree 

 Disclaimer 

 Feedback 

http://www.itreetools.org/
http://www.itreetools.org/support/
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The 2019 i-Tree software international suite includes the following urban forest analysis tools 

and utility programs: 

 

 

i-Tree Eco provides a broad picture of the urban forest or trees in your study area. It is 

designed to use field data from complete inventories of trees or randomly located plots 

throughout a community along with local hourly air pollution and meteorological data to quantify 

urban forest structure, environmental effects, and value to communities. 

 

i-Tree Hydro is the first vegetation-specific urban hydrology model. It is designed to model the 

effects of changes in urban tree cover and impervious surfaces on hourly stream flows and 

water quality at the watershed level. 

 

 

 

i-Tree Canopy offers a quick and easy way to produce a statistically valid estimate of land 

cover types (e.g., tree cover) using aerial images available in Google Maps. The data can be 

used by urban forest managers to estimate tree canopy cover, set canopy goals, and track 

success; and to estimate inputs for use in i-Tree Hydro and elsewhere where land cover data 

are needed. Canopy also estimates tree benefits based on the amount of tree cover in your 

study area (US only). 

 

i-Tree Species is designed to help users select the most appropriate tree species based on 

the species potential environmental services and geographic area. Users select and rank the 

importance (0-10) of each environmental service desired from trees. The program then 

calculates the best tree species based on the user-provided weighting of environmental 

benefits of tree species at maturity. 

 

i-Tree Database is an online system designed for international users outside of the United 

States, Canada, Mexico, Australia United Kingdom and Europe, to submit properly formatted 

international pollution and weather data, location information, new species information, and 

other requirements needed for the i-Tree Eco model to process in a new, previously 

unsupported study area. The submitted information will be vetted by the U.S. Forest Service 

and integrated into the Eco model as a new international location that would be available for 

automated processing in future updates of Eco.  

i-Tree Products 

 Desktop Applications 

 Web Applications  

https://www.itreetools.org/eco/index.php
https://www.itreetools.org/hydro/index.php
https://canopy.itreetools.org/
https://species.itreetools.org/
http://www.itreetools.org/database/
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Components of the i-Tree software suite have been developed over the last few decades by the 

U.S. Forest Service and numerous cooperators. Support for the development and release of the 

2019 i-Tree software suite has come from USDA Forest Service Research, State and Private 

Forestry, and their cooperators through the i-Tree Cooperative Partnership of the Davey Tree 

Expert Company, Arbor Day Foundation, Society of Municipal Arborists, International Society of 

Arboriculture, Casey Trees, and State University of New York College of Environmental Science 

and Forestry. 

 

i-Tree Eco 

 

i-Tree Eco is an adaptation of the Urban Forest Effects (UFORE) model, which was 

cooperatively developed by the U.S. Forest Service Northern Research Station (NRS), USDA 

State and Private Forestry's Urban and Community Forestry Program and Northeastern Area, 

Davey Tree Expert Company, and SUNY College of Environmental Science and Forestry.  

 
The UFORE model was conceived and developed by David J. Nowak and Daniel E. Crane 

(USFS, NRS), and Patrick McHale (SUNY-ESF). The UFORE software was designed and 

developed by Daniel E. Crane and its graphical user interface (GUI) by Lianghu Tian and Mike 

Binkley (The Davey Institute). Many individuals contributed to the design and development 

process of the UFORE application including Mike Binkley (The Davey Institute), Jaewon Choi 

(SUNY-ESF), Daniel E. Crane (NRS), Greg Ina (The Davey Institute), Robert E. Hoehn (NRS), 

Jerry Bond and Christopher J. Luley (Urban Forestry LLC), Patrick McHale (SUNY-ESF), David 

J. Nowak (NRS), Jack C. Stevens (NRS), Lianghu Tian (The Davey Institute), Jeffrey T. Walton 

(Paul Smiths College), and Robert Sacks (Bluejay Software).  

 
New modeling functions, desktop processing capabilities, and updates for i-Tree Eco versions 

were developed and integrated by members of the USFS-NRS and The Davey Institute based 

on newly available research from NRS and feedback from i-Tree users. i-Tree Eco Development 

Team members and contributors include Satoshi Hirabayashi, Alexis Ellis, Daniel Crane, 

Lianghu Tian, Megan Kerr, David Ellingsworth, Allison Bodine, Daniel Vicarel, Mike Binkley, Al 

Zelaya, Jason Henning, Scott Maco, Heidi Siciliano, Michael Leff, Emmanuel Ong, Vidmantas 

Steponavicius, Robert Coville, Arielle Conti, and Erika Teach. 

 

International Support 

 

Many people have contributed to the development of i-Tree Eco to make the application 

functional for users in Canada, Mexico, Australia, the United Kingdom and Europe. Data for the 

Australian enhancements were provided, in part, by Craig Hallam and Chris Spencer (ENSPEC 

Environment and Risk) and with funding from Arboriculture Australia. Andy Kenney (University 
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of Toronto) helped facilitate data acquisition for Canada. Kenton Rogers, Keith Sacre 

(Treeconomics), and Kieron Doick (Forest Research) assisted with project coordination, data 

acquisition, funding, and development of the United Kingdom Eco model adaptation. 
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